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1 Safety

1.1 Validity
The chapter “Safety” is valid as instruction manual.
Specific processes and instructions in this instruction manual require special provisions to 
guarantee the safety of the operating personnel.

1.2 Symbols Used
This document contains symbols for the identification of warning messages and of informative 
messages.

Warning Messages
You will find warning messages, whenever dangers may arise from your actions. It is mandatory 
that you observe these warning messages for your personal safety and in order to avoid prop-
erty damage.
Depending on the risk level, the warning messages are displayed in descending order as fol-
lows:

Informative Symbols

Action
This symbol indicates a paragraph with instructions. You are prompted to perform an action or 
a sequence of actions.

1.3 Target Group, Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and dismount-
ing lies with the plant operator.
The personnel must be appropriately trained and qualified in order to carry out mounting, 
installation, commissioning, operation, maintenance, and dismounting of the device. The 
trained and qualified personnel must have read and understood the instruction manual.
Prior to using the product make yourself familiar with it. Read the instruction manual carefully.

Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.

Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.

Caution!
This symbol indicates a possible fault.
Non-observance could interrupt the device and any connected systems and plants, or result in 
their complete failure.

Note
This symbol brings important information to your attention.
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1.4 Reference to Further Documentation
Observe laws, standards, and directives applicable to the intended use and the operating loca-
tion. Observe Directive 1999/92/EC in relation to hazardous areas.
The corresponding datasheets, manuals, declarations of conformity, EU-type examination cer-
tificates, certificates, and control drawings if applicable (see datasheet) are an integral part of 
this document. You can find this information under www.pepperl-fuchs.com.
Due to constant revisions, documentation is subject to permanent change. Please refer only to 
the most up-to-date version, which can be found under www.pepperl-fuchs.com.

1.5 Delivery, Transport, and Storage
Check the packaging and contents for damage. 
Check if you have received every item and if the items received are the ones you ordered.
Keep the original packaging. Always store and transport the device in the original packaging.
Always store the device in a clean and dry location. Observe the permissible storage tempera-
ture (see datasheet).

1.6 Marking
HD2-DM-A

KT-MB-GT2AD.FF

KT-MB-GT2AD.FF.IO

1.7 Intended Use
The devices are designed to analyze signal and segment parameters for monitoring and mea-
suring of specific system, segment and field device values.

Fieldbus Power Hub, Advanced Diagnostic Module
Pepperl+Fuchs GmbH
Lilienthalstraße 200, 68307 Mannheim, Germany
Statement of conformity: TÜV 04 ATEX 2500 X
Group, category, type of protection, temperature class:

 II 3 G Ex nA IIC T4 Gc

Advanced Diagnostic Gateway with Ethernet and FF-H1 Interface
Pepperl+Fuchs GmbH
Lilienthalstraße 200, 68307 Mannheim, Germany
Statement of conformity: TÜV 14 ATEX 115980 X
Group, category, type of protection, temperature class:

 II 3 G Ex nA IIC T4 Gc

Advanced Diagnostic Gateway with Ethernet and FF-H1 Interface and I/O
Pepperl+Fuchs GmbH
Lilienthalstraße 200, 68307 Mannheim, Germany
Statement of conformity: TÜV 14 ATEX 115980 X
Group, category, type of protection, temperature class:
Motherboard  II 3 G Ex nA nC IIC T4 Gc ,  Gateway  II 3 G Ex nA IIC T4 Gc
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The device is only approved for appropriate and intended use. Ignoring these instructions will 
void any warranty and absolve the manufacturer from any liability.
The device must only be operated in the specified ambient temperature range and at the spec-
ified relative humidity without condensation.
Protection of the personnel and the plant is not ensured if the device is not used according to its 
intended use.
The device is not suitable for isolating signals in power installations unless this is noted sepa-
rately in the corresponding datasheet.

1.8 Mounting/Installation
Prior to mounting, installation, and commissioning of the device you should make yourself 
familiar with the device and carefully read the instruction manual.
The device may be installed in Zone 2.
The device has to be erected in such a way that corresponding to IEC 60079-15, a degree of 
protection of at least IP54 according to IEC 60529 is achieved.
The device has to be erected in such a way that a pollution degree 2 or less according to 
IEC 60664-1 is achieved if the device is connected to an intrinsically safe limited voltage 
according to IEC 60079-11:2011.
The statement of conformity and certificate of compliance of the Fieldbus Power Hub must be 
observed. It is especially important to pay attention to any special conditions for safe use that 
are indicated.
Avoid electrostatic charges which could result in electrostatic discharges while installing, oper-
ating, or maintaining the device.
If the device has already been operated in general electrical installations, the device may sub-
sequently no longer be installed in electrical installations used in combination with hazardous 
areas.
Observe the installation instructions according to IEC/EN 60079-14.
Connection or disconnection of energized non-intrinsically safe circuits is only permitted in the 
absence of a hazardous atmosphere.

1.9 Operation, Maintenance, Repair
Only use operating elements in the absence of a potentially explosive atmosphere.
Only plug and pull the energized module in the absence of a potentially explosive atmosphere.
Connection or disconnection of energized non-intrinsically safe circuits is only permitted in the 
absence of a potentially explosive atmosphere.
Observe IEC/EN 60079-17 for maintenance and inspection of associated apparatus.
The device must not be repaired, changed, or manipulated. In case of failure, always replace 
the device with an original device.

1.10 Disposal
The device, built-in components, packaging, and any batteries contained within must be dis-
posed in compliance with the applicable laws and guidelines of the respective country.
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2 General Description
Overview
Advanced diagnostics provides a set of monitoring tools for FOUNDATION Fieldbus H1 and 
PROFIBUS PA that simplify the work with the fieldbus physical layer.

FieldConnex® physical layer diagnostics offers the following features:
• The advanced diagnostic module (ADM): It provides comprehensive measurement capa-

bilities for up to 4 segments and is integrated into the FieldConnex® Power Hubs.
• The diagnostic gateway (DGW): It connects the ADMs to the process control system 

(PCS). Several integration options to the PCS are available.
• Software packages consisting of DTMs and auxiliary software provide use-case-driven 

and easy access to the functionality of the advanced diagnostics and alarm integration 
with the onsite PCS.

• An optional stand-alone kit can expand the advanced diagnostic features in areas where 
no FieldConnex® Power Hubs are installed.

• Optional cabinet management I/O functionality for the diagnostic gateway.
These features ensure the best possible quality of the fieldbus physical layer through efficient 
working procedures reducing the amount of effort necessary to commission, monitor and trou-
bleshoot segments. Only a very basic understanding of fieldbus is required to operate the diag-
nostic tools as they provide comprehensive information and fieldbus expertise to the user.
The advanced diagnostics offer support for one or all three of the following areas of application 
in process plants:

1. Commissioning
After installation is complete and before loop checking commences, the condition of the seg-
ment is checked. A physical layer in good condition is the basis for a successful loop checking 
and plant commissioning. The ADM and diagnostic manager check the segment with a few 
mouse clicks and simple-to-use automated procedures. The diagnostic manager records com-
prehensive physical layer values in a baseline report and suggests limit values to be stored in 
the ADM.

2. Online Monitoring
The ADM compares actual values to the limits set during commissioning, keeping an "extra set 
of eyes" on the fieldbus. Warnings indicate early on that a fault has occurred or that the quality 
of the installation is degrading. Proactive corrective action is possible preventing unwanted 
plant shutdowns.

3. Troubleshooting
Messages in plain language help the maintenance staff to find possible causes for a problem. 
Repair work is planned and performed only when necessary. This significantly reduces time to 
repair and time spent in the field.
Additional tools for more detailed analysis complete the advanced diagnostics:

• Automated reports in electronic format
• Fieldbus oscilloscope
• Long-term history for monitoring changes
• Storage of configuration and historical data
• Export functions to other spreadsheets or data warehouse
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2.1 General System Layout and PCS Integration
The advanced diagnostics system consists of diagnostic gateways (DGW) and advanced diag-
nostic modules (ADM). The ADMs are mounted on FieldConnex® Power Hubs or a stand-
alone motherboard and are connected to each other and to the GDW using a dedicated diag-
nostic bus. The figure below shows an installation example.

Figure 2.1 System topology with diagnostic gateway, Power Hubs and advanced diagnostic modules
Details for the installation are described for:

• FieldConnex® Power Hubs in section see chapter 4.1
• Stand-alone diagnostic kits in section see chapter 4.2

The PCS connection is actually the choice of the PCS integration method. The following possi-
bilities are available:

• FDS/OPC integration: A server is running on a PC that provides status information to the 
PCS via OPC. FDT DTMs are available for detailed diagnostics, monitoring, and commis-
sioning purposes. This integration consists of the following parts:

• FDS server (the OPC server)
• Diagnostic manager FDT/DTMs

For many PCS, so-called ADM integration packages exist. These packages provide 
step-by-step guides and additional software tools to seamlessly integrate the Field-
Connex® advanced physical layer diagnostics in a PCS. ADM projects including 
segment and field device tags are built directly from the PCS database. Alarming 
and the diagnostic manager are tightly integrated into the PCS asset management. 
Manual OPC configuration etc. is not required. Check www.pepperl-fuchs.com for 
available ADM integration packages.

For FDS/OPC integration, see chapter 5
• FOUNDATION Fieldbus integration for diagnostic gateway FF field device. This integra-

tion consists of the following parts:
• DGW-FF device description (DD)
• Optional: FDT DTM for DGW-FF field device

For FOUNDATION Fieldbus integration, see chapter 6
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• PROFIBUS Power Hub integration for systems that use the transparent Pepperl+Fuchs 
Segment Couplers. This integration is described in detail in the PROFIBUS Power Hub 
manual.

• Simple integrations can be implemented using a volt-free contact. Typically, this integra-
tion will be used with one of the other solutions. Alarming during segment operation is 
done using the volt-free contact; commissioning and troubleshooting are done using one 
of the other integration methods. For more information, see chapter 4.4.

2.2 General Terms and Functions for Advanced Diagnostics

Overview
Each segment monitored by advanced diagnostics (AD) has 1 of 3 states:

• Non-commissioned
This is the initial state of segments in the ADM. All diagnostics in this state are based on 
the following:

• Limits defined by the fieldbus standard IEC/EN 61158–2 or 
• Limits calculated from information on the segment topology, e.g., trunk length, type 

of device couplers used
This mode is used to commission a segment and guarantees an error-free installation.

• Commissioned
A segment is set to commissioned if an initial checkout was executed to verify an error-
free installation. In the commissioned mode, the segment is validated against limits 
defined during the commissioning procedure. These limits can be specified manually for 
each segment, but typically the commissioning wizard is used. For more information on 
the commissioning wizard, see chapter 2.2.2.

• Disabled
The segment is a spare segment and not used yet. The advanced diagnostics is disabled 
for this segment.

The overall segment and each single diagnostic value are classified by the ADM in the follow-
ing way:

Not Commissioned

Commissioned

Excellent:
All values are within the specification limits with an excellent 
safety margin.

Good:
The value is within the specification limits but the safety margin is 
reduced. Values within IEC 61158-2 limits, but with small safety 
margins or values are not matching with expected values of the 
topology.
Out of specification:
The value exceeds the specification limits. At least one value vio-
lated an IEC 61158-2 limit.

No Error:
The value is within the commissioned limits.

Maintenance Required:
The value is outside the commissioned limits (but still inside 
allowed range). At least one value changed since commission-
ing.
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2.2.1 Expert System
FieldConnex® advanced physical layer diagnostics includes an expert system. This expert sys-
tem analyzes all measured values and provides detailed diagnostic messages about any found 
issue on the fieldbus, the root causes of the issue and actions necessary to solve them. This 
way, the user is relieved from the tedious and time-consuming analysis of all measurements of 
the ADM. The expert system takes the segment state (commissioned, non-commissioned) into 
account and provides optimized messages for the 2 different use cases.

2.2.2 Commissioning Wizard
The commissioning wizard is a tool for a fast and easy system setup with advanced diagnostic 
modules (ADM). It is the recommended way to perform segment commissioning.
The wizard guides you through segment commissioning and determines system and segment 
data of your fieldbus installation. The expert system analyzes this data and helps you to solve 
any issues found. A comprehensive report on the status of the segment at the time is automati-
cally generated. Based on this information, the commissioning wizard proposes limits for all 
system, segment, and field device alarm values. If necessary, you can edit the limit values or 
store them on the ADM. After the commissioning wizard is completed successfully, the ADM is 
switched to the "commissioned mode" and is ready for plant real-time monitoring.

2.2.3 Diagnostic Gateway Mode (DGW Mode)
The diagnostic gateway (DGW) can be used for the OPC and DTM integration as well as for the 
Foundation Fieldbus integration. Only 1 of the 2 types of integration can be used at a time. The 
DGW mode must be set to "FDS" or "FF", depending on the selected integration solution. 
When a DGW is installed the first time, it automatically selects the DGW mode depending on 
whether an FF host or an FDS is connecting to the gateway. In order to change the integration 
later on, the DGW mode can be set manually, either via DTMs or via the DGW built-in web 
server.

Out of Specification:
The value exceeds the specification limits. At least one value vio-
lated an IEC 61158-2 limit.

Failure:
Field devices that were active on the fieldbus during commission-
ing and are not active anymore are marked as fail in the user 
interfaces. The overall segment is classified as out of specifica-
tion. If any hardware failure of the ADM is detected or if the diag-
nostic gateway cannot communicate with the ADM this is also 
shown as Fail.
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2.2.4 Field Device Handling
The ADM differentiates between "configured" and "unconfigured" field devices. Field devices 
are identified based on the device address.

• Configured field devices
The ADM features a list of field devices that are labeled "configured field devices". All field 
devices (and the hosts) belonging to the segment are added to the configured field 
devices list. Field devices included in this list can have a tag, limits for their signal levels, 
as well as alarm settings for field-device-specific alarms. The commissioning wizard auto-
matically includes all field devices that are active during the commissioning procedure in 
the configured field devices list. If field devices are active on the fieldbus and are not in the 
configured field devices list or devices in the list are inactive (i.e., not communicating), the 
ADM issues an alarm.

• Unconfigured field devices
All devices that are active on the fieldbus, but are not in the configured field devices list 
are labeled "unconfigured field devices". All measured physical layer data (e.g., signal lev-
els) is shown for this device, but no alarms etc. are associated with this device.
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3 Product Description

3.1 HD2-DM-A - Advanced Diagnostic Module

General Overview
The advanced diagnostic module (ADM) is a plug-in module for FieldConnex® Power Hubs. 
Together with the diagnostic gateway and the diagnostic manager software solutions, it sup-
ports commissioning, online monitoring and troubleshooting of FOUNDATION Fieldbus or 
PROFIBUS PA segments in FieldConnex® Power Hub installations. It measures the physical 
characteristics of the fieldbus installation and the fieldbus communication signals. This data is 
compared to configurable limits and evaluated by and expert system. The results of the exam-
ination are provided as alarm information and a detailed analysis of detected issues.

3.1.1 Assembly

Figure 3.1 Overview HD2-DM-A

3.1.2 Technical Data
HD2-DM-A

1 Plug connections to motherboard
2 LED green PRI Power
3 LED green SEC Power
4 LED Seg 1 ... 4
5 Address selection overview
6 DIP switch for device address
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Supply
Rated voltage 19.2 ... 35 V
Rated current 110 ... 30 mA
Power loss max. 2 W
Fieldbus interface
Number of segments 4
Fieldbus type FOUNDATION Fieldbus/PROFIBUS PA
Rated voltage 9 ... 32 V
Indicators/operating means
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LED PRI PWR green: on, primary bulk power supply con-
nected

LED SEC PWR green: on, secondary bulk power supply con-
nected

LED Seg 1...4 yellow: bus activity; red 2 Hz flashing: alarm; 
red: hardware error

Fault signal VFC alarm 1 A, 50 V DC, normally closed
DIP-switch diagnostic address 1...247, binary coded
Interface
Interface type diagnostic bus: RS 485
Electrical isolation
Fieldbus segment/Fieldbus segment functional insulation acc. to IEC 62103, rated 

insulation voltage 50 Veff

Fieldbus segment/Supply functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Directive conformity
Electromagnetic compatibility
Directive 2004/108/EC EN 61326-1:2013
Standard conformity
Electromagnetic compatibility NE 21:2011
Degree of protection IEC 60529
Shock resistance EN 60068-2-27
Vibration resistance EN 60068-2-6
Corrosion resistance acc. to ISA-S71.04-1985, severity level G3
Ambient conditions
Ambient temperature -40 ... 70 °C (-40 ... 158 °F)
Storage temperature -40 ... 85 °C (-40 ... 185 °F)
Relative humidity < 95 % non-condensing
Shock resistance 15 g 11 ms
Vibration resistance 1 g , 10 ... 150 Hz
Pollution Degree max. 2, according to IEC 60664
Corrosion resistance acc. to ISA-S71.04-1985, severity level G3
Mechanical specifications
Connection type Motherboard specific
Core cross-section Motherboard specific
Housing material Polycarbonate
Housing width 18 mm
Housing height 106 mm
Housing depth 128 mm
Degree of protection IP20
Mass approx. 100 g
Mounting motherboard mounting
Mating cycles 100
Data for application in connection with Ex-areas
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3.1.3 LED Indication

Figure 3.2 LED indication

Statement of conformity TÜV 04 ATEX 2500 X
Group, category, type of protection, tempera-
ture class  II 3 G Ex nA IIC T4 Gc

Directive conformity
Directive 94/9/EC EN 60079-0:2012 , EN 60079-11:2012 , EN 

60079-15:2010
International approvals
FM approval CoC 3024816, CoC 3024816C
Approved for Class I, Division 2, Groups A, B, C, D, T4 / 

Class I, Zone 2, AEx/Ex nA IIC T4
IECEx approval IECEx TUN 13.0038 X
Approved for Ex nA IIC T4 Gc
Certificates and approvals
Marine approval DNV A-10798
Patents This product may be covered by the following 

patent: US7,698,103
General information
Supplementary information Statement of Conformity, Declaration of Con-

formity, Attestation of Conformity and instruc-
tions have to be observed where applicable. 
For information see www.pepperl-fuchs.com.

1 LED: Primary power connection
2 LED: Secondary power connection
3 LED: Status segment 1
4 LED: Status segment 2
5 LED: Status segment 3
6 LED: Status segment 4

Seg4

Seg3

Seg2

Seg1

SEC

PWR

PRI

PWR

Fieldbus

Diagnostic

Module

Advanced

Version

HD2-
DM-A
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3.1.4 Mounting the Diagnostic Module

LED Indication Fault Type Remedy
PRI PWR or SEC PWR LEDs 
are off. 

Supply power failure, possible 
reasons: 
• No primary and/or second-

ary supply power is avail-
able

• Supply power < 19.2 V
• Supply power > 35 V (32 V 

if at least 1 non-isolated 
power module is plugged-
in or configured)

Connect diagnostic PC and 
carry out a complete sys-
tem diagnostics:
• Bulk power supply 

switched on and healthy?
Verify that the wiring is secure:
• Tug on the wires/cable 

clamps
• Measure the DC voltage at 

the terminal block connec-
tor to the bulk power sup-
ply

1 segment LED is flashing yel-
low
(on/off with 2 Hz).

A segment/field device main-
tenance required alarm is 
active.

Connect diagnostic PC and 
carry out a complete sys-
tem diagnostics:
• DC unbalance?
• Jitter level too high?
• Noise level too high?
Bus segment ...
• ... badly terminated?
• ... miswired (shield con-

nections)?
• ... short–circuit overload?
Power supply/conditioner 
modules healthy and cor-
rectly mounted?

1 segment LED is flashing red
(on/off with 2 Hz).

Any segment/field device 
alarm is active.

All segment LEDs are flashing 
yellow 
(on/off with 2 Hz).

A system maintenance 
required alarm is active.

Connect diagnostic PC and 
carry out a complete sys-
tem diagnostics:
• Bulk power supply voltage 

correct?
• Board type configuration 

correct?
• Board redundancy config-

uration correct?

All segment LEDs are flashing 
red
(on/off with 2 Hz).

Any system alarm is active.

Any (or all) segment LEDs are 
constantly lit red.

A hardware fault inside HD2-
DM-A is detected.

-

Warning!
Hardware Damage
If you plug the diagnostic module HD2-DM* into the wrong connection slot, the module or the 
motherboard may be damaged.
The Power Hub motherboard features a special connection slot for diagnostic modules labeled 
"Diagnostic Module only". Use this slot only.
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Mounting of HD2-DM* Modules on the Motherboard
To install a new module on the motherboard, proceed as follows:

1. Carefully center the polarization holes and mate the two connectors, then gently press down 
the module.

2. Push down the red Quick Lok bars on each side of the module to fix it to the panel.

Figure 3.3 Mounting HD2-DM*
 The new module has been installed.

Dismounting Modules from the Motherboard
To dismount a module from the motherboard, proceed as follows:
Pull up the red Quick Lok bars on each side of the module and carefully lift off the entire mod-
ule.

 The module has been removed from the motherboard.

3.2 KT-MB-DMA - Advanced Diagnostic Module, Kit for Stand-Alone 
Operation

General Overview
The stand-alone diagnostic kit consists of an HD2-DM-A plug-in module (see chapter 3.1) and 
a motherboard to connect the HD2-DM-A to up to 4 segments. It is specially designed to lead 
the advanced diagnostic features in areas where continuous monitoring of the physical layer is 
crucial and no FieldConnex ®Power Hubs are installed.
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3.2.1 Assembly

Figure 3.4 Overview KT-MB-DMA

3.2.2 Technical Data
The technical data below refers to the stand-alone motherboard. For technical data of the HD2-
DM-A diagnostic module, see chapter 3.1.2.

KT-MB-DMA

1 Advanced diagnostic module (ADM)
2 Mounting screws
3 Connections for segments

4 Diagnostic bus

5 PRI LED green: Primary power
6 SEC LED green: Secondary power
7 LEDs Seg 1 ... 4
8 Shield/ground connection clamp
9 Connections for bulk power supply
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Extended
Version
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Alarm

Diagnostic
Bus

+ –
PWR

Supply
Rated voltage 19.2 ... 35 V
Rated current 110 ... 30 mA
Power loss max. 2 W
Fieldbus interface
Number of segments 4
Fieldbus type FOUNDATION Fieldbus/PROFIBUS PA
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3.2.3 Mounting the Stand-Alone Kit and the Advanced Diagnostic Module
For mounting the HD2-DM-A diagnostic module, see chapter 3.1.4.

Indicators/operating means
LED PRI PWR green: on, primary bulk power supply con-

nected
LED SEC PWR green: on, secondary bulk power supply con-

nected
LED Seg 1...4 yellow: bus activity; red 2 Hz flashing: alarm; 

red: hardware error
Fault signal VFC alarm 1 A, 50 V DC, normally closed
DIP-switch diagnostic address 1...247, binary coded
Interface
Interface type diagnostic bus: RS 485
Directive conformity
Electromagnetic compatibility
Directive 2004/108/EC EN 61326-1:2006
Standard conformity
Electromagnetic compatibility NE 21
Degree of protection IEC 60529
Shock resistance EN 60068-2-27
Vibration resistance EN 60068-2-6
Ambient conditions
Ambient temperature -40 ... 60 °C (-40 ... 140 °F)
Storage temperature -40 ... 85 °C (-40 ... 185 °F)
Relative humidity < 95 % non-condensing
Shock resistance 15 g 11 ms
Vibration resistance 1 g , 10 ... 150 Hz
Mechanical specifications
Connection type screw terminals
Core cross-section 2.5 mm2

Housing material Polycarbonate
Housing width 50 mm
Housing height 220 mm
Housing depth 162 mm
Degree of protection IP20
Mass approx. 290 g
Mounting DIN mounting rail
International approvals
FM approval CoC 3024816, CoC 3024816C
Approved for Class I, Division 2, Groups A, B, C, D, T4 / 

Class I, Zone 2, AEx/Ex nA IIC T4
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Mounting Fieldbus Motherboards on the DIN Mounting Rail
In order to mount a motherboard on a DIN mounting rail, proceed as follows:

1. Place the motherboard on the DIN mounting rail.

2. Tighten the fastening screw to attach the motherboard on the DIN mounting rail.

 The motherboard has been mounted.

DIN mounting rail

Fastening screw

1

2

Motherboard
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3.3 KT-MB-GT2AD.FF - Diagnostic Gateway, Kit with Motherboard

General Overview
The FieldConnex® Diagnostic Gateway collects all data from the advanced diagnostic module 
(ADM) and provides interfaces to access the data from the diagnostic manager and PCS.

• Ethernet
Allows access to the ADMs for the diagnostic manager and the FDS/OPC server. It is 
mainly used for the FDS/OPC integration, but can also be used with the FOUNDATION 
Fieldbus H1 interface to enhance the functionality of the diagnostic manager and to 
access the FOUNDATION Fieldbus device locally using a mobile computer.

• FOUNDATION Fieldbus H1
Provides the core diagnostic data of up to 16 HD2-DM-A ADMs as FOUNDATION Field-
bus H1 device. The Ethernet interface can be used in addition to the FF-H1 interface to 
enhance the functionality of the diagnostic manager and to access the FOUNDATION 
Fieldbus device locally using a mobile computer.

• Common alarm output 
The common alarm output can be used to report the ADM alarms as a volt-free contact to 
a PCS input.

The gateway is seamlessly integrated into the FieldConnex® advanced physical layer solution 
and provides many features for a fast and easy installation and setup of the advanced diagnos-
tics.

Note
The diagnostic gateway FF-H1 connection must never be connected to device couplers like the 
Pepperl+Fuchs Segment Protectors or FieldBarriers.
The diagnostic gateway must be connected directly to the trunk.
For best performance, we recommend using a separate FF-H1 diagnostic segment for 
diagnostic gateways. Scheduled FB data must be kept to a minimum for this segment.
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3.3.1 Assembly

1 Output I:
Alarm output diagnostic bus channel 1, volt-free con-
tact, NC contact
See chapter 4.4.1

2 Output II:
Alarm output diagnostic bus channel 2, volt-free con-
tact, NC contact
See chapter 4.4.1

3 Serial, not used

4 Output III:
Common alarm, volt-free contact, NC contact
See chapter 4.4.1

5 Bulk power supply connection

6 Ethernet, 8-pin RJ45 socket
7 Enable/disable simulation switch
8 Grounding terminal
9 FF-H1

10 Diagnostic bus channel 2

11 LED:
 Common alarm output

12 LED:
COM, not used

Diagnostic
Gateway

HD2-
GT-

2AD.FF

CH 2

CH 1

PWR

ERR

LINK/

ACT

ALM

COM
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Alarm
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Cable and Connection Information
• Alarm output / serial / bulk power supply:

• Cross section: 0.2 mm2 ... 4 mm2 fixed, 0.2 mm2 ... 2.5 mm2 flexible
• Wire stripping length: 8 mm
• Torque: 0.5 Nm ... 0.6 Nm

• FF-H1 / diagnostic bus channels 1+2: 

• Cross section: 0.2 mm2 ... 2.5 mm2 fixed and flexible
• Wire stripping length: 7 mm
• Torque: 0.5 Nm ... 0.6 Nm

3.3.2 Technical Data
KT-MB-GT2AD.FF

13 LED:
 Diagnostic bus channel 2 activity

14 LED:
Diagnostic bus channel 1 activity

15 Diagnostic bus channel 1

16 LED:
LINK/ACT

17 LED:
Error

18 LED:
Power supply

19 Mounting screw (located under diagnostic gateway)

Alarm
+

–

Supply
Rated voltage 19.2 ... 35 V DC SELV/PELV
Rated current 120 ... 70 mA
Power loss max. 2.5 W
Fieldbus interface
Fieldbus type FOUNDATION Fieldbus
Physical layer profile profile type 114
ITK version 6
Implementation resource block 1x RS

function block 4x MDI, 1x MDO, 1x MAI, 1x DI
transducer block 16x ADM TB, 1x IO TB

Firmware update Ethernet
Polarity polarity-sensitive
Rated voltage 9 ... 35 V SELV/PELV
Rated current 0 mA
Ethernet Interface
Port 100 BASE-TX
Protocol TCP/IP and UDP/IP
Services ICMP , DHCP , AutoIP , HTTP
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Connection type RJ-45 socket, 8-pin
Transfer rate 100 MBit/s
Diagnostic Bus
Number of Diagnostic Bus Channels 2
Number of Diagnostic Modules/Channel 31 Using Ethernet Interface , 8 Using Fieldbus 

Interface
Termination integrated
Cable length/Channel 30 m
Indicators/operating means
LED ERR red: Hardware fault
LED PWR green: Power on
LINK/ACT yellow
CH1, CH2 yellow: diagnostic bus activity
Outputs
Output I alarm output diagnostic bus channel 1 , volt-

free contact , NC contact
Voltage 50 V DC
Current max. 1 A
Output II alarm output diagnostic bus channel 2 , volt-

free contact , NC contact
Voltage 50 V DC
Current max. 1 A
Output III common alarm , volt-free contact , NC contact
Voltage 50 V DC
Current max. 1 A
Electrical isolation
All circuits/FE functional insulation acc. to IEC 62103, rated 

insulation voltage 50 Veff

Output I, II/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 250 Veff

Ethernet/Supply functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Ethernet/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Fieldbus/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Diagnostic Bus/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Directive conformity
Electromagnetic compatibility
Directive 2004/108/EC EN 61326-1:2013
Low voltage
Directive 73/23/EEC EN 61010
Standard conformity
Electrical isolation IEC 62103
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Electromagnetic compatibility NE 21
Degree of protection IEC 60529
Fieldbus standard IEC 61158-2
Climatic conditions DIN IEC 721
Shock resistance EN 60068-2-27
Vibration resistance EN 60068-2-6
Ethernet IEEE 802.3
Ambient conditions
Ambient temperature -40 ... 60 °C (-40 ... 140 °F)
Storage temperature -40 ... 85 °C (-40 ... 185 °F)
Relative humidity < 95 % non-condensing
Shock resistance 15 g 11 ms
Vibration resistance 1 g , 10 ... 150 Hz
Pollution Degree max. 2, according to IEC 60664
Corrosion resistance acc. to ISA-S71.04-1985, severity level G3
Mechanical specifications
Housing material Polycarbonate
Housing width see dimensions
Housing height see dimensions
Housing depth see dimensions
Degree of protection IP20
Mass 470 g
Mounting DIN rail mounting
Data for application in connection with Ex-areas
Statement of conformity TÜV 14 ATEX 115980 X
Group, category, type of protection, tempera-
ture class  II 3 G Ex nA IIC T4 Gc

Directive conformity
Directive 94/9/EC EN 60079-0:2012 , EN 60079-11:2012 , EN 

60079-15:2010
International approvals
IECEx approval IECEx TUN 14.0003X
Approved for Ex nA IIC T4 Gc
General information
Supplementary information Statement of Conformity, Declaration of Con-

formity, Attestation of Conformity and instruc-
tions have to be observed where applicable. 
For information see www.pepperl-fuchs.com.
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3.3.3 LED Indication

1 Power supply
2 Error
3 Link/Activity
4 Diagnostic bus channel 1
5 Diagnostic bus channel 2
6 COM, not used
7 Alarm

LED Indication Description
PWR lights up green The power supply is connected properly
ERR lights up red A hardware failure is detected
ERR flashes red An ADM conflict is detected (same address on both diag-

nostic bus channels)
LINK/ACT lights up yellow A link is established
LINK/ACT flashes yellow Ethernet activity
CH1/CH2 lights up yellow FF mode: ADMs are detected with an address between 

1 ... 16 
FDS/OPC mode:
• FDS is connected
• DTM communication to at least 1 device in the last 3 

seconds
• At least 1 configured device is active 

CH1/CH2 flashes yellow FF mode: ADMs are detected with an address range out-
side 1 ... 16 
FDS/OPC mode: 
• FDS is not connected
• At least 1 device is active (while scanning the range of 

all valid MODBUS addresses)
ALM flashes red Common alarm output is active (open)

Diagnostic
Gateway

HD2-
GT -
2AD.
FF .IO

CH 2

CH 1

PWR

ERR

LINK/
ACT

ALM

COM

1

2

3

4

5

6

7
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3.4 KT-MB-GT2AD.FF.IO - Diagnostic Gateway, Kit with I/O Motherboard

General Overview
The FieldConnex® Diagnostic Gateway collects all data from the advanced diagnostic module 
(ADM) and provides interfaces to access the data from the diagnostic manager and PCS.

• Ethernet
Allows access to the ADMs for the diagnostic manager and the FDS/OPC server. It is 
mainly used for the FDS/OPC integration, but can also be used with the FOUNDATION 
Fieldbus H1 interface to enhance the functionality of the diagnostic manager and to 
access the FOUNDATION Fieldbus device locally using a mobile computer.

• FOUNDATION Fieldbus H1
Provides the core diagnostic data of up to 16 HD2-DM-A ADMs as FOUNDATION Field-
bus H1 device. The Ethernet interface can be used in addition to the FF-H1 interface to 
enhance the functionality of the diagnostic manager and to access the FOUNDATION 
Fieldbus device locally using a mobile computer.

• Common alarm output 
The common alarm output can be used to report the ADM alarms as a volt-free contact to 
a PCS input.

The gateway is seamlessly integrated into the FieldConnex® advanced physical layer solution 
and provides many features for a fast and easy installation and setup of the advanced diagnos-
tics.
Compared to the KT-MB-GT2AD.FF diagnostic gateway the KT-MB-GT2AD.FF.IO uses a differ-
ent motherboard with I/O functionality. This includes binary inputs, binary outputs, frequency 
inputs, temperature inputs and integrated sensors for temperature and humidity. These inputs 
and outputs are primarily designed for cabinet management applications like heater or cooling 
control and door open alarms. The cabinet management application is supported by additional 
control features like on/off controllers in the diagnostic gateway.

Note
The diagnostic gateway FF-H1 connection must never be connected to device couplers like the 
Pepperl+Fuchs Segment Protectors or FieldBarriers.
The diagnostic gateway must be connected directly to the trunk.
For best performance, we recommend using a separate FF-H1 diagnostic segment for 
diagnostic gateways. Scheduled FB data must be kept to a minimum for this segment.
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3.4.1 Assembly

1 Bulk power supply

2 LED:
Error

3 LED:
 Power supply

4 Output I, selectable:
Diagnostic bus CH 1, relay, NO contact

5 Output II, selectable:
Diagnostic bus CH 2, relay, NO contact

6 Ethernet, 8-pin RJ45 socket
7 Grounding terminal
8 I/O terminal block
9 FF-H1

10 LED:
Common alarm output

11 LED:
COM, not used

12 LED:
Diagnostic bus channel 2 activity

13 LED:
 Diagnostic bus channel 1 activity

14 LED:
 LINK/ACT

15 Enable/disable simulation switch
16 Mounting screw (located under diagnostic gateway)

15
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77
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Cable and Connection Information
• Relay contact output 1+2 / bulk power supply:

• Cross section: 0.2 mm2 ... 4 mm2 fixed, 0.2 mm2 ... 2.5 mm2 flexible
• Wire stripping length: 8 mm
• Torque: 0.5 Nm ... 0.6 Nm

• FF-H1: 

• Cross section: 0.2 mm2 ... 2.5 mm2 fixed and flexible
• Wire stripping length: 7 mm
• Torque: 0.5 Nm ... 0.6 Nm

• I/O terminal block:

• Cross section: 0.14 mm2 ... 1.5 mm2 fixed and flexible
• Wire stripping length: 6 mm
• Torque: 0.5 Nm ... 0.6 Nm

I/O Terminal Block

1 + Input I
Frequency 
input 1
Binary/
NAMUR input 1

19 + Output I
Diagnostic bus CH 1,
Output 12 - 20 -

3 + Input II
Frequency input 
2
Binary/
NAMUR input 2

21 GND Ground
4 - 22 A (+) Input V

Diagnostic bus CH 1,
Binary/NAMUR input 5

5 + Input III
Binary/
NAMUR input 3

23 B (-)
6 - 24 GND Ground

7 + Input IV
Binary/
NAMUR input 4

25 + Output II
Diagnostic bus CH 2,
Output 28 - 26 -

9 + Input VII
Temperature 
input 1
Binary/
NAMUR input 7

27 GND Ground
10 H 28 A (+) Input VI

Diagnostic bus CH 2,
Binary/NAMUR input 611 L 29 B (-)

12 - 30 GND Ground
13 GND Ground 31 + Serial, not used
14 + Input VIII

Temperature 
input 2
Binary/
NAMUR input 8

32 - Serial, not used
15 H 33 GND Ground
16 L 34 A Output III

Common alarm 
output 1
Output 3
See chapter 4.4.1

17 - 35 B

18 GND Ground 36 GND Ground
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All grounding terminals are connected to the shield/screen grounding terminal of the mother-
board. The grounding terminals can be used to connect a shield of the I/O or diagnostic bus 
cables to ground.

Input V and Input VI
Each diagnostic bus is built of 2 communication lines (+, -) and 2 alarm lines (A, B). If the 
volt–free contact from the ADM (see chapter 4.4) is not used the volt–free relay contact inputs 
can be used as additional binary/NAMUR inputs.

Input VII and Input VIII
The temperature inputs support Pt100 with 4–wire connection only. The PT100s are connected 
in the following way:

3.4.2 Technical Data
KT-MB-GT2AD.FF.IO

H
+

L
–

ϑ

Supply
Rated voltage 19.2 ... 35 V DC SELV/PELV
Rated current 210 ... 120 mA
Power loss max. 4.2 W
Fieldbus interface
Fieldbus type FOUNDATION Fieldbus
Physical layer profile profile type 114
ITK version 6
Implementation resource block 1x RS

function block 4x MDI, 1x MDO, 1x MAI, 1x DI
transducer block 16x ADM TB, 1x IO TB

Firmware update Ethernet
Polarity polarity-sensitive
Rated voltage 9 ... 35 V SELV/PELV
Rated current 0 mA
Ethernet Interface
Rated voltage max. 35 V SELV/PELV
Port 100 BASE-TX
Protocol TCP/IP and UDP/IP
Services ICMP , DHCP , AutoIP , HTTP
Connection type RJ-45 socket, 8-pin
Transfer rate 100 MBit/s
Diagnostic Bus
Connection only for the connection to protected circuits
Rated voltage max. 35 V
Number of Diagnostic Bus Channels 2
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Number of Diagnostic Modules/Channel 31 Using Ethernet Interface , 8 Using Fieldbus 
Interface

Termination integrated
Cable length/Channel 30 m
Indicators/operating means
LED ERR red: Hardware fault
LED PWR green: Power on
Fault signal buzzer on
LINK/ACT yellow
CH1, CH2 yellow: diagnostic bus activity
Inputs
Input I, II
Input type selectable: Frequency input , 

NAMUR/mechanical contact
Frequency
Input frequency 0.3 Hz to 1 kHz
Connection only passive load
Rated voltage max. 35 V
Pulse duration min. 50 µs
Accuracy ± 1 %
Cable length max. 30 m
Line fault detection lead breakage , short-circuit
NAMUR
Input III, IV NAMUR sensor according to DIN EN 60947-6 

or mechanical contact
Sensor type NAMUR sensor according to DIN EN 60947-6
Connection only passive load
Rated voltage max. 35 V
Switching frequency 10 Hz
Cable length max. 30 m
Line fault detection lead breakage , short circuit
Input III, IV
Input type NAMUR/mechanical contact
NAMUR
Sensor type NAMUR sensor according to DIN EN 60947-6
Connection only passive load
Rated voltage max. 35 V
Switching frequency 10 Hz
Cable length max. 30 m
Line fault detection lead breakage , short circuit
Input V
Input type selectable: diagnostic bus CH 1 alarm input , 

NAMUR/mechanical contact
Alarm Input
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Connection only passive load
Rated voltage max. 35 V
Cable length max. 30 m
Line fault detection lead breakage , short-circuit
NAMUR
Sensor type NAMUR sensor according to DIN EN 60947-6
Connection only passive load
Rated voltage max. 35 V
Switching frequency 10 Hz
Cable length max. 30 m
Line fault detection lead breakage , short circuit
Input VI
Input type selectable: diagnostic bus CH 2 alarm input , 

NAMUR/mechanical contact
Alarm Input
Connection only passive load
Rated voltage max. 35 V
Cable length max. 30 m
Line fault detection lead breakage , short-circuit
NAMUR
Sensor type NAMUR sensor according to DIN EN 60947-6
Connection only passive load
Rated voltage max. 35 V
Switching frequency 10 Hz
Cable length max. 30 m
Line fault detection lead breakage , short circuit
Input VII, VIII
Input type selectable: Pt100 4-wire temperature input , 

NAMUR/mechanical contact
Temperature
Connection only passive load
Rated voltage max. 35 V
Measurement range -50 ... 90 °C (-58 ... 194 °F)
Accuracy 1 K
Measuring current 1 mA
Lead resistance 4.2  per lead
Cable length max. 30 m
Line fault detection lead breakage , short-circuit
NAMUR as input III, IV
Humidity
Measurement range 0 ... 95 % RH
Accuracy 2 % RH
Resolution 0.04 %
Outputs
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Output I relay , NO contact
Output type selectable: diagnostic bus CH 1 , relay , NO 

contact
Contact loading 250 V AC/ 6 A resistive load
Mechanical life 1 x 105 switching cycles
Response time turn-on time 7 ms , turn-off time 3 ms
Switching frequency 6 min-1 full load, 1200 min-1 without load
Output II
Output type selectable: diagnostic bus CH 2 , relay , NO 

contact
Contact loading 250 V AC/ 6 A resistive load
Mechanical life 1 x 105 switching cycles
Response time turn-on time 7 ms , turn-off time 3 ms
Switching frequency 6 min-1 full load, 1200 min-1 without load
Output III
Output type selectable: common alarm , volt-free contact , 

NC contact
Connection only for the connection to protected circuits
Voltage 50 V DC
Current max. 1 A
Output IV
Output type common alarm , buzzer
Electrical isolation
All circuits/FE functional insulation acc. to IEC 62103, rated 

insulation voltage 50 Veff

Output I, II/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 250 Veff

Ethernet/Supply functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Ethernet/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Fieldbus/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Diagnostic Bus/other circuits functional insulation acc. to IEC 62103, rated 
insulation voltage 50 Veff

Directive conformity
Electromagnetic compatibility
Directive 2004/108/EC EN 61326-1:2013
Low voltage
Directive 73/23/EEC EN 61010
Standard conformity
Electrical isolation IEC 62103
Electromagnetic compatibility NE 21
Degree of protection IEC 60529
Fieldbus standard IEC 61158-2
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Climatic conditions DIN IEC 721
Shock resistance EN 60068-2-27
Vibration resistance EN 60068-2-6
Ethernet IEEE 802.3
Ambient conditions
Ambient temperature -40 ... 60 °C (-40 ... 140 °F)
Storage temperature -40 ... 85 °C (-40 ... 185 °F)
Relative humidity < 95 % non-condensing
Shock resistance 5 g 11 ms
Vibration resistance 1 g , 10 ... 150 Hz
Protection against electrical shock overvoltage category II
Pollution Degree max. 2, according to IEC 60664
Corrosion resistance acc. to ISA-S71.04-1985, severity level G3
Mechanical specifications
Housing material Polycarbonate
Housing width see dimensions
Housing height see dimensions
Housing depth see dimensions
Degree of protection IP20
Mass 500 g
Mounting DIN rail mounting
Data for application in connection with Ex-areas
FOUNDATION Fieldbus
Connection For connection to circuits with safe limited volt-

age according to IEC 60079-11:2011, type of 
protection ic

Voltage Ui max. 35 V
Statement of conformity TÜV 14 ATEX 115980 X
Group, category, type of protection, tempera-
ture class Motherboard  II 3 G Ex nA nC IIC T4 Gc , 

Gateway  II 3 G Ex nA IIC T4 Gc
Directive conformity
Directive 94/9/EC EN 60079-0:2012 , EN 60079-11:2012 , EN 

60079-15:2010
International approvals
IECEx approval IECEx TUN 14.0003X
Approved for Motherboard Ex nA nC IIC T4 Gc , Gateway Ex 

nA IIC T4 Gc
General information
Supplementary information Statement of Conformity, Declaration of Con-

formity, Attestation of Conformity and instruc-
tions have to be observed where applicable. 
For information see www.pepperl-fuchs.com.
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4 Hardware Installation

4.1 Power Hub and Advanced Diagnostic Module
In order to provide advanced diagnostics for FieldConnex® Power Hubs installation ADMs are 
mounted on the Power Hubs and are connected to each other and to the diagnostic gateway 
(DGW) via a dedicated diagnostic bus. The figure below shows an installation example.

Figure 4.1 System topology with diagnostic gateway, Power Hubs and advanced diagnostic modules
The DGW provides 2 diagnostic bus channels. Depending on the PCS connection used you 
can connect either of the following:

• FDS/OPC: 31 Power Hub motherboards (for each channel) / 62 Power Hub motherboards 
(for both channels)

• FOUNDATION Fieldbus: 8 Power Hub motherboards (for each channel) / 16 Power Hub 
motherboards (for both channels)

For the FDS/OPC integration, up to 125 DGWs or 1 000 ADMs (whichever maximum is 
reached first) are supported for a single FDS server installation. For the FOUNDATION Field-
bus integration, this limit does not apply because every DGW is a single FF-H1 field device 
without any connection to the other gateways.
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Note
For best performance, use the same number of Power Hub motherboards on each diagnostic 
bus channel.
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Required Hardware Components

4.1.1 Installing the Diagnostic Bus
The max. length of the diagnostic bus channel is 30 m.

Installing the Diagnostic Bus

1. To connect the diagnostic gateway to the FieldConnex® Power Hub, use a 4-line wire.

2. To connect the Power Hubs to each other, use a 4-wire cable or the optional ACC-MB-HDC link 
cable.

3. Use shielded wires for the diagnostic bus in EMC-sensitive areas. Connect the cable shield to 
the grounding terminal of the gateway motherboard.

4. The principal way of connecting the FieldConnex® Power Hubs to each other and to the 
Diagnostic Gateway is shown in the figure below. The actual installation depends on the used 
FieldConnex® Power Hub. Details are shown in the manual of the used FieldConnex® Power 
Hub.

5. The terminals used at the Diagnostic Gateway depend on the used Kit.
KT-MB-GT2AD.FF:see chapter 3.3.1
KT-MB-GT2AD.FF.IO: see chapter 3.4.1

Hardware component Description
KT-MB-GT2AD.FF
or
KT-MB-GT2AD.FF.IO

Kit comprising the following hardware components: 
• HD2-GT-2AD.FF.IO: Diagnostic gateway
• MB-FB-GT.AD.FF / MB-FB-GT.AD.FF.IO: Motherboard for 

diagnostic gateway / I/O motherboard for diagnostic gate-
way

MB* Depending on the number of segments and the redundancy 
concept, several motherboards are available.
For more information see www.pepperl-fuchs.com.

HD2-DM-A Advanced diagnostic module
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Figure 4.2 Cabinet installation example with Diagnostic Gateway

4.1.2 Device Address Assignment
Before mounting the module on the motherboard, a device address must be assigned to the 
HD2-DM-A module. The address depends on your PCS infrastructure, see chapter 5 or see 
chapter 6. This assignment is performed using the DIP switch on the device. The DIP switch 
has 8 switches positioned next to each other. They can be used to assign addresses from 
1 ... 247 in binary form.

Assigning the Device Address
In order to assign an address to the HD2-DM-A, proceed as follows:
Set each of the 8 DIP switches at the left side of the module in the correct position to generate a 
unique address.
For more information on how to generate a binary address, see the label on the module.

 The device address is assigned.

4.1.3 Connecting the PCS Connection
Depending on the used integration method, the following connections are required:

• FDS/OPC integration
An Ethernet RJ45 connector is located on the top of the diagnostic gateway. See chapter 
3.3, see chapter 3.4.

• FF/H1 integration
FF-H1 connection is provided on the diagnostic gateway motherboard. See chapter 3.3, 
see chapter 3.4. For some features, an additional Ethernet connection can be necessary, 
see chapter 6.2.
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Note
Every HD2-DM-A module that is connected to the same KT-MB-GT2AD.FF* must have a 
unique device address. See chapter 4.1.2
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4.2 Kit for Stand-Alone Operation and Advanced Diagnostic Module
The KT-MB-DM kit for stand-alone operation enables the installation of the FieldConnex® 
advanced physical layer diagnostics for non-FieldConnex–Power–Hub-based installations. The 
advanced diagnostic module HD2-DM-A is installed on a motherboard enabling the connec-
tion to 4 FOUNDATION Fieldbus H1 or PROFIBUS PA segments. The motherboards are con-
nected to each other and to the diagnostic gateway (DGW) using a dedicated diagnostic bus. 
The figure below shows an installation example.

Figure 4.3 System topology with diagnostic gateway and kits for stand-alone operation
The DGW provides 2 diagnostic bus channels. Depending on the selected integration solution 
used, you can connect either of the following:

• FDS/OPC Integration: 62 stand-alone kits (for both channels) / 31 stand-alone kits (for 
each channel)

• FOUNDATION Fieldbus: 16 stand-alone kits (both channels) /8 stand-alone kits (for 
each channel)

Note
The diagnostic gateway FF-H1 connection must never be connected to device couplers like the 
Pepperl+Fuchs Segment Protectors or FieldBarriers.
The diagnostic gateway must be connected directly to the trunk.
For best performance, we recommend using a separate FF-H1 diagnostic segment for 
diagnostic gateways. Scheduled FB data must be kept to a minimum for this segment.
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For best performance, use the same number of Power Hub motherboards on each diagnostic 
bus channel.
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For the FDS/OPC integration, up to 125 DGW or 1 000 ADMs (whichever maximum is reached 
first) are supported for a single FDS server installation. For the FOUNDATION Fieldbus integra-
tion, this limit does not apply because every DGW is a single FF-H1 field device without any 
connection to the other gateways.

Required Hardware Components

4.2.1 Installing the Diagnostic Bus
The maximum length of the diagnoastic bus channel is 30 m.

Installing the Diagnostic Bus

1. In order to connect the diagnostic gateway to the FieldConnex® Power Hub, use a 4-line wire.

2. In order to connect the Power Hubs with each other, use a 4-wire cable or the optional ACC-
MB-HDC link cable.

3. Use shielded wires for the diagnostic bus in EMC-sensitive areas. Connect the cable shield to 
the grounding terminal of the gateway motherboard.

4. The principal way of connecting stand-alone kits to each other and to the diagnostic gateway is 
shown in the figure below.

5. The terminals used at the diagnostic gateway depends on the kit used.
KT-MB-GT2AD.FF:see chapter 3.3.1
KT-MB-GT2AD.FF.IO: see chapter 3.4.1

Hardware Component Description
KT-MB-GT2AD.FF
or
KT-MB-GT2AD.FF.IO

Kit comprising the following hardware components: 
• HD2-GT-2AD.FF.IO: Diagnostic gateway
• MB-FB-GT.AD.FF / MB-FB-GT.AD.FF.IO: Motherboard for 

diagnostic gateway / I/O motherboard for diagnostic gate-
way

KT-MB-DMA Kit comprising the following hardware components: 
• HD2-DM-A: Advanced diagnostic module
• MB-FB-DM: Stand-alone motherboard for advanced diag-
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4.2.2 Connecting Stand-Alone Kits to Segments
Connecting the Stand-Alone Diagnostic Motherboard to the Segment
The stand-alone diagnostic motherboard supports connection of up to 4 segments. In order to 
connect a stand-alone diagnostic motherboard to a segment, proceed as follows:
Wire the segment connections of the stand-alone diagnostic motherboard in parallel to the 
segment output lines (trunks) of your fieldbus power supplies.

Connecting the Stand-Alone Diagnostic Motherboard to the Bulk Power 
Supply
Connect the stand-alone diagnostic motherboard in parallel to the bulk power supply of the 
fieldbus power supplies.

 The stand-alone diagnostic motherboard is now supplied with power.The bulk power supply 
of the fieldbus power supplies is also monitored.

Figure 4.4 Trunk connection

4.2.3 Device Address Assignment
Before mounting the module on the motherboard, a device address must be assigned to the 
HD2-DM-A module. The address depends on your PCS infrastructure, see chapter 5 or see 
chapter 6. This assignment is performed using the DIP switch on the device. The DIP switch 
has 8 switches positioned next to each other. They can be used to assign addresses from 
1 ... 247 in binary form.

Note
Every HD2-DM-A module that is connected to the same KT-MB-GT2AD.FF* must have a 
unique device address. See chapter 4.1.2

1 Trunk line to segment
2 Trunk line to segment connection (parallel circuit)
3 Connection KT-MB-DMA bulk power supply
4 Connection fieldbus bulk power supply
5 Fieldbus power supply
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Assigning the Device Address
In order to assign an address to the HD2-DM-A, proceed as follows:
Set each of the 8 DIP switches at the left side of the module in the correct position to generate a 
unique address.
For more information on how to generate a binary address, see the label on the module.

 The device address is assigned.

4.2.4 Connecting the PCS Connection
Depending on the used integration method, the following connections are required:

• FDS/OPC integration
An Ethernet RJ45 connector is located on the top of the diagnostic gateway. See chapter 
3.3, see chapter 3.4.

• FF/H1 integration
FF-H1 connection is provided on the diagnostic gateway motherboard. See chapter 3.3, 
see chapter 3.4. For some features, an additional Ethernet connection can be necessary, 
see chapter 6.2.

4.3 Shielding and Grounding

Note
The diagnostic gateway FF-H1 connection must never be connected to device couplers like the 
Pepperl+Fuchs Segment Protectors or FieldBarriers.
The diagnostic gateway must be connected directly to the trunk.
For best performance, we recommend using a separate FF-H1 diagnostic segment for 
diagnostic gateways. Scheduled FB data must be kept to a minimum for this segment.

Caution!
Risk of electric shock or property damage from inadequate grounding 
If you fail to connect all metal parts of the device to protective local earth correctly, this could 
result in potential equalization currents. These electric currents could hurt operating personnel 
or cause property damage. 
The grounding terminal is not a protective earth: Do not use the grounding terminal to ground 
exposed metal parts. 
Do ground exposed metal parts of the device separately. Ensure that a correct grounding is 
guaranteed at all times.
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Figure 4.5 KT-MB-GT2AD.FF grounding terminal

Figure 4.6 KT-MB-GT2AD.FF.IO grounding terminal

All shield connections are internally connected to the "Shield/Screen GND" grounding terminal.

Connecting the Ground Connection Cable
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1. Connect the ground cable to a cable lug.

2. Position the cable lug over the grounding terminal with the cable pointing downwards.

3. Screw the cable lug to the grounding terminal with 2 detent-edge washers inserted between 
screw, lug, and terminal as illustrated:

Figure 4.7 Connecting the ground connection cable

4. Tighten the screw with a torque of 1.5 Nm.

 The cable lug is properly attached and cannot come loose.
Connect the "Shield/Screen GND" grounding terminal of the motherboard to an equipotential 
bonding system.

4.4 Volt-Free Contact Installation
The FDS/OPC integration and the FOUNDATION Fieldbus integration provide the functionality 
to configure the advanced diagnostic modules, to analyze the measured fieldbus physical layer 
data and to send alarms to a PCS. For the alarm integration, a volt-free contact can also be 
used for both integration methods.
The alarm contacts are NC contacts. The alarm contacts are closed, if no alarm is active and 
the contacts are opened if an alarm is active.
The volt-free contact alarming is built into the ADM HD2-DM-A and also supported by the diag-
nostic gateway. The installation depends on the diagnostic gateway and the integration method 
used.

Note
Use a cable with a minimum cross section of 4 mm².

1 Screw
2 Toothed lock washer
3 Cable lug
4 Grounding terminal on motherboard

1

2

3

4

2
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4.4.1 KT-MB-GT2AD.FF

FDS/OPC Integration
Each diagnostic bus carries its own volt-free contact lines. These lines are connected on the 
motherboard to the following terminals:

• Channel 1: Alarm output for diagnostic bus channel 1
• Channel 2: Alarm output for diagnostic bus channel 2

The common alarm output terminals are not used. The 2 diagnostic bus channels can be con-
nected separately to PCS inputs or can be wired in series.

FOUNDATION Fieldbus Integration
If the FOUNDATION Fieldbus integration is used the volt-free contacts can be used the same 
way as for the FDS/OPC integration. Beside this, the common alarm output can be configured 
to react to the FOUNDATION Fieldbus field diagnostic parameters. For more information, see 
chapter 7. Since the DGW-FF reads the alarm status of all connected ADMs using the 
8 communication lines of the diagnostic bus and sets the FF field diagnostic according to the 
status of the ADMs, the common alarm output can reflect the alarm status of the connected 
ADMs.

4.4.2 KT-MB-GT2AD.FF.IO

FDS/OPC Integration
The diagnostic gateway functionality allows configuring the outputs of the I/O motherboard 
according to the status of the field diagnostic parameters. This status can also be influenced by 
the binary inputs of the diagnostic bus alarm contacts.
Typically, binary input 5 and binary input 6 are configured to create a field diagnostic alarm and 
the common alarm output to be activated if any field diagnostic alarm becomes active.

FOUNDATION Fieldbus Integration
If the FOUNDATION Fieldbus integration is used, the volt-free contacts can be used the same 
way as for the FDS/OPC integration. Since the DGW-FF reads the alarm status of all connected 
ADMs using the communication lines of the diagnostic bus and sets the FOUNDATION Field-
bus field diagnostic according to the status of the ADMs, it is not required to read the ADM sta-
tus based on binary inputs. In this case, the binary input 5 and binary input 6 are not required to 
be connected to the I/O motherboard and can be used independently for other I/O purposes.

Note
The volt-free contact lines of the diagnostic bus of the ADM modules can be connected directly 
to a PCS input. The lines are not required to be connected to the motherboard of the diagnostic 
gateway. If this is applicable for an installation, binary input 5 and binary input 6 can be used 
independently for other I/O purposes.
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5 FDS/OPC Integration
The FDS/OPC integration uses the open standards OPC and FDT in order to integrate the 
FieldConnex® advanced diagnostics into the PCS. It is based on a server component called 
FieldConnex® diagnostic server (FDS). The FDS has the 2 following main tasks:

• The FDS includes an OPC server for OPC DA and AE. Alarms caused by physical layer 
issues are available to the PCS through this interface.

• The FDS provides access to the diagnostic gateways and ADMs for the diagnostic man-
ager. The diagnostic manager is the advanced diagnostics user interface and includes 
special user interfaces for commissioning, monitoring and troubleshooting.

The figure below shows the basic concept of this integration:

For many process control systems, so-called advanced diagnostic module (ADM) integration 
packages exist. These packages provide step-by-step guides and additional software tools to 
seamlessly integrate advanced diagnostics in a PCS. ADM projects including segment and 
field device tags are built directly from the PCS database. The alarm function and the diagnos-
tic manager are tightly integrated in the PCS asset management. Manual OPC configuration 
etc. is not required. Check www.pepperl-fuchs.com for available ADM integration packages.
The diagnostic manager can be deployed in either of the following 2 ways:

• For smaller fieldbus installations, it is recommended to use the local application struc-
ture. The diagnostic manager and FDS are installed on the same PC.

• For large fieldbus installations where real-time monitoring takes place from multiple com-
puters throughout the plant, it is recommended to use the remote application structure. 
The diagnostic manager and FDS are installed on different computers and communicate 
with each other using TCP/IP.

Required software:

• FDT frame, e. g., PACTwareTM or ADM integration package

• FieldConnex® diagnostic manager (DTMs and FDS)
• Appropriate software license:

• DTM-FC.AD for < 100 segments 
• DTM-FC.AD.1 > 100 segments
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5.1 Installation of Diagnostic Manager with PACTwareTM

Installing the Diagnostic Manager with PACTwareTM

Make sure you downloaded the software bundle that includes the diagnostic manager and all 
its tools and accessories, including PACTwareTM, the FieldConnex® diagnostic server, and the 
diagnostic gateway configuration tool from www.pepperl-fuchs.com. To install the diagnostic 
manager, proceed as follows:

1. Extract the software bundle to a local directory.

2. Go to the directory that includes the extracted files and run autorun.exe to start the installation 
wizard.

3. Select the software components you want to install and choose Install selected 
application(s).
We recommend that you install all components.

4. In order to install the Microsoft® .NET framework, follow the instructions of the installation 
dialog.

5. In order to install PACTwareTM, follow the instructions of the installation dialog.

6. In order to install the diagnostic manager, follow the instructions of the installation dialog.
Note that during the installation of the diagnostic manager, the diagnostic server and the OPC 
server are installed automatically. 

7. After the selected components have been installed, choose Quit to leave the installation 
wizard.

 The diagnostic manager and PACTwareTM have now been installed.

8. Run PACTwareTM.

9. Choose View > Device catalog.

10. Choose Update device catalog in the device catalog section.

Figure 5.1 Update device catalog

11. Choose Yes to create a new PACTwareTM device catalog.

12. Choose Extras > Options.

13. Set the Use memory-optimized project management check box.

14. Choose OK.

15. Choose File > Exit to quit PACTwareTM.

 PACTwareTM is ready for use.
Caution!
Network Connection Problems
The diagnostic server cannot connect to the network. 

After the setup is complete, disable the Windows® firewall for the diagnostic server.

http://www.pepperl-fuchs.com
http://www.pepperl-fuchs.com
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5.2 Licensing
To activate the full-featured version, you need a license key. The license key is printed on the 
license certificate you have optionally received with the FieldConnex® diagnostic manager soft-
ware package. If you have downloaded the diagnostic manager from the internet, a license key 
can be ordered through your local Pepperl+Fuchs representative.

Activating the License
Before entering the license key, make sure that the diagnostic manager is closed. 

1. Choose Start > Programs > Pepperl+Fuchs > Activation Tool to start the Pepperl+Fuchs 
license activation tool.

 The license activation tool dialog appears.

Figure 5.2 License activation tool
2. Enter your license key.

3. Choose Activate.

4. After the activation has been confirmed, choose Finish.

Note
Upgrade Information
After upgrading from diagnostic manager version 1.x to version 2.x activate the new version 
with the upgrade license key. After the complete reinstallation of the diagnostic manager (e.g., 
installation on a new PC), enter both license keys from version 1.x and 2.x one after the other 
into the license activation tool.
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5.3 FDS Control Center
The FieldConnex® diagnostic server (FDS) is part of the FieldConnex diagnostic manager 
setup and can be installed together with the DTMs for the local application structure as well as 
alone for the remote application structure. Beside providing access to the diagnostic hardware 
for the diagnostic manager DTMs it includes an OPC DA & AE server. This OPC server pro-
vides the alarm information of the advanced diagnostic system to a PCS. The FDS itself is built 
of 2 components:

• The FDS service is a Windows® service providing the FDS and OPC functionality.

• The FDS control center is a Windows® program for the configuration of the FDS service.
This chapter describes the configuration of the FDS using the FDS control center. For more 
information on data available at the OPC interface, see chapter 8.12

The FDS control center can be minimized to the Windows® notification section, where the cur-
rent status of the FDS is shown:

5.3.1 FDS Configuration
Step-by-Step FDS Configuration
By default, the FDS control center starts with Windows®. If the FDS control center does not 
start automatically, proceed as follows:

1. Choose Start > Programs > Pepperl+Fuchs > FDS Control Center.

 The FDS control center appears.
2. Choose Settings.

3. Set the Start control center automatically check box to make sure that the FDS control 
center starts automatically with Windows®.

4. If the remote application structure is used, activate the Adjust firewall to allow remote 
access check box, to disable the Windows® firewall for the FieldConnex diagnostic server.

5. You can change the SOAP communication port number. The default port is 25 061.

6. Choose OK.

7. Some settings take effect only after the FDS is restarted. Choose Stop FDS from the control 
center toolbar.

Figure 5.3 FDS Control Center toolbar
 The FDS status icon in the taskbar turns red.

Icon Description
Green status icon: FDS is running

Red status icon: FDS is not running
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8. After the server has stopped, choose Start FDS to restart the server with the updated settings.

 The FDS status icon in the taskbar turns green and the FDS is running with the updated set-
tings.

9. Choose Hide to minimize the FDS control center into the task bar.

5.3.2 FDS Configuration Options
Changing FDS Settings
In order to change the FDS startup behavior, proceed as follows:

1. Right-click on the FDS icon in the task bar.

2. Choose FDS Control Center.

 The FDS Control Center window appears.
3. Click the Stop FDS button.

4. Click Settings ...

5. Change the settings. For further information see table below.

6. Click OK.

7. Restart FDS.

Caution!
Network Connection Problems
The diagnostic server is not connected to the network.
Ensure that the Adjust firewall to allow remote access check box is set to "Disable Win-
dows® firewall" for the diagnostic server.
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The following settings can be made:

Control center settings Description
Start the control center automatically Every time the PC starts, the control center 

server starts, too.
Minimize the control center on startup The control center starts without the frontend 

application. The running application is visual-
ized by an icon in the task bar.

Startup type • Start manually: The FDS control center 
has to be started manually every time.

• Start with Windows: The FDS control 
center starts automatically when Win-
dows® is running (no user login required)

• Start with control center: Every time the 
FDS control center starts, the FDS server 
starts, too.

SOAP communication port Port number for SOAP communication by 
default: 25 061.

MODBUS read timeout Adjustment option for communication. 
Change only if a change was advised by Pep-
perl+Fuchs.
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5.4 Project Setup
A diagnostics project can be set up in either of the following ways:

• Manual setup: Enables you to build the diagnostic topology before the diagnostic bus is 
installed or if the diagnostic bus is currently inactive. See chapter 5.4.3

• Scanning: Enables you to import the topology from a diagnostic bus that is already 
installed and active. See chapter 5.4.6

• Import from a file: see chapter 5.4.7. The "Import from file" option is typically used for the 
ADM integration package available for the major process control systems. See "Applica-
tion Notes for the ADM Integration Packages" for details.

• Import from FDS: Reads back the project currently set at the FDS server. See chapter 
5.4.8

5.4.1 Tags Used in ADM Projects
An advanced diagnostic module (ADM) system uses tags for the diagnostic gateways, the 
ADMs, and the segments. Note that tags may only contain the following characters: 0 ... 9, 
a...z, A...Z, or the following special characters: $ ( ) - _. Other characters or blank spaces are 
not allowed. Tags of the same level must be unique, i.e., any 2 FDS ports or 2 diagnostic 
devices beneath the same FDS port must not be tagged identically.

5.4.2 Communication with the Diagnostic Gateway
In order to communicate with the diagnostic gateways (DGW), an IP address must be assigned 
to the device. The IP address can be set in either of the following ways:

• Set the IP address using DHCP (default setting)
• Set the IP address to a fixed IP address

In addition to the IP address, a tag can be assigned to each diagnostic gateway. Setting a tag 
allows a simple identification of the diagnostic gateway while creating a diagnostic project. The 
IP address setting and the tag can be modified using the diagnostic gateway configuration tool. 
For more information on the diagnostic gateway configuration tool, . It also supports communi-
cation to the diagnostic gateway if the web server cannot be used because of wrong IP address 
settings.
The next chapters introduce options to scan for available diagnostic gateways in several situa-
tions. As long as the FDS is located in the same subnet as the diagnostic gateways, the gate-
ways are detected automatically. If the diagnostic gateways are in a different IP subnet, the 
address of at least one diagnostic gateway in the other subnet must be entered manually. After 
that, all other diagnostic gateways in the remote subnet can also be scanned.

5.4.3 Manual Setup of a Diagnostic Project with PACTwareTM

Manually Modeling the Diagnostic Topology 
Before you start, ensure that the FieldConnex® diagnostic server (FDS) is running, the latest 
diagnostic manager is installed, and that the PACTwareTM device catalog is up-to-date. 

1. Start PACTwareTM.

2. Choose File > New to create a new project.

3. Choose View > Device Catalog to open the device catalog.

Adjust firewall to allow remote access Edit the firewall settings for the FDS server.
Read host name via OPC Enter the host name. The host name is used 

by OPC clients to find the FDS.

Control center settings Description
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4. Open the PEPPERL+FUCHS GmbH device folder.

Figure 5.4 Structure in the PACTwareTM device catalog
5. Select the Driver  folder.

Figure 5.5 Device overview of the Driver folder

6. Drag the FieldConnex® Diagnostic Server entry from the device catalog section on the HOST 
PC entry in the project section.

7. Select the Gateway folder in the device catalog section.

8. Drag the FDS Port entry from the device catalog section on the FieldConnex® Diagnostic 
Server entry in the project section.

9. Select the Device folder in the device catalog.

10. Drag the HD2-DM-A entry from the device catalog section on the FDS Port entry in the project 
section.

11. Right-click the FieldConnex® Diagnostic Server in your project section and select Parameter.

 The FDS Parameter tab opens.
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Figure 5.6 FieldConnex® Diagnostic Server (FDS) parameter tab

12. If PACTwareTM and FDS are running on the same system, select Local for the FDS Location.
If the FDS is running on a different system, for example in a remote application structure, select 
Remote for the FDS location and enter the IP address or DNS name of the remote PC. 
Enter the IP port of the FDS. Note that you can define the IP port for the FDS in the FDS control 
center. See chapter 5.3

Figure 5.7 Settings when the FDS is running on the same PC
 Now the diagnostic project looks similar to this example:
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Figure 5.8 Diagnostic project
13. Choose Apply to confirm changed settings.

5.4.4 Assign Diagnostic Gateway Addresses
Assigning Diagnostic Gateway Addresses (Option 1)

1. Right-click the FieldConnex® Diagnostic Server in the project section and choose 
Parameter.

2. Select the FDS Topology tab.

Figure 5.9 FDS Topology tab
3. Select the ??? port in the topology structure.

Figure 5.10 Unassigned Port
4. Enter port tag and IP address. 

Note
For fast creation of projects with a huge number of advanced diagnostic modules (ADM):
Build one FDS port with 62 diagnostic modules. if supported by the FDT software, you can use 
copy & paste to duplicate the new port in the project.

Note
Note that the maximum number of diagnostic modules per FDS port is 62.
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Figure 5.11 Port Properties
5. Choose Apply to confirm changed settings.

 IP address and tag of the Diagnostic Gateway are assigned to the port.

Assigning Diagnostic Gateway Addresses (Option 2)

1. Right-click the FieldConnex® Diagnostic Server in the project area and choose Connect.

2. Right-click the FieldConnex® Diagnostic Server in the project area and choose Parameter.

3. Select the FDS Topology tab.

Figure 5.12 FDS Topology tab
4. Select the Unassigned Diagnostic Gateways entry in the topology structure.

Figure 5.13 Unassigned Diagnostic Gateway
5. Choose Update in the Unassigned Diagnostic Gateways area.

 All Diagnostic Gateways located within the subnet are shown in the table.

Figure 5.14 All Gateways
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6. If the Diagnostic Gateway is located in a different subnet, enter its IP address in the Remote 
subnet IP address field and choose Add. 
Then choose Update to find all Diagnostic Gateways in the subnet.

Figure 5.15 Scanned gateways
7. To identify a gateway in the cabinet, select the gateway from the list and choose Locate 

selected gateway(s).
 Gateways LEDs are flashing in the cabinet.

8. Drag the Diagnostic Gateway from the Unassigned Diagnostic Gateways area on an 
unassigned ??? port in the topology structure.

 IP address and tag of the Diagnostic Gateway are automatically assigned to the port.

Figure 5.16 Assigned gateway
9. Choose Apply to confirm changed settings.

5.4.5 Assign HD2-DM-A Addresses
Registering the Device Address of Diagnostic Modules
Each advanced diagnostic module (ADM) has a device address that is assigned directly on the 
device. See chapter 4.1.2
In order to register the device address of each ADM, proceed as follows:

1. Right-click the FieldConnex® Diagnostic Server in the project section and choose 
Parameter.

2. Select the FDS Topology tab.

3. Select the ADM you want to configure in the topology structure.

4. Select the device address for the selected ADM in the Address of the ADM drop-down list.

Figure 5.17 Device address settings
5. Choose Apply to confirm changed settings.
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5.4.6 Scanning of a Diagnostic Installation for Project Setup
Importing the Topology 
Before you start, ensure that the FieldConnex® diagnostic server (FDS) is running, the latest 
diagnostic manager is installed, and that the PACTwareTM device catalog is up-to-date. 

1. Start PACTwareTM.

2. Choose File > New to create a new project.

3. Choose View > Device Catalog to open the device catalog.

4. Open the PEPPERL+FUCHS GmbH device folder.

Figure 5.18 Structure in the PACTwareTM device catalog
5. Select the Driver  folder.

Figure 5.19 Device overview of the Driver folder

6. Drag the FieldConnex® Diagnostic Server entry from the device catalog section on the HOST 
PC entry in the project section.

7. Right-click the FieldConnex® Diagnostic Server in the project section and choose Connect.

8. Right-click the FieldConnex® Diagnostic Server in the project section and choose Additional 
functions > Topology Scan and Import.

9. Select Scan Diagnostic Gateways.

Figure 5.20 Topology Scan or Import Source
10. Choose Next.
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11. If the diagnostic gateway is located in a different subnet, enter its IP address in the Remote 
subnet IP address field and choose Add. 
Then choose Update to find all diagnostic gateways in the subnet.
To identify a gateway in the cabinet, select the gateway from the list and choose Locate 
selected gateway(s).

Figure 5.21 Scanned gateways
12. Select the gateways to include in the project from the list of available gateways.

13. If required, you can set scan limits for the address range of the diagnostic devices in the Lower 
Scan Limit and Upper Scan Limit fields. Only HD2-DM-A addresses within the set limit will 
be scanned. This option can speed up the scanning process if only a few HD2-DM-A modules 
within a small address range are used in a project.

14. Choose Next.

 The topology scan function scans for diagnostic modules within the restricted address 
range and builds up the diagnostic topology automatically.

5.4.7 Import of Diagnostic Project from File
The "Import from file" option is typically used for the advanced diagnostic module (ADM) inte-
gration package available for the major process control systems (PCS). See the application 
notes for the ADM integration packages for details.

Importing the Configuration from File
Before you start, ensure that the FieldConnex® diagnostic server (FDS) is running, the latest 
diagnostic manager is installed, and that the PACTwareTM device catalog is up-to-date. 

1. Start PACTwareTM.

2. Open a PACTwareTM diagnostic project.

3. Choose View > Device Catalog to open the device catalog.

4. Open the PEPPERL+FUCHS GmbH device folder.

Figure 5.22 Structure in the PACTwareTM device catalog
5. Select the Driver  folder.

Figure 5.23 Device overview of the Driver folder
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6. Drag the FieldConnex® Diagnostic Server entry from the device catalog section on the HOST 
PC entry in the project section.

7. Right-click the FieldConnex® Diagnostic Server in the project section and choose Connect.

8. Right-click the FieldConnex® Diagnostic Server in the project section and choose Additional 
functions > Topology Scan and Import.

9. Select Read from File.

Figure 5.24 Topology scan or import source - Read from File
10. Choose Browse and select the file that contains the configuration you intend to import.

11. Choose Next.

 The wizard displays the configuration and the changes that will be made in your active proj-
ect.

12. Choose Next to confirm the changed settings and follow the instructions of the wizard.

5.4.8 Import of Diagnostic Project from FDS
The diagnostic manager provides an import function that enables you to import existing config-
urations and topologies from the FieldConnex® diagnostic server (FDS). Furthermore, the wiz-
ard enables you to compare and update the current project with the data of an existing FDS 
configuration.

Importing the Configuration from FDS
Before you start, ensure that the FieldConnex® diagnostic server (FDS) is running, the latest 
diagnostic manager is installed, and that the PACTwareTM device catalog is up-to-date. 

1. Start PACTwareTM.

2. Open a PACTwareTM diagnostic project.

3. Choose View > Device Catalog to open the device catalog.

4. Open the PEPPERL+FUCHS GmbH device folder.

Figure 5.25 Structure in the PACTwareTM device catalog
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5. Select the Driver  folder.

Figure 5.26 Device overview of the Driver folder

6. Drag the FieldConnex® Diagnostic Server entry from the device catalog section on the HOST 
PC entry in the project section.

7. Right-click the FieldConnex® Diagnostic Server in the project section and choose Connect.

8. Right-click the FieldConnex® Diagnostic Server in the project section and choose Additional 
functions > Topology Scan and Import.

9. Select Read from FDS.

Figure 5.27 Topology scan or import source - Read from FDS
10. Choose Next.

 The wizard displays the configuration and the changes that will be made in your active proj-
ect.

11. Choose Next to confirm the changed settings and follow the instructions of the wizard.

5.4.9 Set Snapshot Archive Location
By default, snapshots are stored in the diagnostic manager project file. For large fieldbus instal-
lations with many diagnostic devices, this project file increases rapidly. This can make file han-
dling complicated.

Caution!
Large Project Files
Large project files may cause the software to slow down. We recommend that you store snap-
shot data in an external file if the expected number of snapshots exceeds 4 000.

Caution!
Data Loss
Once the snapshot data has been stored in an external file, it cannot be stored in the project file 
again without losing the externally stored snapshots.
To prevent data loss, establish a backup solution for the external snapshots.
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Setting the Snapshot Archive Location

To change the snapshot archive location, proceed as follows:

1. Right-click the FieldConnex® Diagnostic Server in the project section and choose 
Parameter.

2. Select Manual Configuration (HD2-DM-A only) in the snapshot file location section.

Figure 5.28 Snapshot location
3. Enter the directory for the snapshot data in the Snapshot File Path field.

4. Choose Apply to confirm changed settings.

 The snapshot data will be stored in the Snapshot.mdb file, which is automatically created 
in the dedicated snapshot directory.

5.5 Operation with Device Type Managers (DTM)
The FDT/DTM based diagnostic manager is the graphic interface for the user of advanced 
diagnostic modules (ADM). The ADM contains all configuration settings, diagnostic informa-
tion, and device functionalities.
Before reading this chapter on the functionality of the diagnostic manager DTMs, see chapter 2 
and see chapter 8.10.

Note
Ensure that the directory where the snapshots will be saved already exists.

Note
Some functions and features are available only if the latest firmware version is installed on the 
HD2-DM-A module. A firmware supporting all features is integrated with this DTM and can be 
installed on any HD2-DM-A hardware. See chapter 7.11
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Main Functions of the Diagnostic Manager

5.6 Online Parameterization

5.6.1 Overview
The online parameterization interface is the main user interface of the diagnostic manager. It 
enables access to the most common functions and to the current segment data.

Opening the Online Parameterization Window
To open the online parameterization window, proceed as follows:

1. Right-click an Advanced Diagnostic Module in the project section.

2. Choose Parameter > Online Parameterization.

 The online parameterization window appears.

Online parameterization
See chapter 5.6

This is the main interface. It provides a short overview of 
the system and segments settings. Furthermore, it con-
tains the Related Tasks quick start section which 
enables you to access key features like segment com-
missioning, diagnostics, etc.

Commissioning wizard
See chapter 5.6.3

The commissioning wizard is a tool for fast and easy 
system setup with ADM. It guides you through the entire 
setup process with system and segment calculation.

Diagnostics
See chapter 5.7

The diagnostics function displays all alarms that have 
occurred at a glance.

Measured value
See chapter 5.8

This function enables fast validation of a new or 
reworked fieldbus installation. It displays a qualitative 
rating of the relevant segment and field device data. In 
order to save the results as a report, this function 
enables you to create a snapshot of the measured val-
ues.

Snapshot explorer
See chapter 5.9

The snapshot explorer simplifies administration and 
enables printing of existing snapshots and reports.

Parameterization
See chapter 5.10

This is an offline interface, which means that you can 
change these settings without having a direct connec-
tion to the diagnostic device. This interface enables you 
to define the power supply, the alarm settings, and the 
field devices per segment.

Advanced parameterization
See chapter 5.10

This interface enables detailed access to all possible 
settings of the HD2-DM-A. It is for advanced parameter-
ization and can be used to adjust the HD2-DM-A to 
some more seldom use cases not covered by the auto-
matic tools like the commissioning wizard.

History export
See chapter 5.11

Allows exporting the history data automatically record 
by the HD2-DM-A.

Fieldbus oscilloscope
See chapter 5.12

The fieldbus oscilloscope is the perfect tool for in-depth 
analysis of the fieldbus signal.

Firmware update
See chapter 5.13

The firmware update function enables you to update the 
firmware of a selected advanced diagnostic module 
(ADM).
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Figure 5.29 Online parameterization window

5.6.2 Settings
The Settings tab enables you to adjust segment settings, for example the fieldbus type and the 
recording intervals for the long-term history storage. The history function enables you to collect 
and export data in well-defined time intervals. See chapter 5.11.
Furthermore, the Settings tab displays the serial number of the diagnostic device and the firm-
ware version that is installed on the device.

Figure 5.30 Online parameterization settings window

1 General diagnostic module information
2 Quick start section
3 System and segment status information
4 Function tabs

1

2

3

4
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5.6.3 Commissioning Wizard
The commissioning wizard is a tool for fast and easy system setup with advanced diagnostic 
modules (ADM). It guides the user through the system and segment set up and determines the 
system and segment data of your fieldbus installation. Based on this information, the commis-
sioning wizard proposes limit values for all system, segment, and field device alarm values. If 
necessary, you can edit the limit values or store them on the ADM. After the commissioning 
wizard has been completed successfully, the ADM is ready for plant real-time monitoring.

Opening the Commissioning Wizard
In order to open the commissioning wizard, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Additional Functions > Commissioning Wizard.

 The commissioning wizard window appears.

Figure 5.31 Commissioning wizard window

5.6.4 System Commissioning
Performing System Commissioning with the Commissioning Wizard
In order to perform system commissioning, proceed as follows:

1. Open the commissioning wizard. See chapter 5.6.3

2. Select your fieldbus type from the Fieldbus Type drop-down list.

3. Choose System Commissioning.

 The system displays the current motherboard and power supply data.
4. Choose Next.

 The system takes a snapshot and displays the current system data with the automatically 
calculated maintenance and limits alarms.
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5. If necessary, you can modify these values before storing them on the advanced diagnostic 
module. Note that the out-of-specification alarm for the primary and secondary power supply 
will be enabled automatically by default.

6. Choose Next.

 System warning and alarm limit values are now stored on the diagnostic device.

Figure 5.32 System commissioning succeeded
7. Choose Restart to confirm changed settings and to return to the commissioning wizard start 

page.

5.6.5 Segment Commissioning
Performing Segment Commissioning with the Commissioning Wizard
To perform segment commissioning, proceed as follows:

1. Open the commissioning wizard. See chapter 5.6.3

2. Perform system commissioning. See chapter 5.6.4

3. In the segment commissioning section of the commissioning wizard start page choose the 
Segment  you want to commission.

 The topology settings window appears.
4. Choose Next.

 The field device tags window appears.
5. Choose Next.

 Current segment measurements and field device signal level tabs are shown.
6. Choose Next.

 The system takes a snapshot and generates a printable report that is stored in the snapshot 
explorer. See chapter 5.9. In case the expert system detects any issues while recording the 
snapshot, ensure to ignore these if you intend to proceed with the commissioning. Not 
ignoring them will cancel the commissioning procedure and generate a report of the failed 
commissioning. Before the report is generated, you can add a comment to the report and 
select an option to include characteristic oscilloscope recording fragments for each field 
device to the report.

7. Choose Next.

 The physical layer measurement report appears.
8. Choose Next.

 Current system data with automatically calculated limits are shown.



 2
02

0-
11

70

Advanced Diagnostics
FDS/OPC Integration

9. Choose Next.

 System warning and alarm limit values are now stored on the diagnostic device.

Figure 5.33 Segment commissioning succeeded
10. Choose Restart to confirm changed settings and to return to the commissioning wizard start 

page.
11. Repeat segment commissioning for the remaining segments.

5.6.6 Generate Report for HD2-DM-A.RO DIP Switch Settings
Once commissioning of all 4 segments is complete, the commissioning wizard supports gener-
ation of a report with the correct DIP switch settings for the HD2-DM-A.RO module.

Generating a HD2-DM-A.RO Settings Report
In order to generate a settings report for the HD2-DM-A.RO module, proceed as follows:

1. Open the commissioning wizard. See chapter 5.6.3

2. Perform system commissioning. See chapter 5.6.4

3. Perform segment commissioning. See chapter 5.6.5

4. In the HD2-DM-A.RO settings section of the commissioning wizard start page, choose 
Generate RO Report.

 The system generates a report that can be printed and saved.

Figure 5.34 Snapshot explorer - HD2-DM-A.RO settings report
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5.7 Diagnostics
The diagnostics function is for troubleshooting after an alarm of the advanced diagnostic mod-
ule (ADM) appeared in the process control system (PCS). It displays the currently active expert 
messages, as well as all active alarms and a history of the last 500 alarms detected by the 
ADM.

5.7.1 Expert Diagnostics
The expert diagnostics tab shows all expert messages of the selected segment, including a 
description of the detected phenomenon, a list of possible causes for the phenomenon and 
actions suggested to fix the issue.

Opening the Expert Diagnostics Tab
To open the expert diagnostics tab, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Diagnosis.

 The expert diagnostics window appears.

Figure 5.35 Expert diagnostics window

1 Overall segment quality
2 Summary diagnostic messages

1

2
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5.7.2 Current Alarms Diagnostics Tab
On the current alarms tab all active advanced diagnostic module (ADM) alarms are displayed. 
This tab shows all the active alarms from which the expert messages that are displayed on the 
expert diagnostics tab are derived.

Figure 5.36 Current alarms tab

5.7.3 Alarm History Diagnostics Tab
An alarm history is recorded automatically by the advanced diagnostic module (ADM) for the 
last 500 active alarm events. The alarm history tab shows the history including a timestamp 
when the event occurred.

Figure 5.37 Alarm history tab

1 Alarm summary
2 Segment and field device alarm
3 Possible cause and troubleshooting information

1

2

3

1 Filter function, filter settings, history export and clear history
2 Alarm history
3 Possible cause and troubleshooting information

1

2

3
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Alarm Icon Description
Each alarm in the alarm history column is shown with date, time, address, and type.
The alarm icon indicates whether the alarm is still active or whether it is inactive, i.e., the alarm 
situation is already over. See the example below.

Figure 5.38 Alarm icons: Active and inactive alarms

Filter Settings
The system displays all alarm messages by default. The filter enables you to create different 
views of the alarm history and to narrow down the history list.
The system includes different types of filters:

• Common filters that enable you to activate/deactive all filters or display active alarms only.
• Filters for system-specific alarms.
• Filters for segment-specific alarms.
• Filter for field-device-specific alarms. Note that if you set a field device alarm, you can 

reduce the view onto specific field devices by using the address filter drop-down list.

1 Active alarm
2 Inactive alarm

2
1
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Filter On/Off
Use the Filter On/Off button to activate or deactivate the filtered view.

Figure 5.39 Alarm history toolbar and filter settings

Exporting the Alarm History

1. Select a segment from the Device Navigation list.

2. Choose Export on the alarm history tab.

3. Enter the file name, type, and directory in the Export Alarm History section.

4. Choose Save to export the alarm history file.

Note
The system always saves the complete history, independent of the filter 
settings.
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5.8 Measured Value

5.8.1 System & Segment Measurement
The system & segment measurement function allows for fast validation of a new or reworked 
fieldbus installation. It provides a brief overview of the segment health and enables you to per-
form a detailed analysis.
You can also go to other functions right out of the Related Tasks section.

Opening the System and Segment Measurement
In order to open the system and segment measurement window, proceed as follows:

1. Right-click the Diagnostic Module in the project section.

2. Choose Measured value.

 The system & segment measurements window appears.

Figure 5.40 System & segment measurements overview

The analog measurement values are shown using a graph shown in the figure below. The val-
ues are classified according to Excellent, Good, and Out of Specification for the uncomis-
sioned mode and No Error, Maintenance Required and Out of Specification for the 
Commissioned mode, see chapter 2.2.

1 Function tabs
2 Segment overall quality
3 System and motherboard overall quality values
4 Segment measurements
5 Related tasks

12

3

4

5
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Figure 5.41 Signal level

Magnifying Glass
Click on the magnifying glass to see current field device data.

Figure 5.42 Magnifying glass

5.8.2 Field Device Signal Level
The field device signal level tab provides a graphical overview of the different devices and their 
signal level.

Figure 5.43 Field device signal level tab

1 Current value
2 Range for excellent value (green)
3 Range for good value (blue)
4 Range for exceeded value (yellow)
5 Maximum value occurred during operation
6 Minimum value occurred during operation

1 2 3

6 5 4
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5.8.3 Field Device Measurement
The field device measurements tab features a table that offers a live view of the essential phys-
ical layer values.

Figure 5.44 Field device measurements tab

5.8.4 Fieldbus Statistics
The fieldbus statistics tab provides a statistical overview of the communication frames 
received, errors, and other fieldbus values.

Figure 5.45 Fieldbus statistics tab

5.8.5 Snapshot Creation
A snapshot provides a detailed overview of the current segment settings and the communica-
tion quality. For data exchange, a snapshot including the current minimum and maximum noise, 
jitter, and signal level values of each device and the rated segment values can be printed or 
exported as an image, text, or PDF document.

Creating a Snapshot
In order to create a snapshot, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.
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2. Choose Measured value.

 The system & segment measurements window appears.

Figure 5.46 Create snapshot button
3. Choose Create Snapshot or Create Snapshot including Oscilloscope Recordings. The 

second option adds characteristic oscilloscope recording fragments for each field device to the 
report.

 Once all snapshot data is collected, the Save Snapshot Report window appears.

Figure 5.47 Save snapshot report window
4. Enter a description for the snapshot.

5. Choose Save to save the snapshot.

 The snapshot explorer window appears. See chapter 5.9

5.9 Snapshot Explorer
The snapshot explorer simplifies administration and enables the printout of existing snapshots 
and reports. These reports can be printed or exported as an image, text, PDF document, or 
diagnostic module snapshot (DMS) file. See chapter 5.8.5

Note
DMS is a file format for data exchange created by Pepperl+Fuchs.
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2 different templates can be selected: A clearly arranged default template and a compact tem-
plate that contains the same information using less space. You can export the report to Micro-
soft® Excel. This spreadsheet enables you to generate diagrams and perform individual 
calculations based on the report data.

Opening the Snapshot Explorer
In order to open the snapshot explorer, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Additional Functions > Snapshot Explorer.

 The snapshot explorer window appears.

Figure 5.48 Snapshot screen overview

5.9.1 Snapshot Toolbar

1 Toolbar
2 Snapshot collection
3 Report preview
4 Segment navigation panel

1

2

3

4

Button Name Result
Open Open a saved report.

Copy to (Export) Copy the selected report to another location. 
File types: PDF, RTF, TXT, DMS

Copy all to (Export all) Copy all reports to another location.
File type: DMS

Delete Delete the selected report.

Delete all Delete all reports.

Print Print the selected report.

Excel Export the selected report in Excel.

Settings Choose:
• Paper size (A4 or letter)
• Report type (compact template or detailed 

template)
Zoom in Enlarge the report.
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5.10 Advanced Parameterization and Parameterization
The diagnostic manager offers 2 user interfaces for detailed parameterization:

• Offline parameterization
• Online parameterization

These 2 interfaces allow tuning the behavior of all aspects of the advanced diagnostics. For 
typical operation, they are not required because measurement, commissioning wizard, and 
diagnostics offer a more advanced usage of the advanced physical layer diagnostics.
The main difference between the 2 user interfaces is their relationship to the advanced diag-
nostic module (ADM):

• Parameterization is an offline user interface. All data is stored in the FDT project. The data 
is not sent to the device until a download is executed. Use this user interface to view data 
loaded into the FDT project by an upload, e.g., for backup reasons.

• Advanced parameterization is an online interface. All changes are directly written to the 
device. The data is not stored automatically in the FDT project. In order to save the data to 
the FDT project, upload the data first.

Zoom out Reduce the report.

Zoom 100% View of the report of 100 %.

Fit to height Fit the view of the report on the height.

Fit to width Fit the view of the report on the width.

First page Go to the first page of the report.

Previous page Go to the previous page of the report.

Next page Go to the next page of the report.

Last page Go to the last page of the report.

Button Name Result
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Opening the Advanced Parameterization
In order to open the advanced parameterization window, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Additional Functions > Advanced Parameterization.

 The advanced parameterization window appears.

Figure 5.49 Advanced parameterization start window

Opening the Parameterization
To open the parameterization window, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section and choose Disconnect.

1 General diagnostic module information
2 Function tabs
3 Segment/field devices selectable via tree. The preceding icon shows diagnostic state of 

field device.
4 Field device handling see chapter 5.10.1

4
1

2

3
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2. Right-click the Advanced Diagnostic Module in the project section and choose Parameter > 
Parameterization.

 The parameterization window appears.

Figure 5.50 Parameterization start window

Components Overview

1 General diagnostic module information
2 Function tabs
3 Segment/field devices are selectable via tree. The preceding icon shows diagnostic state 

of field device.
4 Field device handling see chapter 5.10.1

Components Tabs and Settings
Diagnostic module System configuration

• General
• Motherboard configuration
• Motherboard bulk supply input voltage
Segment configuration
• Segment 1 ... 4 (enable segment)

Segment Segment configuration
• General
• Fieldbus supply module properties
• Measurement alarm settings
Segment topology settings
• Topology Settings
Field devices
• General
• Configured field devices

Field device • General
• Device information
• Settings

1

2

4

3
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5.10.1 Field Device Handling
The advanced diagnostic module (ADM) classifies the field devices as configured field devices 
and unconfigured field devices. See  also see chapter 2.2.4. The advanced parameterization 
allows for either of the following configured device list actions:

• Add unconfigured field devices
• Add new configured field devices
• Remove configured field devices that are no longer required

Adding an Unconfigured Field Device
In order to add an unconfigured field device, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section and choose Additional 
Functions > Advanced Parameterization.

 The advanced parameterization window appears.
2. Select the segment in the Device Navigation section.

 The segment window appears.
3. Select the Field Devices tab.

4. Mark the field devices you intend to add in the Unconfigured Field Devices section.

5. Choose Add selected Field Device.

Figure 5.51 Unconfigured field devices section
 The new field device is located in the configured field devices list.

6. Choose Apply.

Adding a New Field Device
In order to add a new field device, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section and choose Additional 
Functions > Advanced Parameterization.

 The advanced parameterization window appears.
2. Select the segment in the Device Navigation section.

 The segment window appears.

Note
For more information on the parameters, see chapter 5.8.
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3. Select the Field Devices tab.

4. Choose Add new Field Device in the configured field devices section.

Figure 5.52 Configured field devices section
 The new field device is located in the configured field devices list.

5. Choose Apply.

Removing a Field Device
In order to remove a field device, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section and choose Additional 
Functions > Advanced Parameterization.

 The advanced parameterization window appears.
2. Select the segment in the Device Navigation section.

 The segment window appears.
3. Select the Field Devices tab.

4. Mark the field device you want to remove in the Configured Field Devices section.

5. Choose Remove selected Field Device.

 The selected field device is removed from the configured field devices list.
6. Choose Apply.

Remove all Inactive Field Devices
To remove all inactive field devices, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section and choose Additional 
Functions > Advanced Parameterization.

 The advanced parameterization window appears.
2. Select the segment in the Device Navigation section.

 The segment window appears.
3. Select the Field Devices tab.

4. Choose Remove all inactive Field Devices in the configured field devices section.

 All inactive field devices are removed from the configured field devices list.
5. Choose Apply.
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5.11 History Export

5.11.1 Long-Term History
The long-term history function enables you to collect and store data in well-defined recording 
intervals. The minimum and maximum values of each measured value within the recording 
interval are stored as 1 data set. Recording intervals can range from 4 hours up to 7 days.

Defining the Recording Interval
In order to define the recording interval for the long-term history, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Parameter > Online Parameterization.

3. Select the required recording interval from the Long-term History drop-down list in the device 
settings section.

Figure 5.53 Long-term history drop-down list with different intervals
4. Choose Apply to confirm changed settings.

5.11.2 Export History
The export function enables you to convert the long-term history data into a commonly used 
document format, in order to use this data for your own calculations. The long-term history can 
be exported as Microsoft® Excel document, comma-separated values (CSV file), or binary his-
tory file (HIS).

Exporting the History Data
In order to export the long-term history data, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Additional Functions > History Export.

3. Select the segment and choose Start.

4. Select the required file format in the Export Type section and enter a file name in the 
Filename field.

Note
The data storage is limited to 100 data sets. New data sets will overwrite existing ones, i.e., data 
set 101 overwrites data set 1.
Depending on the defined recording interval, the long-term history can range from 17 days (4 h 
* 100 = 400 h = approx. 17 days) up to approx. 2 years.
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Figure 5.54 Export type and export settings
5. Choose Next.

6. After the export is complete, you can close the export function or choose Restart to export the 
long-term history for another segment.

5.11.3 Excel Export Feature
The diagnostic manager provides feature for exporting history data to Microsoft® Excel that 
enables fast and easy data exchange and reformatting of your physical layer data.
The physical layer data is exported into a special template. This template is designed to provide 
a detailed overview of all relevant parameters and enables you to create diagrams with one 
click.

Figure 5.55 History data overview in Excel
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5.12 Fieldbus Oscilloscope

5.12.1 Oscilloscope Recording Settings
The built-in oscilloscope enables in-depth analysis of the fieldbus signal level during a defined 
time period, for example, if a specific telegram type was detected or if communication issues 
occurred.

Opening the Fieldbus Oscilloscope
In order to open the fieldbus oscilloscope, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Additional Functions > Fieldbus Oscilloscope.

 The fieldbus oscilloscope window appears.

Figure 5.56 Record settings overview

1 Record toolbar
2 Start/cancel signal recording

 (depending in the system, a reaction delay of up to 5 s is possible)
3 Recording length

default value = 32.768 ms/sample rate = 2 MS/s
4 Recent recordings tab
5 Trigger events
6 Trigger options

1
23

4

6

5
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Recent Recordings
All oscilloscope recordings taken during one session are shown in the recent recordings sec-
tion.

5.12.2 Start Oscilloscope Recording
Starting the Recording
In order to start the oscilloscope recording, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Additional Functions > Fieldbus Oscilloscope.

 The fieldbus oscilloscope window appears.
3. You can select various trigger events in the Trigger Events section. See chapter 5.12.3

4. Choose Start Recording.

 The oscilloscope window appears.

Figure 5.57 Oscilloscope screen overview

Note
If you close the oscilloscope dialog, all unsaved recordings are lost.

1 Record toolbar
2 Overview screen
3 Information and users note
4 Zoom in view
5 Oscilloscope toolbar

1

2

3

4

5
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5.12.3 Trigger Description
To make sure that the triggered frame is valid, every trigger event occurs at the end of the 
frame.

Trigger Events for FOUNDATION Fieldbus

Trigger Events for PROFIBUS PA

Name Result
Pass Token to address Trigger if the specified addresses send frames 

after receiving a pass token.
ProbeNode to address Trigger if a probe node is sent to the specified 

address, but no probe node response is 
detected as the next frame.

Token usage from address Trigger if the specified addresses send frames 
after receiving a pass token.

Missing Token usage from address
(next valid bus address is triggered)

Trigger if a pass token is sent to the specified 
address, but is not used from this dress after-
wards. 

Probe Response from address Trigger if a probe node frame to the specified 
address is detected.

Missing Probe Node Response from address Trigger if a probe node is sent to the specified 
address, but no probe node response is 
detected as the next frame.

Claim LAS from address Trigger if a Claim LAS frame is detected from 
the specified address.

Transfer LAS to address Trigger if a Transfer LAS frame to a specified 
address is detected. 

Maintenance Required by address
(available since diagnostic manager version 
1.3)

Triggers when one of the parameters noise, jit-
ter or signal level gets into state maintenance 
required. 
Note: Amplitude, recording length, and pre-
trigger time are set automatically independent 
from the settings here. 

Out of Specification by address
(available since diagnostic manager version 
1.3)

Triggers when one of the parameters noise, jit-
ter or signal level gets into state out of specifi-
cation. 
Note: Amplitude, recording length, and pre-
trigger time are set automatically independent 
from the settings here.

Name Result
Request from address Trigger if any request frame is detected from 

the specified address.
Response from address Trigger if any response frame is detected from 

the specified address.
Missing Response from address
 (next valid bus address is triggered)

Trigger if the slave at the specified address 
does not respond on a request.

Pass Token to address Trigger if a pass token frame to the specified 
address is detected.

Missing Pass Token response from address Trigger if a master at the specified address 
does not react on a Pass Token frame.
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Other Trigger Events

5.12.4 Toolbars and Shortcuts

Recording Toolbar

Maintenance required by address
(available since diagnostic manager version 
1.3) 

Triggers when one of the parameters noise, jit-
ter or signal level gets into state maintenance 
required. 
Note: Amplitude, recording length, and pre-
trigger time are set automatically independent 
from the settings here. 

Out of Specification by address
(available since diagnostic manager version 
1.3) 

Triggers when one of the parameters noise, jit-
ter or signal level gets into state out of specifi-
cation. 
Note: Amplitude, recording length, and pre-
trigger time are set automatically independent 
from the settings here.

Name Result

Note
The CRC values of the advanced diagnostic module and the host system can differ, depending 
on the fault tolerances.

Name Result
CRC error Trigger if a fieldbus frame with a CRC error is 

detected.
Framing error Trigger if a frame is invalid (e. g., SOF 

detected but EOF missing).
Signal level Trigger if a voltage higher than the specified 

value is detected. Triggers exist for signals, 
noise, etc.

Note
If you close the oscilloscope dialog, all unsaved recordings are lost.

Button Name Result
Cancel Recording Cancel the current oscillo-

scope record.
Open Open a saved oscilloscope 

record.
Save Save oscilloscope record as 

XML-file.
Export as Image Save the current view of the 

oscilloscope graph as image.
File types: png, jpeg, gif, bmp

Page Setup The page setup object con-
tains all page setup attributes: 
Paper size, left margin, bottom 
margin and so on.

Print Print the current view of the 
oscilloscope graph.
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Oscilloscope Toolbar

 Oscilloscope Shortcuts

Button Name Result
Move Grip and move the graph. 

Press and hold the left mouse 
button.

Horizontal marker Measure the time difference. 
Press left mouse button to set 
the first marker and press the 
right mouse button to set the 
last marker. 

Vertical marker Measure the voltage differ-
ence. Press the left mouse 
button to set the upper marker 
and press the right mouse but-
ton to set the lower marker.

Rectangular marker Measure time and voltage dif-
ference. Press and hold the 
left mouse button to set the 
rectangular marker.

Marker measurement Measure the time and voltage 
at one point.

Zoom in Enlarge the view of the graph.

Scale 1:1 See 1:1 graph size.

Zoom out Reduce the view of the graph.

Analysis On/Off different view of the 
graph.
Different Layers: 1-bit level, 1 
section, 2 short, 2 full

Button Shortcut Result
Drag while left mouse button 
is pressed

Move the waveform to the 
left/right.

Double-click left mouse button Sets the maximum cursor to 
the maximum value of the cur-
rently visible part of the wave-
form.

Double-click right mouse but-
ton

Sets the minimum cursor to 
the minimum value of the cur-
rently visible part of the wave-
form.

All tools Double-click on telegram in 
overview section 

Shows the complete frame in 
detail/zoom-in view.

All tools CTRL + mouse wheel Increases/decreases the 
zoom factor.
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5.13 Firmware Update
The firmware update function enables you to benefit from the latest software developments.

Firmware Update

Before you perform a firmware update, ensure that all diagnostic manager windows are closed 
and that the ADM is connected and online.

1. Right-click the Advanced Diagnostic Module in the project section and choose Additional 
Functions > Firmware Update.

 The firmware update window appears.

Figure 5.58 Firmware update tab
2. Choose Check Device in the device data section.

 The firmware file section displays the product description and the current firmware version 
of the selected device.

3. Select the firmware source in the Firmware File section.

4. Choose Next.

5. After the firmware has been updated successfully, choose Close.

Figure 5.59 Firmware update successful

Warning!
Connection Loss
In some situations, the advanced diagnostic module (ADM) disconnects 
during the update process. Do not try to reconnect manually. The ADM recon-
nects automatically after a short time.
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5.14 FDS Diagnostics
The FSD DTM offers a diagnostics view. This diagnostics gives an overview of all currently 
active alarms for the segments connected to the FDS, as well as the last time an alarm was 
active for a segment. With the Open button you can directly open the segment diagnostics 
view for the respective segment.

It is also possible to filter the displayed segments to show only currently active alarms or to 
show segments with an active alarm during several periods of time. This is especially helpful if 
volt-free contact integration is used and you intend to check which segment generated the 
alarm.
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5.15 FDS Reporting Wizard
The FDS reporting wizard allows creating reports of all segments connected to an FDS. Cur-
rently, one report type is supported:

• Surge protector status

If you use FieldConnex® surge protectors with diagnostics, this report gives you an overview of 
all currently detected issues related to the surge protectors. It can be used to check the surge 
protectors after a surge incident.

Checking the Surge Protector Status

1. Start the reporting wizard.

2. Select the report type.

3. Optionally enter a comment to include into the report.

4. Click Next.

 The report is being generated.
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6 FOUNDATION Fieldbus Integration
The FOUNDATION Fieldbus integration is based on an FF-H1 field device inside the diagnostic 
gateway. These devices map the data of up to 16 HD2-DM-A modules to FOUNDATION Field-
bus data structure.
Both the measurement data and the expert system evaluations of the data are available inside 
the data structures of transducer blocks. Advanced diagnostic modules (ADM) alarms are sent 
to a process control system (PCS) using block alarms, field diagnostic alarms, or scheduled 
function block data.
Beside the DD for integration into the PCS, also a DTM is available providing a more comfort-
able access to the advanced physical layer diagnostic functionality and additional functions.
The FF-H1 field device supports up to 16 HD2-DM-A ADMs, with each providing 4 segments. 
This results in 64 segments supported by one diagnostic gateway in FF-H1 mode.
Each segment supports up to 18 FF-H1 field devices including the host(s).
Before reading this chapter, see chapter 2.

6.1 FF Device Structure
The device consists of the following function blocks:

• 1 resource block
• 16 ADM_TB transducer blocks: Each block corresponds to 1 ADM with 4 segments
• 1 IO_TB transducer blocks: The I/O functionality of the device is described in a separate 

chapter. See chapter 7
• 4 multiple digital input (MDI) function blocks
• 1 digital input (DI) function block
• 1 multiple analog input (MAI) function block only usable for IO_TB
• 1 multiple digital output (MDO) function block only usable for IO_TB

The following image shows a simplified device structure that only takes ADM_TB transducer 
blocks and the associated function blocks into account. For more information on the IO_TB and 
its corresponding function blocks, see chapter 7.
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Device identification:
• Manufacturer ID: 502B46 (Pepperl+Fuchs)
• Device type: 0005 (HD2-GT-2AD.FF.IO)
• Default process data (PD) tag: P+F DGW-FF plus 8-times underscore plus 14-digit serial 

number
• Default node address: 248

ADM Mapping and Address Assignment
The diagnostic gateway FF-H1 field device contains 16 transducer blocks for ADMs. Each of 
these transducer blocks includes the 4 segments supported by an HD2-DM-A. The ADMs are 
mapped to the transducer blocks based on their address. The address is set using a DIP switch 
located on the module. See chapter 4.1.2.

ADM Address/Transducer 
Block Number Default Tag Service Data (OD) Index
1 ADM_TB_1 serial number 500
2 ADM_TB_2 serial number 600
3 ADM_TB_3 serial number 700
4 ADM_TB_4 serial number 800
5 ADM_TB_5 serial number 900
6 ADM_TB_6 serial number 1000

Function blocks

DI

Field
DIAG

Summary
Status

MDI

M

MDI
RESB

FF Stack

CH 1, 11

CH 2, 3, 12, 13

CH 201

Transducer Blocks

ADM
TB
1

ADM
TB
2

ADM
TB
15

ADM
TB
16

H1DIAG
Bus 1

DIAG
Bus 2
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6.2 Installation
Typically, the FF-H1 field device built into the diagnostic gateway is connected to the host of a 
PCS, using FF-H1 as every other FF-H1 field device. For more information on the installation 
and the related terminals, see chapter 4.

Beside the main connection using FF-H1 there are 2 more options if the DTM is used:
• FF-H1 for basic communication and Ethernet for advanced communication
• FF-H1-over-Ethernet connection

FF-H1 for Basic Communication and Ethernet for Advanced 
Communication
The FieldConnex® advanced physical layer diagnostics features "history report" and "fieldbus 
oscilloscope" require large amounts of data transferred to the DTM. Since FF-H1 is not suitable 
for transferring this amount of data, the DTM uses TCP/IP communication. There is no configu-
ration required to support this functionality. If you connect Ethernet to the diagnostic gateway in 
addition to FF-H1, the DGW-FF DTM automatically detects and uses Ethernet for the history 
and oscilloscope data. All other data is communicated using FF-H1.
If a firewall is used between the PC running the DGW-FF DTM and the diagnostic gateway, the 
TCP/IP ports 25 063 and 25 064 must be allowed for communication.

7 ADM_TB_7 serial number 1100
8 ADM_TB_8 serial number 1200
9 ADM_TB_9 serial number 1300
10 ADM_TB_10 serial number 1400
11 ADM_TB_11 serial number 1500
12 ADM_TB_12 serial number 1600
13 ADM_TB_13 serial number 1700
14 ADM_TB_14 serial number 1800
15 ADM_TB_15 serial number 1900
16 ADM_TB_16 serial number 2000

ADM Address/Transducer 
Block Number Default Tag Service Data (OD) Index

Note
The devices can be connected to any of the 2 diagnostic bus channels. For best performance 
connect the same number of HD2-DM-A to each diagnostic bus channel.

Note
It is recommended to connect all DGW-FF devices in your application to a specific FF 
segment(s) diagnostics to clearly separate the diagnostics from the actual process 
functionality.
It is recommended that the diagnostic segments provide a high amount of free communication 
time to allow an efficient use of the advanced diagnostic data.
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FF-H1-over-Ethernet Connection
During commissioning of a plant, the host may not be available yet, but commissioning of the 
physical layer is already being executed. For these use cases, a PC (e.g., laptop) can be con-
nected to the diagnostic gateway using Ethernet. Alternatively, Ethernet communication can be 
used since the communication performance is much higher. The DGW-FF DTM can be con-
nected to a special communication DTM included in the same installation package. This com-
munication DTM transfers the FF-H1 communication over Ethernet and allows the DGW-FF 
DTM to provide the same functionality as via FF-H1. Typically, a stand-alone FDT frame like 
PACTwareTM is used for this setup. For more information, see chapter 6.7.
After the commissioning, you can upload the configuration data to your PCS with FF-H1. Com-
missioning reports can be transferred to a DTM inside the PCS by exporting and importing 
reports.

6.3 Alarm Integration
Advanced diagnostic module (ADM) alarms are sent to a process control system (PCS) with 
block alarms, field diagnostic alarms, or scheduled function block data.

6.3.1 Alarm Integration with Scheduled Function Block Data
The status of ADMs can be transferred in different ways using scheduled communication:

• Summary status: This is a summary of the status for all ADMs connected to the DGW-FF.
• ADM status: A single status value for each of the ADMs (4 segments).
• Field diagnostic value: The currently worst active status of field diagnostic is transferred 

as an enumeration using a digital input (DI) function block.
Each of these 3 methods can transfer binary information (alarm - no alarm) or an enumeration 
showing more details (no error, maintenance required, out of specification, etc.)

Summary Status for all ADMs (DI Function Block)
Add DGW-FF digital input (DI) function block to your schedule.
Channels:

• Binary Status all ADMs (Channel 1): Value is 0 (no error) or 1 (other status). 
"1" means any segment or system on an ADM_TB in AUTO mode has a status other than 
"no error", "excellent", "good" or "segment disabled".

• Enum Status all ADMs (Channel 11): Worst status for all systems and segments of 
ADM_TBs in AUTO mode. The value uses the following encoding:

Value Description
00h No error (segment commissioned)
01h Maintenance required (segment commissioned)
02h Out of specification (segment commissioned) 
10h Excellent (segment non-commissioned)
11h Good (segment non-commissioned)
12h Out of specification (segment non-commissioned)
20h Fail (ADM hardware error)
21h Configuration error (of an ADM transducer block)
22h No ADM connected
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ADM Status (MDI Function Blocks)
Add 1 or 2 DGW-FF multiple digital input (MDI) function blocks to your schedule. 
If you use 1 ... 8 ADMs, 1 MDI is sufficient. If you use 9 ... 16 ADMs, 2 MDI function blocks are 
required.
Channels:

• Binary Status ADM x-y (Channel 2, 3): Value is 0 (no error) or 1 (other status). 
"1" means any segment or system on the related ADM has a status other than "no error", 
"excellent", "good" or "segment disabled".

• Enum Status ADM x-y (Channel 12, 13): Worst status for all systems and segments of 
ADM_TBs in AUTO mode. The encoding is the same as for the enum status of all ADMs 
listed above.
Channel 2 and 12 correspond to ADM_TB 1 ... 8, channel 3 and 13 correspond to 
ADM_TB 9 ... 16.

Field Diagnostic Value (DI Function Block)
Add DGW-FF digital input (DI) function block to your schedule.
Channel:
Field Diagnostics (Channel 201): The current worst active status of field diagnostics is trans-
ferred as an enumeration using a DI. The data the field diagnostic status is built from can be 
configured at the resource block and may also include other diagnosis information in addition 
to the ADM information. The value uses the following encoding:

6.3.2 Field Diagnostics
The FF-H1 field device built in the DGW-FF supports field diagnostics according to FF-912. 
This also includes alarm information from the ADMs. For more information, see chapter 8.4.

6.3.3 Transducer Block Alarms
The ADM transducer blocks support block alarms. If the status of any segment shows an error, 
i.e., if the XD status is not "Good", "Excellent" or "No error", a block alarm with a BLOCK_ERR 
value of the other is activated.

6.4 Operation with Device Descriptions (DD)
The DGW-FF supports the following Device Description Languages (DDL): DD4, and EDDL 
(Electronic Device Description Language, also DD5). DD4 only supports a reduced set of fea-
tures compared to EDDL. Therefore, it is recommended to use EDDL if your process control 
system (PCS) supports this option. The differences are explained in the following chapters. For 
more information on all parameters supported by the FF-H1 field device, see chapter 8.2.
EDDL (DD5) contains 2 sets of menus for the use cases configuration and diagnostics. The 
configuration menu contains all parameters necessary to configure the maintenance limits. The 
diagnostics menu provides an overview of the actual measured values and diagnosis informa-
tion.

Value Description
00h No error
30h Check function
01h Maintenance required
02h Out of specification
20h Fail
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6.4.1 Configuration
It is recommended to use the commissioning wizard for configuration of the segment, since this 
is the fastest and safest way of adjusting the maintenance limits. However, it is also possible to 
configure a segment manually; all necessary settings are available as FF parameters. For sys-
tems that do not support all EDDL (DD5) features, a list of parameters of the ADM_TB is avail-
able. See chapter 8.2.1

System
• Block tag: Block tag of the ADM_TB.
• History period: Time difference between non-volatile storage of segment measurement 

entry. These entries can only be read using the history export function. See chapter 5.11
• Identify diagnostic module: Causes LEDs of diagnostic module to flash.
• ADM firmware update: Updates the advanced diagnostic module (ADM) to the firmware 

built into the HD2–GT–2AD.FF.IO device. Only 1 ADM can be updated at a time. Check 
the expert diagnostic messages in the diagnostic segment user interfaces for the update 
status.

Segment
• Segment tag: Tag of the segment. Should be set to the same tag as the physical segment 

for reference.
• Segment mode: Select the segment mode. For more information on the segment mode, 

see chapter 2.
• Disabled: Segment is not used.
• Non-commissioned: Segment operates in non-commissioned mode.
• Commissioned: Segment operates in commissioned mode.

• Power supply real-time monitoring: Enables or disables real-time monitoring of power 
supplies. When checked, an alarm is generated when a power supply module is not 
inserted or not working correctly. This setting is effective in commissioned mode only.

• Trunk surge protector alarm: When enabled, trunk surge protector alarms are monitored. 
This setting is effective in commissioned mode only.

• Segment X commissioning button-method: Starts commissioning wizard. See chapter 
6.5.1

• Segment X commissioning (simple-mode-) method: Starts a simple commissioning 
method. This approach is useful for hosts that do not support the necessary EDDL fea-
tures for the full-blown commissioning wizard.

• Segment X tag import (simple-mode-) method: Starts a simple tag import method. This 
approach is useful for hosts that do not support the necessary EDDL features for the full-
blown commissioning wizard.

Topology
Topology information is used in non-commissioned mode to refine diagnostics. The quality of 
the expert system messages is improved if the topology of the segment is known.
Configuration grid
The configuration grid provides the possibility to change the maintenance-required limits of 
several segment parameters and to enable or disable monitoring of out-of-specification limits. 
All settings on this page are effective in commissioned mode only. A value of “0” disables real-
time monitoring of the limits.

• Voltage: Segment voltage limits
• Current: Segment current consumption
• Unbalance: Segment unbalance against positive or negative pole
• Noise: Segment noise level
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• Jitter: Maximum field device jitter value on the segment
• Minimum signal: Lowest field device signal level on the segment
• Maximum signal level: Highest field device signal level on the segment

Field Devices
This page allows the configuration of limits and information about the field devices attached to 
the segment. All devices detected on the fieldbus that are not available in this list are unconfig-
ured field devices.

• Address: When address is “0”, the entry is not used.
• Tag: Field device tag. It is recommended to use the tag import wizard, included in the 

commissioning wizard, see chapter 6.5.1 for automatic tag reading from field devices.
• Signal level maintenance required limits: When limit is set to “0”, the limit is not super-

vised.
• Signal level out of specification limits: Can be enabled and disabled. When limit is set to 

“0”, the limit is not supervised.
• Coupler Alarms maintenance required or out of specification: When device couplers with 

diagnostics are used, the alarms can be enabled and disabled.

6.4.2 Configuration Limitations
The configuration parameters have the following limitations that result in a configuration block 
error:

• Maximum segment voltage > (minimum segment voltage + 1.6 V)
• Maximum segment current > (minimum segment current + 40 mA)
• Maximum segment unbalance > (minimum segment unbalance + 40%)
• Address of all configured nodes must be unique

6.4.3 Diagnostics
The diagnostic user interfaces show the currently measured values of system and segment, as 
well as the expert system messages for simplified diagnostics and remedy of potential prob-
lems.

System
• Block tag: Tag of the ADM_TB.
• Serial number: Serial number of connected HD2-DM-A module.
• Software revision: Software revision of connected HD2-DM-A module.
• Motherboard type: Motherboard the module is mounted on.
• Bulk power supply: Currently measured value and out-of-specification limits.
• ADM diagnostics: Overview of system and all segment states.
• Identify diagnostic module method: When clicked, the LEDs of the connected ADM start 

flashing.
• System alarms: Bulk power supply diagnostics, high/low out-of-specification for the pri-

mary and secondary power supply.

Note
In case of a configuration block error, check the expert system messages for information on 
which error is causing the problem.
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Segment
Overview

• Segment tag: Tag of the segment
• Segment mode: Current segment mode (disabled, non-commissioned, commissioned)
• Segment status: Overall segment diagnostics quality
• Active diagnostics: Expert system messages about the current status of the segment. The 

message describes the phenomenon detected on the fieldbus. Every expert system mes-
sage has a unique number assigned. For more information on the causes of any detected 
phenomenon as well as actions to solve the found issues, .

Statistics
• Communication active: Indicates whether communication is detected on the segment
• Number of field devices: The total number of active field devices on the segment
• Error rate in actual history period: Percentage of broken telegrams in current history 

period
• Error rate in last history period: Percentage of broken telegrams in last history period. His-

tory period length is configurable on system configuration page.
List of current segment measurements

• Voltage: Segment voltage
• Current: Segment current consumption
• Unbalance: Segment unbalance to positive or negative pole
• Noise: Segment noise
• Jitter: Maximum field device jitter
• Minimum signal level: Minimum field device signal level
• Maximum signal level: Maximum field device signal level

Diagnosis
• Segment alarms: List of segment alarms (valid when segment is running in commissioned 

mode)
• Segment quality: List of segment quality analysis (valid when segment is in non-commis-

sioned mode)

Field Devices
The list “configured field devices” shows the current measured values of all configured field 
devices. You can see the current signal and jitter levels and the device status.
The “Unconfigured field devices” list shows all currently active unconfigured field devices and 
their measurement data.

6.5 Supported Methods

6.5.1 Commissioning Wizard

The EDDL user interface provides a wizard to execute commissioning on a system. It consists 
of the following steps:

1. Welcome page

Note
It is strongly recommended to perform a commissioning run for each segment once all the 
installation work is completed.
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2. Topology information: Using the topology information that can be entered here, the expert 
system can refine its diagnostics of the current segment measurement information. This is 
useful in step 4.

3. Field device tagging: In this step, tags for the field devices can be assigned in either of the 
following 2 ways: 

• Entering tags manually in a grid.
• Using a tag import wizard: The tag import wizard can import the tags of most devices 

on the segment automatically. This method is used most often except for the host 
itself. In order to use this wizard, it is necessary to disconnect the host from and 
reconnect the host to the affected segment. Follow the instructions of the wizard.

4. Show actual segment diagnostics based on topology information provided in step 2. This 
is the last possibility make any corrections on the segment before the actual commission-
ing run. Ensure that all problems on the segment are fixed before proceeding with next 
step of the wizard.

5. The actual commissioning is running automatically and takes several seconds to collect 
enough measurement data. The commissioning wizard configures the alarm limits auto-
matically based on the measured data.

6. Presentation of commissioning result. You can review and edit the adjustments of the 
maintenance limits that the commissioning algorithm set automatically. The segment is 
now running in commissioned mode.

Segment Commissioning (Simple Mode)
Method also supported by DD4. Only step 5 of the commissioning wizard is executed.

Segment Tag Import (Simple Mode)
Method also supported by DD4. This method can import the tags of most devices on the seg-
ment automatically. This method is used most often except for the host itself. In order to use this 
wizard, it is necessary to disconnect the host from and reconnect the host to the affected seg-
ment. Follow the instructions of the wizard.

Identify Diagnostic Module (Flash LEDs)
Method also supported by DD4. This method causes the HD2-DM-A module to have all LEDs 
flashing for identification purpose.

ADM Firmware Update
The DGW-FF has an ADM firmware built in. This method can be used to update an ADM to any 
firmware compatible with the DGW-FF.

6.6 Installation of DGW-FF Device Type Managers with PACTwareTM

Installing DGW-FF Device Type Managers with PACTwareTM

Ensure you downloaded the software bundle that includes the DGW-FF device type manager 
(DTM) and all its tools and accessories, e.g., PACTwareTM, and the diagnostic gateway config-
uration tool from www.pepperl-fuchs.com. In order to install the FieldConnex® DGW-FF DTMs, 
proceed as follows:

1. Extract the software bundle to a local directory.

2. Go to the directory that includes the extracted files and run autorun.exe to start the installation 
wizard.

3. Select the software components you want to install and choose Install selected 
application(s).
We recommend that you install all components.

http://www.pepperl-fuchs.com
http://www.pepperl-fuchs.com
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4. In order to install the Microsoft® .NET framework, follow the instructions of the installation 
dialog.

5. In order to install PACTwareTM, follow the instructions of the installation dialog.

6. In order to install the FieldConnex DGW-FF DTMs, follow the instructions of the installation 
dialog.

7. After the selected components have been installed, choose Quit to leave the installation 
wizard.

 The DGW-FF DTMs and PACTwareTM are now installed.
8. Run the FieldConnex diagnostic gateway DTM.

9. Choose View > Device catalog.

10. Choose Update device catalog in the device catalog section.

Figure 6.1 Update device catalog

11. Choose Yes to create a new PACTwareTM device catalog.

12. Choose OK.

13. Choose File > Exit to quit PACTwareTM.

 PACTwareTM is ready for use.

Licensing
In order to activate the full-featured version, a license key is needed. The license key is printed 
on the license certificate you have optionally received with the FieldConnex diagnostic man-
ager software package. If you have downloaded the FieldConnex diagnostic manager from the 
internet, a license key can be ordered through your local Pepperl+Fuchs representative.

Note
Upgrade Information
After upgrading from diagnostic manager version 1.x to version 2.x, activate the new version 
with the upgrade license key. After complete reinstallation of the diagnostic manager, e.g., the 
installation on a new PC, enter both license keys from version 1.x and 2.x, one after the other, 
into the license activation tool.
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License Activation
Before entering the license key, ensure that the diagnostic manager is closed. 

1. Choose Start > Programs > Pepperl+Fuchs > Activation Tool to start the Pepperl+Fuchs 
license activation tool.

 The license activation tool window appears.

Figure 6.2 License activation tool
2. Enter your license key.

3. Choose Activate.

4. After the activation has been confirmed, choose Finish.

6.7 Project Setup
The DGW-FF DTM for the HD2-GT-2AD.FF.IO can be used in 2 different project structures:

Use the FF-H1 Communication DTM
The HD2-GT-2AD.FF.IO DTM can be connected to any FF-H1 communication DTM and FF-H1 
communication channel of your PCS. The communication to the device takes place using FF-
H1. Refer to the documentation of your field device tool (FDT) frame on how to connect the 
HD2-GT-2AD.FF.IO DTM to an FF-H1 communication channel.

Use the HD2-GT-2AD.FF.IO Communication DTM
During commissioning of a plant, the host may not be available yet, but the physical layer must 
already be commissioned. For such use cases, a PC, e.g., a laptop, can be connected to the 
diagnostic gateway via Ethernet. Alternatively, Ethernet communication with a much higher 
communication performance can be used. The DGW-FF DTM can be connected to a special 
communication DTM included in the same installation package. This communication DTM 
transfers the FOUNDATION Fieldbus H1 communication over Ethernet and allows the DGW-
FF DTM to provide the same functionality as via FOUNDATION Fieldbus H1.  Typically, a 
stand-alone FDT frame, e.g., PACTwareTM is used for this setup.
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6.8 HD2-GT-2AD.FF.IO Device Type Manager (DTM)
The DTM provides the following functions:

6.8.1 Online Parameterization and Parameterization
The online parameterization and parameterization provide detailed access to all settings of the 
FF diagnostic gateway. It is typically used for detailed tuning of the ADM functionality, configu-
ration of the I/O functionality and access to the resource and function blocks. For easy and fast 
configuration of the ADM functionality, it is recommended to use more advanced tools such as 
the commissioning wizard.
On the initial page, the online parameterization shows an overview of all function blocks.

Online parameterization
See chapter 6.8.1

This interface enables detailed access to all possible settings 
of the HD2-DM-A. It is for advanced parameterization and can 
be used to adjust the HD2-DM-A to some more seldom use 
cases not covered by the automatic tools like the commission-
ing wizard.

Commissioning wizard
See chapter 6.8.2

The commissioning wizard is a tool for fast and easy system 
setup with ADM. It guides you through the entire setup pro-
cess with system and segment calculation.

Diagnostics
See chapter 6.8.3

The diagnostics function displays all alarms that have 
occurred at a glance.

Measured values
See chapter 6.8.4

This function enables fast validation of a new or reworked 
fieldbus installation. It displays a qualitative rating of the rele-
vant segment and field device data. In order to save the results 
as a report, this function enables you to create a snapshot of 
the measured values.

Snapshot explorer
See chapter 6.8.7

The snapshot explorer simplifies administration and enables 
printing of existing snapshots and reports.

Parameterization
See chapter 6.8.1

This is an offline interface, which means that you can change 
these settings without having a direct connection to the diag-
nostic device. This interface enables you to define the power 
supply, the alarm settings, and the field devices per segment.

History export
See chapter 6.8.6

Allows exporting the history data automatically record by the 
HD2–DM–A.

Fieldbus oscilloscope
See chapter 6.8.8

The fieldbus oscilloscope is the perfect tool for in-depth analy-
sis of the fieldbus signal.

Tag import wizard
See chapter 6.8.9

This wizard provides the option to import segment and device 
tags from the PCS to the DGW-FF.

Reporting wizard
See chapter 6.8.10

Generates overview Reports for all segments connected to the 
diagnostic gateway.
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The overview also shows if the actual mode of a block is not equal to the normal mode. All 
unused blocks, e.g., unused function blocks, or ADM transducer blocks with no ADM con-
nected, are usually set to out-of-specification (OOS) in order to exclude them from any sum-
mary diagnostics. For the ADM transducer blocks, this can be done automatically:

Excluding All Unused ADM Transducer Blocks from Summary 
Diagnostics
In order to configure the modes of all ADM transducer blocks automatically, click on Execute at 
the "Configure ADM Modes automatically" command.

 All blocks where a corresponding ADM is connected are set to normal and target mode 
"AUTO". All other blocks are set to normal and target mode "OOS".
If any other block of the device is selected in the navigation tree, all available configuration set-
tings are shown on the right-hand side. For more information on parameters, see chapter 8.2.

6.8.2 Commissioning Wizard
The commissioning wizard is the recommended way to perform segment commissioning. The 
wizard guides you through all necessary steps to set tags of field devices and debug the seg-
ment. A report containing all segment measurements is generated to document the segment 
state at the time of commissioning run.
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Commissioning Segments

1. Start the commissioning wizard.

 An overview is shown with information on which segments are not commissioned yet:

2. In order to start commissioning, select a segment.

 The segment topology window appears:
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3. Enter segment topology settings to refine the diagnostics of the segment you intend to 
commission.

4. Click Next.
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 The field device tags window appears:

5. Enter field device tags manually or click Import Field Device Tags.

 Selecting Import Field Device Tags initiates the reading of the field device tags by observ-
ing the communication on the segment. In order to import segment and device tags from the 
process control system (PCS) , use the Tag Import Wizard instead. See chapter 6.8.9.

6. Upon selecting Import Field Device Tags, follow the instructions of the window that opens:
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7. Click Next.

 The diagnostic data overview window appears. It provides basic diagnostics of the segment 
measurements based on the topology information provided in the topology settings window:

8. Eliminate possible problems by using the information given in the segment diagnostics table.

9. To start the commissioning, click Next.
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 The commissioning wizard records physical layer data to create a snapshot of the current 
segment state. This may take a few seconds. After recording the result is displayed:
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10. Enter a report description. You may also select the option to include characteristic oscilloscope 
recording fragments for each field device into the report.

 The actual snapshot report is shown. The report is stored in the DTM persistence and can 
be reviewed or printed anytime later in the snapshot explorer.
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11. Click Next.

 The advanced diagnostic module's configuration window appears. Based on the snapshot 
report, maintenance required limits for all measured values are calculated.

12. Review or optimize the calculated values, if required. 
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13. To store the calculated limits in the device, click Next.

 The limits are stored. The commissioning is complete.
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6.8.3 Diagnosis
The diagnosis window provides information on all currently active alarms of the diagnostic 
gateway. For the function blocks, resource block, and the IO transducer block, all available 
diagnostic functions are shown. The ADM transducer blocks additionally include the diagnostic 
messages of the expert system.
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6.8.4 Measured Value
The measured value window provides easy access to the measurement data of the diagnostic 
gateway. The function blocks and the IO transducer blocks show the current I/O data.

The ADM transducer blocks include a more advanced view of the physical layer data of the 
connected FF-H1 segments.

System & Segment Measurements
The System and Segment Measurements tab provides a graphical representation of the cur-
rently measured values.
The analog measurement values are shown using a graph shown in the figure below. In the 
non–commissioned mode the values are classified as Excellent, Good, or Out of Specification. 
In the commissioned mode, the values  are classified as No Error, Maintenance Required, or 
Out of Specification. See chapter 2.
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Figure 6.3 Signal level

Magnifying Glass
Click on the magnifying glass to see current field device data.

Figure 6.4 Magnifying glass

1 Current value
2 Range for excellent value (green)
3 Range for good value (blue)
4 Range for exceeded value (yellow)
5 Maximum value occurred during operation
6 Minimum value occurred during operation

1 2 3

6 5 4
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Showing specific field device measurements
In order to show specific field device measurements, click the corresponding magnifying glass 
in the last column.

Figure 6.5 Sytem & Segment Measurements tab in non-commissioned mode
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Figure 6.6 Sytem & Segment Measurements tab in commissioned mode
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Field Device Signal Level
The field device signal level tab shows a graphical overview of the measured field device signal 
levels. For a detailed description of the bar colors, see the system & segment measurements 
tab description. 
In commissioned mode, the bar for unconfigured field devices is completely blue. This is the 
case because no alarm limits exist for this device.

6.8.5 Create a Snapshot
A snapshot provides a detailed overview of the current segment settings and the communica-
tion quality. For data exchange, a snapshot containing the current min/max noise, jitter and sig-
nal level values of each device and the rated segment values can be printed or exported as an 
image, text, or PDF document.
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Creating a Snapshot
In order to create a snapshot, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Measured value.

 The system & segment measurements window appears.

3. Choose Create Snapshot or Create Snapshot including Oscilloscope Recordings.. The 
second option includes characteristic oscilloscope recording fragments for each field device 
into the report.

 Once all snapshot data is collected, the Save Snapshot Report window appears.

Figure 6.7 Save snapshot report window
4. Enter a description for the snapshot.

5. Choose Save to save the snapshot.

 The snapshot explorer window appears. See chapter 6.8.7

6.8.6 History Export
Note
In order to export history data, an Ethernet connection to the DGW-FF is required.
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6.8.6.1 Long-Term History
The long-term History function enables you to collect and store data in well-defined recording 
intervals. The minimum and maximum value of each measured value within the recording inter-
val are stored as one data set. Recording intervals can range from 4 hours up to 7 days.

Defining a Recording Interval
In order to define the recording interval for the long-term history, proceed as follows:

1. Open online parameterization.

2. Select an ADM transducer block.

3. Set block mode to "OOS" if required.

4. Move to the configuration tab and adjust the history period.

5. Choose Apply to confirm the changes.

6. Restore the block mode.

6.8.6.2 Export History
The export history function enables you to convert the long-term history data into a commonly 
used document format, in order to use this data for your own calculations. The long-term history 
can be exported as Microsoft® Excel document, comma-separated values (CSV file), or binary 
history file (HIS).

Exporting the History
In order to export the long-term history data, proceed as follows:

1. Select "Segment to Export the History data for".

2. Select the segment and choose Start.

Note
The data storage is limited to 100 data sets. New data sets will overwrite existing ones, which 
means that data set 101 overwrites data set 1.
Depending on the defined recording interval, the long-term history can range from 17 days (4 h 
* 100 = 400 h = approx. 17 days) up to approx. 2 years.
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3. Select the required file format in the Export Type section and enter a file name in the 
Filename field.

Figure 6.8 Export type and export settings

6.8.6.3 Excel Export Feature
The diagnostic manager provides feature for exporting history data to Microsoft® Excel that 
enables fast and easy data exchange and reformatting of your physical layer data.
The physical layer data is exported into a special template. This template is designed to provide 
a detailed overview of all relevant parameters and enables you to create diagrams with one 
click.

Figure 6.9 History data overview in Excel
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6.8.7 Snapshot Explorer
The snapshot explorer simplifies administration and enables printing existing snapshots and 
reports. These reports can be printed or exported as an image, text, PDF document, or diag-
nostic module snapshot file (DMS) file. 

2 different templates can be selected: A clearly arranged default template and a compact tem-
plate that contains the same information using less space. You can launch the report using Mic-
rosoft® Excel. This spreadsheet enables you to generate diagrams and perform individual 
calculations based on the report data.

Opening the Snapshot Explorer
In order to open the snapshot explorer, proceed as follows:

1. Right-click the Advanced Diagnostic Module in the project section.

2. Choose Additional Functions > Snapshot Explorer.

 The snapshot explorer window appears.

1. Toolbar
2. Snapshot collection
3. Report preview
4. Segment navigation panel

Note
DMS is a file format for data exchange created by Pepperl+Fuchs.
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6.8.7.1 Snapshot Toolbar

6.8.8 Fieldbus Oscilloscope
For further information on the fieldbus oscilloscope functionality, see chapter 5.12.

6.8.9 Tag Import Wizard
The tag import wizard can be used to import segment and device tags from process control 
systems (PCS) to the DGW-FF.
The basic concept described in this chapter is the same independent of the PCS used. How to 
import data from the supported PCS and some PCS-specific behavior is described at the end 
of this chapter. Supported process control systems are:

• Emerson DeltaV
• Honeywell Experion PKS
• Yokogawa PRM

Button Name Result
Open Open a saved report.

Copy to (Export) Copy the selected report to another 
location. 
File types: PDF, RTF, TXT, DMS

Copy all to (Export all) Copy all reports to another location.
File type: DMS

Delete Delete the selected report.

Delete all Delete all reports.

Print Print the selected report.

Excel Export the selected report in Excel.

Settings Choose:
• Paper size (A4 or letter)
• Report type (compact template 

or detailed template)
Zoom in Enlarge the report.

Zoom out Reduce the report.

Zoom 100% View of the report of 100 %.

Fit to height Fit the view of the report on the 
height.

Fit to width Fit the view of the report on the 
width.

First page Go to the first page of the report.

Previous page Go to the previous page of the 
report.

Next page Go to the next page of the report.

Last page Go to the last page of the report.
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Importing Tags in General

1. Launch the tag import wizard.

2. In order to create a new topology, choose Create a new topology. 

 The wizard clears all tags saved on the DGW-FF.
3. In order to update tags already loaded, choose Update existing project topology.

 The wizard assigns imported tags to the currently existing tags based on the segment tag.
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4. Select the PCS file to be imported and click Next.

 The segment selection list shows all segments found in the imported PCS file.

5. Select the segments that are attached to the DGW-FF and click Next.

 The software assigns the segments to the ADMs automatically. The default handling 
depends on the individual PCS. 
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6. In order to change the default assignment, edit the ADM addresses.

7. Click Next.

 The software sets the ADM_TB block tags and the segment tags according to the imported 
data. The software also creates a configured field device for each imported field device tag 
and assigns the device tag to this device.

6.8.9.1 Export Tags from Emerson DeltaV
Exporting Tags from Emerson DeltaV

1. Open the Emerson DeltaV Explorer.
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2. Right-click on control network and choose Export.

3. Enter the file name and save the file.
During import, the tags are assigned to the ADM transducer blocks in the following way:
FF-H1 cards are assigned from the lowest to the highest card number to the transducer blocks. 
Since a DeltaV H1 card has 2 segments, and an ADM has 4 segments, the cards are assigned 
using the following algorithm:

• Check if 4 continuously addressed Emerson cards with the addresses 1 ... 4, 5 ... 8, (and 
so on) contain non-redundant cards.

• If the block contains at least 1 non-redundant card, the card addresses 1 + 2, 3 + 4, 
(and so on) are combined at an ADM. If redundant cards are in this block, the ADM 
segments reserved for the redundant card remain unused.

• If the block only contains redundant cards, the cards with the addresses 1 ... 4, 
5 ... 8, (and so on) are mapped to 1 ADM. This is possible because in a redundant 
system, even address numbers are not used.

6.8.9.2 Export Tags from Honeywell Experion
Exporting Tag from Honeywell Experion

1. On Experion Server, open configuration studio and select Control Strategy > Configure 
process control strategies to open the control builder.

2. Right-click on a root in the project assignment window. Choose Export.

3. Select at least all FIM4, FIM8, Fieldbus Devices and Templates for Fieldbus Devices. 
Choose a directory to export to, and click Export.. Typically, it is the best way to select all and 
export.

 FIMs are assigned from the lowest to the highest device index to the ADM transducer 
blocks. Any FIM8 allocates to consecutive ADM transducer blocks.
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6.8.9.3 Export Tags from Yokogawa Plant Resource Manager
Exporting Tags from Yokogawa Plant Resource Manager

1. Start the plant resource manager (Start > All Programs > YOKOGAWA PRM > Plant 
Resource Manager).

2. Choose File > Export > Maintenance Info.

 The Export Maintenance Info  window appears.
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3. Select Browse.

 The Device Selection window appears.
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4. Select all FOUNDATION Fieldbus devices and click OK.

 The export maintenance info window appears.

5. Activate Device and click OK.

 The export starts.

6. After the export has finished, click Close.
ALF111 devices are assigned to ADM transducer blocks from low to high device path.
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6.8.10 Reporting Wizard
The FDS reporting wizard allows creating reports on all segments connected to a diagnostic 
gateway. Currently, one report type is supported:

• Surge protector status

If you use FieldConnex® surge protectors with diagnostics, this report provides an overview of 
all current issues that are related to surge protectors. It can be used to check the surge protec-
tors after a surge incidence.

Checking the Surge Protector Status

1. Start the reporting wizard.

2. Select the report type.

3. Optionally enter a comment to include into the report.

4. Click Next.

 The report is being generated.
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7 Cabinet I/O
Besides ADM access functionality, the diagnostic gateway KT-MB-GT2AD.FF.IO provides I/O 
functions mainly for cabinet management applications. The following inputs and outputs are 
available:

• Inputs:
• 2 binary inputs that can also be used as frequency inputs.
• 4 binary inputs (NAMUR sensors)
• 2 temperature inputs for use with PT100 sensors that can also be used as binary 

inputs.
• 1 temperature sensor integrated on the motherboard.
• 1 humidity sensor integrated on the motherboard.

• Outputs:
• 2 relay outputs.
• 1 common alarm output, a volt-free contact for alarm loops; off=closed, on=open.
• 1 buzzer.

Integrated on/off controllers allow local control functionality inside the diagnostic gateway, e.g., 
for thermostat controls.
This functionality is provided for the FF integration, as well as for the FDS/OPC integration. The 
main difference between these 2 types of is the possibility to interact with FF function blocks 
where the FDS/OPC integration does only support local control. Access to the I/O functionality 
is provided in the following way:

• FF Integration
The I/O functionality is provided as an FF transducer block. Several channels for the func-
tion blocks allow to access the input and outputs. See chapter 7.5

• FDS/OPC Integration
The FDS port DTM provides an online and offline parameterization user interface for this 
functionality. This port behaves like an FF transducer block, i.e., the block must be set to 
"OOS" before any parameter can be changed and must be switch back to auto for opera-
tion. Handling of the resource block mode is not required.
The I/O functionality is not integrated with the OPC server. The local control functionality 
can be used as described in this chapter and alarms to a PCS can be sent using the com-
mon alarm output.

The common alarm output of the I/O functionality is also provided on the KT-MB-GT2AD.FF 
and can be used for a volt-free contact integration of the ADM functionality in FF integration 
mode. See chapter 4.4

7.1 Field Diagnostics
The inputs of the IO_TB can be integrated with field diagnostics in either of the following ways:

• Map a binary input to field diagnostics: When the corresponding bit in FD binary * map is 
set, a binary input value of "1" triggers the field diagnostics condition.

• Compare analog inputs values against limits: All analog inputs have Hi and Lo Mainte-
nance Required and Out of Specification limit settings. Whenever the input value is out-
side the selected limits, the field diagnostics condition is triggered.

• Input lead break/short circuit detection is mapped to field diagnostics. Whenever a lead 
break/short circuit condition is detected, the corresponding field diagnostics condition is 
triggered.
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For more information on field diagnostics conditions, see chapter 8.4
You find more details on the configuration options for field diagnostics in the following sections.

7.2 Input Configuration
Most device inputs are multifunctional inputs that can be used for different types of I/O signals.

7.2.1 Frequency/Binary Inputs
• Lead breakage and short circuit detection can be enabled and disabled.
• Use as frequency input: Use input as frequency input instead of binary input.

The following settings are only used in binary mode:
• Invert: Invert binary input value.
• Use fault state: If an error is detected, the input status remains "GOOD" instead of becom-

ing "BAD". Depending on the setting of "Fault state to value", the input value remains on 
the last "GOOD" value or changes to the fault state value.

• Fault state to value: If enabled, the input value changes to the value of the "Fault state" bit 
when an error is detected instead of remaining on the last "GOOD" value.

• Fault state: Fault state value used with "Fault state to value".
• Field Diag Out Of Specification: If this option is set, a logical 1 at the binary input triggers 

an IO_TB Out-of-Specification condition.
• Field Diag Maintenance Required: If this option is set, a logical 1 at the binary input trig-

gers an IO_TB Maintenance-Required condition.
The following settings are only used in frequency mode:

• High Out of Specification: If the currently measured frequency value is higher than the 
High-Out-of-Specification limit, the field diagnostics IO_TB–Out-of-Specification condi-
tion is triggered.

Condition Description Default Mapping
IO Out of Specification Any bit in 

IO_TB.FD_OOS_ACTIVE is 
set when IO_TB has the target 
mode "AUTO"

Offspec

IO Maintenance Required Any bit in IO_TB.FD_MR_AC-
TIVE is set when IO_TB has 
the target mode "AUTO"

Maintenance Required

IO Fail Any bit in IO_TB BINARY_ER-
RORS or ANALOG_ER-
RORS is set when IO_TB has 
the target mode "AUTO"

Fail

Note
Analog Limit Values
You can configure Hi and Lo Maintenance Required and Out of Specification limits for analog 
input values. If you do not want to use these limits, you can disable this functionality by entering 
the following information in the configuration: 

• For "low": <<<
• For "high": >>>

This combination of characters means +- infinite and disables the functionality.
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• High Maintenance Required: If the currently measured frequency value is higher than the 
High-Maintenance–Required limit, the field diagnostics IO_TB–Maintenance–Required 
condition is triggered.

• Low Maintenance Required: Like High Maintenance Required, but for measured fre-
quency lower than the Low–Maintenance–Required value.

• Low Maintenance Required: Like High Maintenance Required, but for measured fre-
quency lower than the Low–Maintenance–Required value.

• Hysteresis: In order to avoid the flickering of diagnostics, a hysteresis value can be config-
ured.

7.2.2 Binary Inputs
• Lead breakage and short circuit detection can be enabled and disabled.
• Invert: Invert binary input value.
• Use fault state: If an error is detected, the input status remains "GOOD" instead of becom-

ing "BAD". Depending on the setting of "Fault state to value", the input value remains on 
the last "GOOD" value or changes to the fault state value.

• Fault state to value: If enabled, the input value changes to the value of the "Fault state" bit 
when an error is detected instead of remaining on the last "GOOD" value.

• Fault state: Fault state value, used with "Fault state to value".
• Field Diag Out Of Specification: If this option is set, a logical 1 at the binary input triggers 

an IO_TB-Out-of-Specification condition.
• Field Diag Maintenance Required: If this option is set, a logical 1 at the binary input trig-

gers an IO_TB-Maintenance-Required condition.

7.2.3 Temperature/Binary Inputs
• Lead breakage and short circuit detection can be enabled and disabled.
• Use as binary input: Use input as binary input instead of temperature input.

The following settings are only used in binary mode:
• Invert: Invert binary input value.
• Use fault state: If an error is detected, the input status remains "GOOD" instead of becom-

ing "BAD". Depending on the setting of "Fault state to value", the input value remains on 
the last "GOOD" value or changes to the fault state value.

• Fault state to value: If enabled, the input value changes to the value of the "Fault state" bit 
when an error is detected instead of remaining on the last "GOOD" value.

• Fault state: Fault state value, used with "Fault state to value".
• Field Diag Out Of Specification: If this option is set, a logical 1 at the binary input triggers 

an IO_TB-Out-of-Specification condition.
• Field Diag Maintenance Required: If this option is set, a logical 1 at the binary input trig-

gers an IO_TB-Maintenance-Required condition.
The following settings are only used in temperature mode:

• High Out of Specification: If the currently measured temperature value is higher than 
High-Out-of-Specification limit, the field diagnostics IO_TB-Out-of-Specification condition 
is triggered.

• High Maintenance Required: If the currently measured temperature value is higher than 
High-Maintenance-Required limit, the field diagnostics IO_TB-Maintenance-Required 
condition is triggered.

• Low Maintenance Required: Like High Maintenance Required, but for measured tempera-
ture lower than Low-Maintenance-Required value.
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• Low Out of Specification: Like High Out of Specification, but for measured temperature 
lower than Low-Out-of-Specification value.

• Hysteresis: In order to avoid flickering of diagnostics, a hysteresis value can be config-
ured.

• Unit: Select the unit for temperature measurement.

7.2.4 Board Humidity
• High Out of Specification: If the currently measured humidity value is higher than the 

High-Out-of-Specification limit, the field diagnostics IO_TB-Out-Of-Specification condi-
tion is triggered.

• High Maintenance Required: If the currently measured humidity value is higher than High-
Maintenance-Required limit, the field diagnostics IO_TB-Maintenance-Required condi-
tion is triggered.

• Low Maintenance Required: Like High Maintenance Required, but for measured humidity 
lower than the Low-Maintenance-Required value.

• Low Out of Specification: Like High Out of Specification, but for measured humidity lower 
than the Low-Out-of-Specification value.

• Hysteresis: In order to avoid flickering of diagnostics, a hysteresis value can be config-
ured.

7.2.5 Board Temperature
• High Out of Specification: If the currently measured temperature value is higher than 

High-Out-of-Specification limit, the field diagnostics IO_TB-Out-of-Specification condition 
is triggered.

• High Maintenance Required: If the currently measured temperature value is higher than 
High-Maintenance-Required limit, the field diagnostics IO_TB-Maintenance-Required 
condition is triggered.

• Low Maintenance Required: Like High Maintenance Required, but for measured tempera-
ture lower than the Low-Maintenance-Required value.

• Low Out of Specification: Like High Out of Specification, but for measured temperature 
lower than the Low-Out-of-Specification value.

• Hysteresis: In order to avoid flickering of diagnostics, a hysteresis value can be config-
ured.

• Unit: Select the unit for temperature measurement.

7.3 Output Configuration
The outputs use the following I/O logic:

The relay contact output 1, relay contact output 2, common alarm output, and the buzzer can 
be configured the following way:

• Invert: The output as described in the table above.
• Output source: This configures the value used to control the output. The following options 

exist:

Relay contact output 1,
Relay contact output 2

0 = relay open
1 = relay closed

Buzzer 0 = Buzzer Off
1 = Buzzer On

Common alarm output 0 = Contact closed
1 = Contact Open
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• Not connected:
The output is not used

• FF channel:
The output is directly controller using an FF function block. This option is only avail-
able for the FF integration

• Binary input *: 
The output is directly controlled by a binary input. Any of the binary inputs 1 ... 8 can 
be used. For example, you can turn on a relay if a binary input is activated.

• On/Off controller *: 
The output of 1 of the 4 On/Off controllers is used. Each On/Off controller can be 
assigned to any output.

• Field diagnostics:
If a specified field diagnostic value is set (or reset), the output is activated. This can 
be used to activate an output if any Maintenance-Required condition (or worse) is 
active for the device. Since all inputs and the ADM conditions can be mapped to field 
diagnostics, the common alarm output can summarize all cabinet or ADM issues 
detected. The table below shows how to use this behavior.

Field Diagnostics Functions

The buzzer on the motherboard provides an additional configuration option:
• Frequency: Specifies the buzzing interval for the buzzer. Available options are: 0.5 Hz, 

1 Hz, 1.5 Hz, 2 Hz and "Permanently on". If activated, the buzzer modulates its output with 
the frequency selected.

7.4 On/Off Controllers
The On/Off controllers can be used to control the discrete outputs based on analog input val-
ues, such as temperature. Thus, On/Off controller can be used to replace a thermostat for heat-
ing or cooling control. The following configuration options are available:

FD Check function If for any check function Maintenance 
Required, Out of Specification, or Failure con-
dition is active at the field diagnostics, the out-
put is activated.

FD Check function (inverted) If for any check function Maintenance 
Required, Out of Specification, or Failure con-
dition is active at the field diagnostics, the out-
put is deactivated.

FD Maintenance Required If for any check function Maintenance 
Required, Out of Specification, or Failure con-
dition is active at the field diagnostics, the out-
put is activated.

FD Maintenance Required (inverted) If for any check function Maintenance 
Required, Out of Specification, or Failure con-
dition is active at the field diagnostics, the out-
put is deactivated.

FD Out of Specification If for any check function Out of Specification or 
Failure condition is active at the field diagnos-
tics, the output is activated.

FD Out of Specification (inverted) If for any check function Out of Specification or 
Failure condition is active at the field diagnos-
tics, the output is de activated.

FD Failure If for any check function Failure condition is 
active at the field diagnostics, the output is 
activated.

FD Failure (inverted) If for any check function Failure condition is 
active at the field diagnostics, the output is 
deactivated.
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• Input: A selector for an analog input value. Available options are:
• Temperature input 1
• Temperature input 2
• Temperature input 2 -  temperature input 1 (temperature difference)
• Motherboard temperature
• Motherboard humidity
• Frequency input 1
• Frequency input 2

• Invert: Inverts the output value.
• On Level: If the input value exceeds this value, the output is set to "1".
• Off Level: If the input value falls below this value, the output is set to "0".

The start value of the output is "0".

7.5 FF Channels for the I/O Transducer Block
The following FF channels can be used to map I/O data to function blocks:

• 101: Input value of binary inputs 1 ... 8 (multiple digital input (MDI) function blocks)
• 102: 1 ... 4 result values of on/off controllers 1 ... 4 (MDI function blocks)
• 103: Value of temperature, humidity, and frequency inputs (multiple analog input (MAI) 

function block)
• 104: Output values for relay contact outputs, common alarm output, and buzzer. Note that 

the source of the outputs must be set to "FF channel" (multiple digital output (MDO) func-
tion block)

• 105: Value of binary inputs as bits of a U8 value (multiple digital input (MDI) and digital 
input (DI) function blocks)

• 201: Field diagnostics status value (DI function block), see chapter 6.3
For more information on FF channels, see chapter 8.3.

7.6 Cabinet Management Applications and I/O Blocks
This chapter describes typical cabinet management applications and how to configure their I/O 
transducer blocks. If the DTM is used, this can be done in a comfortable way. The tab I/O 
Blocks allows you to select preconfigured applications. These blocks can be adjusted by 
selecting the inputs and outputs used. Otherwise, most of the configuration takes place auto-
matically.

Note
Default Values
The default values for the on level and off level inputs are ‘<<<’ for low infinity and ‘>>>’ for high 
infinite.

Note
Temperature Difference
When using the temperature difference input, the same temperature unit must be configured 
for the temperature inputs 1 and 2.
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7.6.1 Configuring Typical Cabinet Management Applications Manually
Using Cooling Control

1. Select an unused relay contact output and connect a cooling device (e.g., ventilator) to it.

2. Select an unused on/off controller and configure it as follows:
Options: Not inverted
On level: Temperature level at which the output is supposed to be switched ON.
Off level: Temperature level at which the output is supposed to be switched OFF.
Input selection: Select the temperature input to be used as reference temperature.

3. Configure the output source of the selected relay contact output to the selected on/off 
controller.

4. Configure measurement unit of selected temperature input.

Using Heater Control

1. Select an unused relay output and connect a heater device to it.
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2. Select an unused on/off controller and configure it as follows:
Options: Invert
On level: Temperature level at which the output is supposed to be switched OFF (Note: Inverted 
output!)
Off level: Temperature level at which the output is supposed to be switched ON (Note: Inverted 
output!)
Input selection: Select the temperature input to be used as reference temperature.

3. Configure the output source of the selected relay contact output to the selected on/off 
controller.

4. Configure measurement unit of selected temperature input.

Using Frequency Diagnostics (Ventilator Speed Control)

1. Select an unused frequency input and configure it as follows:
Frequency input: Enable, i.e., set input to frequency mode.
Option: Enable or disable NAMUR lead breakage and short circuit detection as required.

2. Configure the High-/Low- Out-of-Specification and Maintenance-Required limits.

3. Configure the field diagnostics alarms in the resource block.

Monitoring Ambient Conditions (Humidity/Temperature)
In order to enable the field diagnostics alarms for ambient conditions, configure the required 
High-/Low- Out-of-Specification and Maintenance-Required limits of the board sensors.

Using Binary Input Diagnostics (Cabinet Door Monitoring, Bulk Power 
Supply Failure Monitoring)

1. Select an unused binary input and configure it as follows:
Options: Enable or disable NAMUR lead breakage and short circuit detection as required.
Binary options: Enable Invert if required.

2. Check the corresponding flag in "FD Binary OOS Map" or "FD Binary MR Map". When the 
input is "1", the selected field diagnostics condition is triggered.

3. Configure the field diagnostics alarms in the resource block.

Mapping of Field Diagnostics to Common Alarm Output (Volt-Free 
Contact)

Select the required field diagnostics condition as an output source for the common alarm out-
put.
Two mapping examples help to illustrate how it works:

• FD Out of Specification: If field diagnostics reports an Out-of-Specification alarm or worse 
(Failure alarm), the output is OPEN.

• FD Check: If field diagnostics reports a check-function alarm or worse (Failure, Out-of-
Specification, Maintenance-Required alarms), the output is OPEN.

Note
The common alarm output is a volt-free contact that is designed to be used as 
an alarm contact. The normal state ("OFF") is CLOSED.
Note that the ALM LED of the device is connected to the common alarm 
output. When the output is closed, the LED flashes.
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8 Appendix

8.1 Measured Values / Parameters

8.1.1 Board Type

Board Type Detection
The type of the board on which the HD2-DM-A is installed is detected.

Board Redundancy Detection
Detects whether the HD2-DM-A is installed on a redundant board or not.

8.1.2 Communication Active
Communication activity is detected if any valid frames (Preamble, SOF, EOF) are detected. 
Loss of communication is detected if no valid signal is recognized for at least 4 seconds.

8.1.3 Current
The current supplied to the segment is measured.

8.1.4 Unbalance
The parameter detects unbalance between signal wire and ground (shield). This measurement 
signals an earth unbalance. This is the case if a segment that belongs to the same isolation 
group has a DC earth unbalance, e. g., a short circuit from a signal line to shield.

Definition
Unbalance is the result of a capacitive or resistive connection between the fieldbus signal wires 
and ground (cable shield).

Possible Causes
Miswiring/incorrect installation  see Figure 8.1 on page 145:
In the installation scenario illustrated below, several devices are installed incorrectly. On each 
of the independent segments, one device is wired with the negative data line tied to the shield 
while the shield is tied to earth ground.
Device influence: In order to increase electromagnetic compatibility stability, some plants 
modify their fieldbus devices with asymmetric capacitive connections between shield and their 
+ or - fieldbus line. If such fieldbus devices are connected to the plant, they influence the bal-
ance of the specific field device or the entire segment.
Wire damage: A wire damaged through external influences can also cause unbalance if there 
is a short circuit between a fieldbus line and the cable shield.

Type Values
Precision +/- 5%
Measuring range 0 ... 6.5 A (depends on the motherboard)

Type Values
Precision 1%
Measuring range -100% (short against - wire)

 to
 +100% (short against + wire)
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Figure 8.1 Fault wiring DC unbalance
An undetected unbalance can cause communication issues and a lack of electromagnetic 
compatibility stability.

8.1.5 Active Field Devices
The number and addresses of the currently active field devices are analyzed. Any difference to 
the time of commissioning is evaluated and reported.

8.1.6 Communication Error Statistics
Parameters for segment and field-device-specific error counters, e.g., CRC errors, framing 
errors, the number of FF-H1 tokens the device missed. etc.
The number of missed H1 tokens is only updated if the DTM is opened and the segment is 
selected.

8.1.7 History Recording
Segment and field-device-specific physical layer values are stored with a timestamp of up to 2 
years in the advanced diagnostic module for trend analyses.

8.1.8 Jitter

Definition
Jitter is the deviation from the ideal timing of an event. In this case, it is the deviation from the 
ideal zero crossing point of the transmitted signal curve during the nominal bit duration, mea-
sured in relation to the previous zero crossing (reference event).
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Note
A single pole-to-shield fault is not critical. But if a second pole-to-shield-fault happens at the 
same time, corruption of the communication signal and high crosstalk levels can occur 
between the 2 affected segments.



 2
02

0-
11

146

Advanced Diagnostics
Appendix

Figure 8.2 Bit cell jitter

Segment or Field Device Jitter
This parameter monitors the current maximum jitter of all active devices connected to the seg-
ment. The H1 jitter level is a value derived from the device jitter values. Due to noise levels 
caused by additional effects, the diagnostic device indicates a first warning at 75 % (2.4 s) of 
the maximum allowable jitter level. This is an empiric value that can be modified according to 
your requirements. If the jitter level exceeds 3.2 s, a final warning is issued.

The segment jitter is the maximum value of all device jitter values. A high jitter level causes 
communication problems and a lack of operational reliability. The transmitted bit cell jitter can-
not exceed 10 % of 1-bit time. E. g., at 31.25 kbits/s the duration of 1-bit time is 32 s. Thus, the 
maximum bit cell jitter cannot exceed 3.2 s. Your system can run at a higher jitter level, but at 
the expense of a reduced level of immunity against influences on electromagnetic compatibility.
Jitter can have the following causes:

• Crosstalk
• Electromagnetic interferences (EMI)
• Simultaneous switching outputs
• Device dependency
• Bad wiring practice

A Reference event; first zero crossing point
B Actual zero crossing point
C Bit cell jitter, deviation from the ideal timing
D Ideal zero crossing point

Type Values
Precision 0.1 s
Measuring range 0 s ... 8 s

 

C L t 

V 1 bit time 

0.5 bit time 0.5 bit time 

A B

D
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8.1.9 Noise

Definition
Noise is an undesired disturbance within the signal frequency band. Noise appears with differ-
ent characteristics. A high noise level causes communication problems and a lack of opera-
tional reliability. Segment noise is the maximum noise of all field device noise or the noise 
measured if no field device is communicating. The field device noise is measured just before a 
field device is transmitting. That does not mean that this device is causing any noise. Measure-
ment takes place to determine whether the noise value is high for a single field device only. 
Often, this means that noise is caused by the device that has been transmitting right before the 
device that shows the increased noise. The HD2–GT–2AD.FF.IO FF-H1 field device does not 
support noise measurement per device.
Noise can have the following causes:

• Bad wiring practice
• Bad shielding/grounding practice
• Supply voltage noise pulses passed onto the bus by a non-regulated power supply
• An AC power supply injects noise into the bus
• A regulated FOUNDATION Fieldbus power supply injects switching noise into the bus

Figure 8.3 Communication noise

8.1.10 Polarity
This parameter detects the polarity of the communication signal for every field device.

8.1.11 Power Supply Voltage
This parameter indicates the voltage level of the primary and secondary bulk power.

A Noise level
B Signal level

Type Values
Precision 10 mV
Measuring range 0 ... 2.5 V, 100 Hz … 140 kHz

A

t

U

B
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8.1.12 Signal Level
The current peak–to–peak signal level of all field devices is measured and shown for each field 
device, as well as the current maximum and minimum value for the segment.

8.1.13 Trunk Surge Protector Alarm
Diagnostics detect and report the end of effective life signals from FieldConnex® trunk surge 
protectors.

8.1.14 Device Coupler Alarms
Diagnostics detect and report Maintenance Required and Out of Specification alarms from 
FieldConnex® device couplers. This includes the diagnostic information of the following 
devices:

• Device coupler diagnostics
• Surge protector alarms
• Enclosure leakage sensor alarms

8.1.15 Voltage

H1 Segment Voltage
The voltage at the segment input of the advanced diagnostic module is measured.

8.1.16 Measured Values by Motherboard Type

Type Value
Precision +/- 5%
Measuring range 0 ... 40 V

Type Values
Precision +/- 10 mV
Conforming standards value 150 mV ... 375 mV

Type Values
Precision +/- 5 %
Measuring range 0 ... 40 V

Values
MB* - Mother-
board MB-FB-DMA DART

Bulk power supply x x x

Board type detection x x x

Board redundancy detection x x

Power supply module type and fail-
ure detection

x x

Voltage x x

Current x

Communication active x x x

Segment/field device noise x x x

Segment/field device jitter x x x
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8.2 HD2-GT-2AD.FF.IO FF Blocks
The column "Char." shows which characteristics or conditions are applicable to this parameter.

• OOS (Out of Service): The parameter can be written only if the target mode of the block is 
"Out of Service".

• S (Static): During each writing process to a parameter of this type, the parameter ST_REV 
is increased by 1.

• W (Writeable): The parameter can be modified by the user.
Since all parameters can be read, this is not marked in a special way.

8.2.1 ADM_TB Transducer Block
Parameters

Active field devices x x x

Unbalance x x

Communication errors statistic x x x

Field device polarity x x x

Signal level x x x

Trunk surge protector alarm x

Device coupler alarm x x

Values
MB* - Mother-
board MB-FB-DMA DART

Parameter Char. Description
ST_REV S During each writing process to a parameter marked by "S" the 

parameter ST_REV is increased by 1.
TAG_DESC S, W An additional description to the tag of the field device.
STRATEGY S, W The strategy field can be used to identify comprising blocks. 

This data is not controlled or used by the block.
ALERT_KEY S, W Identification number of the plant component. This information 

can be used by the control computer, e.g., to sort alarms. Valid 
values are 1 ... 65536.

MODE_BLK S, W Displays the current, permitted standard mode and the target 
mode of the block. The target mode can be set to the values 
"Auto" or "Out of Service".
Default: Auto

BLOCK_ERR • Out of Service: The actual block mode is OOS.
• Block configuration error: Check all segment expert sys-

tem messages for information on configuration error cause.
• Other: The status of any ADM segment is not "good", "no 

error", "excellent" or "segment disabled".
UPDATE_EVT This parameter is used to signal to the PCS that a parameter 

marked with "S" was overwritten, provided the PCS supports 
alarm messages.

BLOCK_ALM This parameter is used to signal to the PCS diagnostic mes-
sages displayed in BLOCK_ERR, provided the PCS supports 
alarm messages.

XD_STATUS Record SYSTEM_STATUS:
Status of the ADM system (bulk power supply voltage).
SEGMENT_*_STATUS:
Summary value of segment quality.
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SYSTEM Record, S, W, 
OOS

HISTORY_PERIOD:
History period of the ADM. Controls the number of times the 
ADM writes a history entry to its non-volatile memory. History 
can be read via DTM function "History export".
FLASH_LEDS:
Causes the ADM device to have all LEDs flashing for identifi-
cation purpose.

SYSTEM_DY-
NAMIC

Record ADM_SERIAL_NUMBER:
Serial number of the attached ADM.
ADM_SofTWARE_REVISION:
Software version of attached ADM.
ADM_PROTOCOL_REVISION:
Internal usage
ADM_EXPERT_REVISION:
Internal usage
BOARD_TYPE:
Motherboard type the ADM is mounted on.
U_PWR_HI_HI_OOS:
Bulk power supply High-Out-of-Specification limit.
U_PWR_LO_LO_OOS:
Bulk power supply Low-Out-of-Specification limit.
U_PWR_PRI:
Actual measured value of primary bulk power supply voltage.
U_PWR_SEC:
Actual measured value of secondary bulk power supply volt-
age (not available on some motherboards).
SYSTEM_ALARMS:
List of active system alarms:
• Primary power supply high Out of Specification
• Primary power supply low Out of Specification
• Secondary power supply high Out of Specification
• Secondary power supply low Out of Specification

All segment parameters exist 4x, once for each ADM segment. X = 1 ... 4
EXPERT_SYS
TEM_(X)

Record, W RESET_INACTIVE:
Clears inactive messages
OVERALL_STATUS:
Overall segment diagnostic quality. Possible values: are
• No Error (commissioned)
• Maintenance Required (commissioned)
• Out of Specification (commissioned)
• Excellent (non-commissioned)
• Good (non-commissioned)
• Out of Specification (non-commissioned)
• Fail (ADM hardware error)
• Configuration Error (see expert messages for information)
• No corresponding ADM connected
• Segment is disabled
5x expert diagnostic messages consisting of "Active" flag and 
the actual message. N = 1 ... 5
ACTIVE_(N):
Following expert message is active (the error is present) or 
inactive (the error is gone).

Parameter Char. Description
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EXPERT_MSG_(N):
Expert message. For detailed explanation, .

SEG-
MENT_(X)_S
TATIC

Record, W, S, 
OOS

H1_TAG:
Segment tag

H1_MODE:
Segment mode
• Disabled
• Non commissioned (default)
• Commissioned
PS_MODULE_SUPERVISION:
Enables diagnostics of power supply modules. If enabled, 
segment power supply errors are reported (module missing, 
module failure).
• Supervise power supply A.
• Supervise power supply B (on redundant boards).
H1_U_HI_HI_OOS:
Enable or disable segment voltage High-Out-of-Specification 
limit.
H1_U_HI_MR:
Segment voltage high maintenance required limit.
• 0: Disabled
• 9 ... 32 V: Enabled
H1_U_LO_MR:
Segment voltage Low-Maintenance-Required limit.
• 0: Disabled
• 9 ... 32 V: Enabled
H1_U_LO_LO_OOS:
Enable or disable segment voltage Low-Out-of-Specification 
limit.
H1_I_HI_MR:
Segment current High-Maintenance-Required limit.
• 0: Disabled
• 1 ... 6500 mA: Enabled
H1_I_LO_MR:
Segment current Low-Maintenance-Required limit.
• 0: Disabled
• 1 ... 6500 mA: Enabled
H1_UNBALANCE_HI_HI_OOS:
Enable or disable segment unbalance High-Out-of-Specifica-
tion limit.
H1_UNBALANCE_HI_MR:
Segment unbalance High-Maintenance-Required limit.
• 0: Disabled
• -100% ... 100%: Enabled
H1_UNBALANCE_LO_MR:
Segment unbalance Low-Maintenance-Required limit.
• 0: Disabled
• -100% ... 100%: Enabled
H1_UNBALANCE_LO_LO_OOS:
Enable or disable segment unbalance Low-Out-of-Specifica-
tion limit.
H1_SIGNAL_LEVEL_HI_HI_OOS:
Enable or disable segment maximum signal level High-Out-of-
Specification limit.

Parameter Char. Description
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H1_SIGNAL_LEVEL_HI_MR:
Segment maximum signal level High-Maintenance-Required 
limit.
• 0 mV: Disabled
• 100 mV ... 2200 mV: Enabled
H1_SIGNAL_LEVEL_LO_MR:
Segment minimum signal level Low-Maintenance-Required 
limit.
• 0 mV: Disabled
• 100 mV ... 2200 mV: Enabled
H1_SIGNAL_LEVEL_LO_LO_OOS:
Enable or disable segment minimum signal level Low-Out-of-
Specification limit.
H1_NOISE_HI_HI_OOS:
Enable or disable segment noise level High-Out-of-Specifica-
tion limit.
H1_NOISE_HI_MR:
Segment noise level low maintenance required limit:
• 0 mV: Disabled
• 25 mV ... 1000 mV: Enabled
H1_JITTER_HI_HI_OOS:
Enable or disable segment jitter level High-Out-of-Specifica-
tion limit.
H1_JITTER_HI_MR:
Segment jitter High-Maintenance-Required limit:
• 0 µS: Disabled
• 0.5 ... 7 µS: Enabled
H1_TRUNK_ALARM:
Enable or disable trunk surge protector alarm.
IGNORE_TOPOLOGY_SETTINGS:
Ignore or use the following topology settings.
POWERSUPPLY_TYPE:
Segment power supply type.
COUPLER_TYPE:
Device coupler type used on segment.
COUPLER_COUNT:
Number of device couplers on segment.
TRUNK_LENGTH:
Segment trunk length.
TRUNK_CABLE_TYPE:
Segment trunk type.
TOPO_OPTIONS:
Topology options:
• Enable or disable monitoring of surge protector status.

SEG-
MENT_(X)_D
YNAMIC

Record H1_COMMUNICATION_ACTIVE:
Communication is detected on segment.

H1_NUM_ACTIVE_DEVICES:
Number of detected field devices.
H1_U:
Segment voltage
H1_I:
Segment current (not available on some motherboards).

Parameter Char. Description
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H1_UNBALANCE:
Segment unbalance (not available on some motherboards).
H1_SIGNAL_LEVEL_MAX:
Maximum field device signal level.
H1_SIGNAL_LEVEL_MIN:
Minimum field device signal level.
H1_NOISE:
Segment noise
H1_JITTER:
Maximum field device jitter.
H1_SEGMENT_ALARMS:
List of segment errors in commissioned mode:
• Power supply A Out of Specification
• Power supply B Out of Specification
• Segment voltage high Out of Specification
• Segment voltage high Maintenance Required
• Segment voltage low Maintenance Required
• Segment voltage low Out of Specification
• Segment current high Maintenance Required
• Segment current low Maintenance Required
• Unbalance high Out of Specification
• Unbalance high Maintenance Required
• Unbalance low Maintenance Required
• Unbalance low Out of Specification
• Signal level high Out of Specification
• Signal level high Maintenance Required
• Signal level low Maintenance Required
• Signal level low Out of Specification
• Noise high Out of Specification
• Noise high Maintenance Required
• Jitter high Out of Specification
• Jitter high Maintenance Required
• Inactive configured device
• Unconfigured active/field devices
• Trunk surge protector alarm

Parameter Char. Description
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H1_SEGMENT_NONCOM_STATUS:
List of segment errors in non-commissioned mode:
• Power supply A error
• Power supply B error
• Segment voltage high Out of Specification
• Segment voltage high Good
• Segment voltage low Good
• Segment voltage low Out of Specification
• Segment current high Good
• Unbalance high Out of Specification
• Unbalance high Good
• Unbalance low Good
• Unbalance low Out of Specification
• Signal level high Out of Specification
• Signal level high Good
• Signal level low Good
• Signal level low Out of Specification
• Noise high Out of Specification
• Noise high Good
• Jitter high Out of Specification
• Jitter high Good
• Trunk surge protector alarm
H1_ERROR_RATE_ACT:
Error rate in actual history period – number of errors per 
frames received.
H1_ERROR_RATE_LAST:
Error rate in previous history period – number of errors per 
frames received

Configuration data of nodes. The record is used 6 times (Z=1..6),18 nodes are configurable 
(Y=1-18)
SEG-
MENT_(X)_D
EV_STAT-
IC_-
DATA_(Z)
Z=
1_3
4_6
7_9
10_12
13_15
16_18

Record, W, S, 
OOS

DEVICE_(Y)_ADDRESS:
Field device address:
• 0: Entry is not used (default)
• 1 ... 254: Entry is used

DEVICE_(Y)_TAG:
Field device tag
DEVICE_(Y)_SIGNAL_LEVEL_HI_HI_OOS:
Enable or disable segment maximum signal level High-Out-of-
Specification limit
DEVICE_(Y)_SIGNAL_LEVEL_HI_MR:
Segment maximum signal level High-Maintenance-Required 
limit
• 0 mV: Disabled
• 100 mV ... 2200 mV: Enabled

Parameter Char. Description
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DEVICE_(Y)_SIGNAL_LEVEL_LO_MR:
Segment maximum signal level Low-Maintenance-Required 
limit
• 0 mV: Disabled
• 100 mV ... 2200 mV: Enabled
DEVICE_(Y)_SIGNAL_LEVEL_LO_LO_OOS:
Enable or disable segment maximum signal level Low-Out-of-
Specification limit
DEVICE_(Y)_COUPLER_ERROR:
Enable or disable device coupler OOS and MR diagnostics

Actual measurement data of active configured nodes on bus. Y = 1 ... 18
SEG-
MENT_(X)_D
EVICE_DY-
NAMIC_-
DATA_1_9

Record DEVICE_(Y)_ADDRESS:
Field device address:
• 0: Node not available on segment
• Other: Node is active

DEVICE_(Y)_STATUS:
Field device status information
• Device is inactive
• Inverse polarity
• Active
• Device coupler status Good
• Device coupler status Maintenance Required
• Device coupler status Out of Specification
• Signal level high Out of Specification
• Signal level high Maintenance Required
• Signal level low Maintenance Required
• Signal level low Out of Specification
• Device is LAS
DEVICE_(Y)_SIGNAL_LEVEL:
Measured signal level
DEVICE_(Y)_JITTER_LEVEL:
Measured jitter level

SEG-
MENT_(X)_D
EV_DYNAM-
IC_-
DATA_10_18

Record Same as SEGMENT_(X)_DEVICE_DYNAMIC_DATA_1_9 but 
nodes 10 ... 18

Actual measurement data of active unconfigured nodes on bus. Y = 1 ... 18
SEG-
MENT_(X)_U
NCON-
F_DEV_-
DATA_1_9

Record UNCF_DEVICE_(Y)_ADDRESS:
Field device address:
• 0: Node not available on segment
• Other: Node is active

Parameter Char. Description
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Methods
• Identify ADM: Causes the ADM to have all LEDs flashing for identification purpose.
• Commissioning wizard: Graphical wizard to perform commissioning of the segment. See 

chapter 6.8.2
• Commissioning wizard (simple): Simple wizard to commission a segment in systems that 

do not support EDDL features that wizards use.
• Tag import (simple): Simple tag import function for systems that do not support EDDL fea-

tures that wizards use.
• Firmware update: Updates the ADM to the firmware built into HD2-GT-2AD.FF.IO device. 

Only 1 ADM can be updated at a time, check the expert diagnostic messages in the diag-
nostics segment interfaces for the update status.

8.2.2 Transducer Block IO_TB
Parameters

UNCF_DEVICE_(Y)_STATUS:
Field device status information
• Device is inactive
• Inverse polarity
• Device is active
• Device coupler status Good
• Device coupler status Out of Specification
• Signal level high Out of Specification
• Signal level high Good
• Signal level low Good
• Signal level low Out of Specification
• Device is LAS
UNCF_DEVICE_(Y)_SIGNAL_LEVEL:
Measured signal level
UNCF_DEVICE_(Y)_JITTER_LEVEL:
Measured jitter level

SEG-
MENT_(X)_U
NCONF_DE-
VICE_-
DATA_10_18

Record Same as SEGMENT_(X)_UNCONF_DEVICE_DATA_1_9, but 
nodes 10 ... 18

COMMIS-
SION-
ING_WIZARD

Record, W COMMISSIONING_CMD:
For internal use
COMMISSIONING_PROGRESS:
For internal use
COMMISSIONING_STATUS:
For internal use
TAGIMPORT_STATE:
For internal use
TAGIMPORT_PROGRESS:
For internal use

Parameter Char. Description

Parameter Char. Description
ST_REV S During each writing process to a parameter marked with "S", 

the parameter ST_REV is increased by 1.
TAG_DESC S, W An additional description of the tag of the field device.
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STRATEGY S, W The strategy field can be used to identify comprising blocks. 
This data is not controlled or used by the block.

ALERT_KEY S, W Identification number of the plant component. This information 
can be used by the control computer, e.g., to sort alarms. Valid 
values are 1 ... 65536.

MODE_BLK S, W Displays the current, permitted standard mode and the target 
mode of the block. The target mode can be set to the values 
"Auto" or "Out of Service".
Default: Auto

BLOCK_ERR • Out of service: When actual block mode is OOS
• Block configuration error:

- Turn_On value of an on/off controller is lower than 
Turn_Off value
- Maintenance Required or Out of Specification limits of 
temperature, humidity, or frequency inputs not consistent
- On/off controller has input temperature difference and dif-
ferent units are selected for temperature input 1 and 2

• Other: If XD_ERROR is not zero
• Sensor failure detected: If any bit in BINARY_ERRORS or 

ANALOG_ERRORS is set
UPDATE_EVT This parameter is used to signal to the PCS that a parameter 

marked with "S" was overwritten provided that the PCS sup-
ports alarm messages.

BLOCK_ALM This parameter is used to signal to the PCS diagnostic mes-
sages displayed in BLOCK_ERR, provided that the PCS sup-
ports alarm messages.

XD_ERROR Summary Field diagnostics status of the block:
• Out of specification
• Maintenance required

BINARY_ER-
RORS

Leadbreakage or short circuit detection diagnostic information 
of binary inputs.

ANALOG_ER-
RORS

Failure information of analog inputs
• Temperature input 1 and 2
• Board temperature input
• Board humidity input
• Frequency input 1 and 2

FD_MR_AC-
TIVE

Field diagnostics Maintenance Required error active for either 
of the following:
• Binary input 1 ... 8
• Temperature input 1 and 2
• Board temperature input
• Board humidity input
• Frequency input 1 and 2

FD_OOS_AC-
TIVE

See FD_MR_ACTIVE, but for Out-of-Specification status

BINARY_IN-
PUT_X (1-
8)

Binary input X value and status

TEMP_IN-
PUT_X (1-
2)

Temperature input X value and status

TEMP_IN-
PUT_INT

Board temperature value and status

Parameter Char. Description
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HUMIDI-
TY_IN-
PUT_INT

Board humidity value and status

FREQ_IN-
PUT_X (1-
2)

Frequency input X value and status

RELAY_OUT-
PUT_X (1-
2)

Output value and status of relay output:
• 0: Relay is off (open)
• 1: Relay is on (closed)

BUZZER_OUT
PUT

Output value and status of buzzer:
• 0: Buzzer is off
• 1: Buzzer is active

COM-
MON_ALARM_
OUTPUT

Output value and status of common alarm output. This is a fail-
ure output, so “on” means “open”:
1. 0: Common alarm output is closed
2. 1: Common alarm output is open

ON_OFF_-
CONT_X (1-
4)

Output value and status of on/off controller

FD_BINA-
RY_OOS_MAP

W, S, OOS When activated, a value of "1" of the corresponding binary 
input triggers a field diagnostics IO_TB-Out-of-Specification 
condition.

FD_BINA-
RY_MR_MAP

W, S, OOS When activated, a value of "1" of the corresponding binary 
input triggers a field diagnostics IO_TB-Maintenance-
Required condition.

BINARY_IN-
PUT_1_SET-
TINGS/
BINARY_IN-
PUT_2_SET-
TINGS

Record, W, S, 
OOS

TAG
Tag of the input
OPTIONS
• Enable or disable lead breakage detection
• Enable or disable short circuit detection
• Use input as frequency input instead of binary input
• Invert (binary mode only)
• Use Fault state (binary mode only)
• Fault state to value (binary mode only)
• Fault state (binary mode only)
HI_HI_OOS
Field diagnostics High-Out-of-Specification frequency limit 
(frequency mode)
HI_MR
Field diagnostics High-Maintenance-Required frequency limit 
(frequency mode)
LO_MR
Field diagnostics Low-Maintenance-Required frequency limit 
(frequency mode)
LO_LO_OOS
Field diagnostics Low-Out-of-Specification frequency limit (fre-
quency mode)
HYSTERESIS
Diagnostics hysteresis in order to avoid alarm flickering (fre-
quency mode).

Parameter Char. Description
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BINARY_IN-
PUT_3_SET-
TINGS/
BINARY_IN-
PUT_4_SET-
TINGS/
BINARY_IN-
PUT_5_SET-
TINGS/
BINARY_IN-
PUT_6_SET-
TINGS/

Record, W, S, 
OOS

TAG
Tag of the input.
OPTIONS
• Enable or disable lead breakage detection.
• Enable or disable short circuit detection.
• Invert (binary mode only)
• Use Fault state (binary mode only).
• Fault state to value (binary mode only).
• Fault state (binary mode only).

TEMP_IN-
PUT_1_SET-
TINGS/
TEMP_IN-
PUT_2_SET-
TINGS

Record, W, S, 
OOS

TAG
Tag of the input.
OPTIONS
• Enable or disable lead breakage detection (binary mode 

only)
• Enable or disable short circuit detection (binary mode only)
• Use input as binary Input
• Invert (binary mode only)
• Use Fault state (binary mode only)
• Fault state to value (binary mode only)
• Fault state (binary mode only)
UNIT
Temperature unit.
Supported units: °C, °F, °R, K
HI_HI_OOS
Field diagnostics High-Out-of-Specification temperature limit 
(temperature mode)
HI_MR
Field diagnostics High-Maintenance-Required temperature 
limit (temperature mode)
LO_MR
Field diagnostics Low-Maintenance-Required temperature 
limit (temperature mode)
LO_LO_OOS
Field diagnostics Low-Out-of-Specification temperature limit 
(temperature mode)
HYSTERESIS
Diagnostic hysteresis in order to avoid alarm flickering (tem-
perature mode).

TEMP_INT_-
SETTINGS

Record, W, S, 
OOS

UNIT
Temperature unit.
Supported units: °C, °F, °R, K
HI_HI_OOS
Field diagnostics High-Out-of-Specification temperature limit
HI_MR
Field diagnostics High-Maintenance-Required temperature 
limit
LO_MR
Field diagnostics Low-Maintenance-Required temperature 
limit
LO_LO_OOS
Field diagnostics Low-Out-of-Specification temperature limit
HYSTERESIS
Diagnostic hysteresis to avoid alarm flickering

Parameter Char. Description
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HUMIDI-
TY_IN-
PUT_INT_SE
TTINGS

Record, W, S, 
OOS

HI_HI_OOS
Field diagnostics High-Out-of-Specification humidity limit
HI_MR
Field diagnostics High-Maintenance-Required humidity limit
LO_MR
Field diagnostics Low-Maintenance-Required humidity limit
LO_LO_OOS
Field diagnostics Low-Out-of-Specification humidity limit
HYSTERESIS
Diagnostic hysteresis in order to avoid alarm flickering

BUZZER_-
SETTINGS

Record, W, S, 
OOS

Frequency
Buzzer interval:
• 0.5 Hz
• 1.0 Hz (default)
• 1.5 Hz
• 2.0 Hz
• Permanently on
OPTIONS
Invert input value (0: On; 1: Off)

RELAY_OUT-
PUT_1_SET-
TINGS/
RELAY_OUT-
PUT_1_SET-
TINGS

Record, W, S, 
OOS

TAG
Tag of the output.
OPTIONS
Invert output value (0: On; 1: Off)

COM-
MON_ALARM_
OUTPUT_-
SETTINGS

W, S, OOS Invert output value (0: Open; 1: Closed)

Parameter Char. Description
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OUTPUT_-
SOURCE

Record, W, S, 
OOS

RELAY_OUTPUT_1
• Not connected: The value of the output is the same as 

defined if the IO_TB is in OOS mode
• FF channel: The output value is provided through an FF 

channel
• BINARY_INPUT_1-8: Binary input 1 ... 8
• ON_OFF_CONT_1-4: On/off controller 1 ... 4
• Field diagnostics Fail: The output is set to 1 if a field diag-

nostics Fail alarm is active
• Field diagnostics Fail Inverted: Same as FD Fail but output 

value is inverted
• Field diagnostics Out of Spec: The output is set to 1 if a 

field diagnostics Fail or Out of Specification alarm is active
• Field diagnostics Out of Spec Inverted: Same as FD Out of 

Specification but output value is inverted
• Field diagnostics MR: : The output is set to 1 if a Field diag-

nostics Fail, Out of Specification, or Maintenance Required 
alarm is active

• Field diagnostics MR Inverted: Same as FD MR, but output 
value is inverted

• Field diagnostics Check: The output is set to 1 if a field 
diagnostics Fail, Out of Specification, Maintenance 
Required, or Check function alarm is active

• Field diagnostics Check Inverted: Same as FD Check, but 
output value is inverted

RELAY_OUTPUT_2
See RELAY_OUTPUT_1
BUZZER_OUTPUT
See RELAY_OUTPUT_1
COMMON_ALARM_OUTPUT
See RELAY_OUTPUT_1

ON_OFF_-
SET-
TINGS_1/
ON_OFF_-
SET-
TINGS_2/
ON_OFF_-
SET-
TINGS_3/
ON_OFF_-
SETTINGS_4

Record, W, S, 
OOS

INPUT
Selects the input value for the on/off controller
• Temperature input 1
• Temperature input 2
• Temperature difference (Temperature input 2 – tempera-

ture input 1)
• Motherboard temperature
• Motherboard humidity
• Frequency input 1
• Frequency input 2
ON_LEVEL
If input value > ON_LEVEL, then output value = 1
OFF_LEVEL
If input value < OFF_LEVEL, then output value = 0
OPTIONS
Invert: Inverts controller output.

SERI-
AL_USAGE

For internal usage

Parameter Char. Description
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8.2.3 Multiple Discrete Input (MDI) Function Block 
Parameters

IO_BOARD_I
NFO

Record BOARD_TYPE
Indicates the board type where the diagnostic gateway is 
mounted on:
• MB-FB-GT-AD.FF ("Passive board")
• MB-FB-GT-AD.FF.IO ("I/O board")
BOARD_SW_REVISION
Software revision of the I/O motherboard (only when mounted 
on MB-FB-GT-AD.FF.IO)

Parameter Char. Description

Parameter Char. Description
ST_REV S During each writing process to a parameter marked 

with "S", the parameter ST_REV is increased by 1.
TAG_DESC S, W An additional description to the tag of the field 

device.
STRATEGY S, W The strategy field can be used to identify comprising 

blocks. This data is not controlled or used by the 
block.

ALERT_KEY S, W Identification number of the plant component. This 
information can be used by the control computer, 
e.g., to sort alarms. Valid values are 1 ... 65536.

MODE_BLK S, W Displays the current, permitted standard mode and 
the target mode of the block. The target mode can be 
set to the values "Auto" or "Out of Service".
Default: Auto

BLOCK_ERR Displays diagnostic messages of the block.
CHANNEL S, W The channel parameter is used to logically associate 

transducer and function block information. During 
block configuration, the value of the channel number 
may be configured in input and output function 
blocks. See chapter 8.3

OUT_D1 W, OOS, 
MAN

Output value and status.
Manual mode permits manual (operator/engineer) 
substitution of the value of OUT_D, for tests or other 
purposes.

OUT_D2 – OUT_D8 W, OOS, 
MAN

See OUT_D1

UPDATE_EVT This parameter is used to signal to the PCS that a 
parameter marked with "S" was overwritten, provided 
the PCSs supports alarm messages.

BLOCK_ALM This parameter is used to signal to the PCS diagnos-
tic messages displayed in BLOCK_ERR, provided 
that the PCS supports alarm messages.
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8.2.4 Digital input (DI) Function Block
Parameters
Parameter Char. Description
ST_REV During each writing process to a parameter marked 

with "S", the parameter ST_REV is increased by 1.
TAG_DESC W, S Via this parameter, a tag (measuring point designa-

tion) can be assigned to the valve interface in the 
plant or process.

STRATEGY W, S The strategy field can be used to identify comprising 
blocks. This data is not controlled or used by the 
block.

ALERT_KEY W, S Identification number of the plant component. This 
information can be used by the control PC, e.g., to 
sort alarms. Valid values are 1 ... 65536.

MODE_BLK W, S Displays the current, allowed, normal mode and the 
target mode of the block. The target mode can be set 
to the values "Auto", "Man" or "Out of Service".

BLOCK_ERR Displays diagnostic messages of the block.
PV_D Channel value with optional inversion (IO_OPTS) 

and filtering applied to it (PV_FTIME).
OUT_D W, Man The actual output value. When the block is in AUTO 

mode, this is equal to PV_D. If the block is in manual 
mode, the parameter is writeable.

SIMULATE_D W, S, OOS Using this structure, the simulation can be activated 
or deactivated. If the simulation is activated, this 
parameter determines FIELD_VAL_D. The simula-
tion can only be activated with the associated 
switch 1 ON.

XD_STATE W, S Used by some PCS to assign texts to the numerical 
values of FIELD_VAL_D.

GRANT_DENY W Depending on the PCS in use, the parameter regu-
lates the access rights between PCS and local oper-
ator workstations for some control systems.

IO_OPTS W, S, OOS Option which enables the user to adapt the block 
algorithm to the task of the block. This option is: 
Invert. 
PV_D is calculated as follows: A Boolean negation of 
FIELD_Val_D is carried out i.e., PV_D becomes 1 if 
FIELD_VAL_D is 0. If FIELD_VAL_D is greater than 
0, then PV_D becomes 0.

STATUS_OPTS W, S, OOS Option that enables the user to adapt the block status 
processing to the task of the block. This option is: 
Propagate Fault Forward. 
If this option is used, the function block does not trig-
ger an alarm itself if the status of PV_D becomes 
"Bad“. Instead, the status, including substatus, is 
passed on via OUT_D. 

CHANNEL W, S, OOS The number of the logical hardware channel that is 
connected to this I/O block. This information defines 
the signal converter to be used going to or from the 
physical world. See chapter 8.3

PV_FTIME W, S Time constant of a single exponential filter for the pri-
mary variable (PV) in seconds.

FIELD_VAL_D Raw value of the field device digital input, with a sta-
tus reflecting the signal converter condition.
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8.2.5 Function Block MAI
Parameters

UPDATE_EVT This parameter is used to signal to the PCS that a 
parameter marked with "S" was overwritten, provided 
the PCS supports alarm messages.

BLOCK_ALM This parameter is used to signal diagnostic mes-
sages that are displayed in BLOCK_ERR to the PCS, 
provided the PCS supports alarm messages. 

ALARM_SUM The current status of the alarm messages of the 
block.

ACK_OPTION S, W Determines if alarms of the function block have to be 
confirmed or not. 

DISC_PRI S, W Priority of discrete alarm
DISC LIM S, W Digital input state, in which an alarm is supposed to 

be generated.
DISC_ALM S, W The current state of the discrete alarm, along with a 

timestamp and datestamp.

Parameter Char. Description

Parameter Char. Description
ST_REV S During each writing process to a parameter marked 

with "S", the parameter ST_REV is increased by 1.
TAG_DESC S, W Use this parameter to assign a tag to the valve inter-

face (measuring point designation) in the plant or 
process.

STRATEGY S, W The strategy field can be used to identify comprising 
blocks. This data is not controlled or used by the 
block.

ALERT_KEY S, W Identification number of the plant component. This 
information can be used by the control computer, 
e.g., to sort alarms. Valid values are 1 ... 65536.

MODE_BLK S, W Displays the current, allowed normal mode and the 
target mode of the block. The target mode can be set 
to the values "Auto" or "Out of Service".
Default: Auto

BLOCK_ERR Displays diagnostic messages of the block.
CHANNEL S, W The channel parameter is used to logically associ-

ated signal converter and function block information. 
During block configuration, the value of the channel 
number can be configured in input and output func-
tion blocks. See chapter 8.3

OUT_D1 Output value and status.
Manual mode permits the operating personnel or 
engineer to manually substitute the value of OUT_D, 
for test or other purposes.

OUT_D2 – OUT_D8 See OUT_D1
UPDATE_EVT This parameter is used to signal to the PCS that a 

parameter marked with "S" was overwritten if the 
PCS supports alarm messages.

BLOCK_ALM This parameter is used to signal to the PCS diagnos-
tic messages displayed in BLOCK_ERR, if the PCS 
supports alarm messages.
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8.2.6 Function Block MDO
Parameters

8.2.7 Resource Block
Parameters

Parameter Char. Description
ST_REV S During each writing process to a parameter marked 

with "S", the parameter ST_REV is increased by 1.
TAG_DESC S, W Use this parameter to assign a tag to the valve inter-

face (measuring point designation) in the plant or 
process.

STRATEGY S, W The strategy field can be used to identify comprising 
blocks. This data is not controlled or used by the 
block.

ALERT_KEY S, W Identification number of the plant component. This 
information can be used by the control computer, 
e.g., to sort alarms. Valid values are 1 ... 65536.

MODE_BLK S, W Displays the current permitted standard mode and 
the target mode of the block. The target mode can be 
set to the values "Auto" or "Out of Service".
Default: Auto

BLOCK_ERR Displays diagnostic messages of the block.
CHANNEL S, W The channel parameter is used to logically associate 

signal converter and function block information. 
During block configuration, the value of the channel 
number can be configured in input and output func-
tion blocks. See chapter 8.3

IN_D1 Input value and status.
IN_D2 - IN_D8 See IN_D1
MO_OPTS S, W Options that the user can select to alter multiple out-

put block processing.
FSTATE_TIME S, W The delay time in seconds. Time from the detection 

of a condition initiating a fault state action in an output 
block until the actual initiation of the output action of 
the block output. That is provided that the condition 
exists continuously during this time interval as sam-
pled by the output block.

FSTATE_VAL_D1 S, W The preset discrete value to be used if failure occurs 
in IN_D1. This value is ignored if the “Fault state to 
value 1” in the MO_OPTS parameter is false.

FSTATE_VAL_D2 - 
FSTATE_VAL_D8

S, W See FSTATE_VAL_D1

UPDATE_EVT This parameter is used to signal to the PCS that a 
parameter marked with "S" was overwritten provided 
that the PCS supports alarm messages.

BLOCK_ALM This parameter is used to signal to the PCS diagnos-
tic messages displayed in BLOCK_ERR provided 
that the PCS supports alarm messages.

Parameter Char. Description
ST_REV During each writing process to a parameter marked with "S", 

the parameter ST_REV is increased by 1.
TAG_DESC W, S Use this parameter to assign a tag to the valve interface (mea-

suring point designation) in the plant or process.
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STRATEGY W, S The strategy field can be used to identify comprising blocks. 
This data is not controlled or used by the block.

ALERT_KEY W, S Identification number of the plant component. This information 
can be used by the control computer, e.g., to sort alarms. Valid 
values are 1 ... 65536.

MODE_BLK W, S Displays the current, allowed normal mode and the target 
mode of the block. The target mode can be set to the values 
"Auto" or "Out of Service".

BLOCK_ERR Displays diagnostic messages of the block.
RS_STATE Current status of the device.
TEST_RW Test parameter used to test the device.
DD_RE-
SOURCE

FF standard parameter, not used.

MANU-
FAC_ID

Identification number of the device manufacturer. The parame-
ter is used by the PCS to assign the device description (DD) to 
the device.

DEV_TYPE Device type. The parameter is used by the control system to 
assign the device description to the device.

DEV_REV Version number of the device. The parameter is used by the 
PCS to assign the device description to the device.

DD_REV Version number of device description. The parameter is used 
by the PCS to assign the device description to the device.

GRANT_DEN
Y

W Regulates the access rights between PCS and local operator 
stations for some control systems.

HARD_-
TYPES

Hardware type.

RESTART W  This parameter enables the user to carry out a new manual 
start. The following different types of restarts are possible: 
• Restart resource
• Restart with defaults (default settings)
• Restart processor

FEATURES Displays the options supported by the device. The options are:
Reports:
Alert reports
Soft write lock:
If enabled, the WRITE_LOCK parameter (if set) prevents any 
external change to the static or nonvolatile database in the 
function block application of the resource.
Unicode strings:
Unicode string
Multi-bit alarm:
If multi-bit alarms are enabled, block alarms are considered to 
be multi-bit alarms, and they are NOT treated as simple 
alarms.
Fault state:
If set, the FAULT_STATE parameter causes all output function 
blocks in the resource to go immediately to the condition cho-
sen by the fault state type I/O option.

FEATURE_-
SEL

W, S The options used are selected here. See FEATURES. 

CYCLE_-
TYPE

The parameter provides the different block implementation 
methods for this device. 

Parameter Char. Description
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CYCLE_SEL W, S The parameter is used to display the block implementation 
method.

MIN_CY-
CLE_T

This parameter sets the shortest macro-cycle that can be used 
by this device. 

MEMORY_-
SIZE

FF standard parameter. Not used. 

NV_CY-
CLE_T

FF standard parameter. Not used. 

FREE_SPAC
E

FF standard parameter. Not used. 

FREE_TIME FF standard parameter. Not used. 
SHED_RCAS W, S The parameter defines the time until a communication failure is 

recognized in the "RCas" mode. 
SHED_ROUT W, S The parameter defines the time until a communication failure is 

recognized in the "ROUT" mode.
FAULT_STAT
E

The parameter indicates whether the device global safety sta-
tus was set. See SET_FSTATE and CLR_FSTATE.

SET_FSTATE W, S The parameter is used to set the device global safety status.
CLR_FSTATE W, S The parameter is used to reset the device global safety status.
MAX_NO-
TIFY

The parameter defines the maximum number of unacknowl-
edged alarm messages that can be managed by the device.

LIM_NOTIFY W, S The parameter defines the maximum number of unacknowl-
edged alarm messages that are admitted.

CONFIRM_-
TIME 

W, S The parameter sets the time during which an alarm is repeated 
unless acknowledged.

WRITE_LOC
K

The parameter indicates the position of the read-only switch.

UPDATE_EV
T

This parameter is used to signal to the DSCS that a parameter 
identified with "S" was overwritten provided that the PCS sup-
ports alarm messages.

BLOCK_ALM This parameter is used to signal to the PCS diagnostic mes-
sages displayed in BLOCK_ERR provided that the PCS sup-
ports alarm messages.

ALARM_SUM The current status of the alarm messages of the block. 
ACK_OP-
TION

W, S The parameter determines whether the alarms of the resource 
block must be acknowledged.

WRITE_PRI The parameter determines the priority of the alarm messages 
that are released when setting and resetting the read-only 
switch.

WRITE_ALM The parameter determines if an alarm message is released 
when setting and resetting the read-only switch.

ITK_VER The parameter assigns a version number to the interoperability 
test that was used to test the device.

SERIAL_-
NUM 

The parameter assigns a serial number to the device.

SW_REV The parameter sets a version status of software used by the 
device. 

FD_VER A parameter equal to the value of the major version of the field 
diagnostics specification according to which this device was 
designed.

Parameter Char. Description
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FD_FAIL_AC-
TIVE

This parameter reflects the fault conditions that are detected as 
active as selected for this category.
Since this parameter is a bit string, multiple conditions can be 
issued.

FD_OFF-
SPEC_AC-
TIVE

See FD_FAIL_ACTIVE

FD_-
MAINT_AC-
TIVE

See FD_FAIL_ACTIVE

FD_-
CHECK_AC-
TIVE

See FD_FAIL_ACTIVE

FD_FAIL_-
MAP

S, W, OOS This parameter maps conditions to be detected as active for 
this alarm category. Thus, the same condition can be active in 
all, some, or none of the 4 alarm categories.

FD_OFF-
SPEC_MAP

S, W, OOS See FD_FAIL_MAP

FD_MAINT_-
MAP

S, W, OOS See FD_FAIL_MAP

FD_CHECK_-
MAP

S, W, OOS See FD_FAIL_MAP

FD_-
FAIL_MASK

S, W, OOS This parameter allows the user to suppress any single or multi-
ple conditions that are active in this category from being trans-
mitted to the host through the alarm parameter.
1 bit = 1 masks, i. e., inhibits the transmission of a condition 
1 bit = 0 unmasks, i. e., enables transmission of a condition

FD_OFF-
SPEC_MASK

S, W, OOS See FD_FAIL_MASK

FD_-
MAINT_MAS
K

S, W, OOS See FD_FAIL_MASK

FD_-
CHECK_MAS
K

S, W, OOS See FD_FAIL_MASK

FD_-
FAIL_ALM

This parameter is primarily used to transmit a change in the 
associated active conditions that are not masked, for this alarm 
category to a host system.

FD_OFF-
SPEC_ALM

See FD_FAIL_ALM

FD_-
MAINT_ALM

See FD_FAIL_ALM

FD_-
CHECK_ALM

See FD_FAIL_ALM

FD_FAIL_PRI S, W, OOS This parameter allows the user to specify the priority of this 
alarm category.

FD_OFF-
SPEC_PRI

S, W, OOS See FD_FAIL_PRI

FD_MAINT_-
PRI

S, W, OOS See FD_FAIL_PRI

FD_CHECK_-
PRI

S, W, OOS See FD_FAIL_PRI

Parameter Char. Description
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8.3 HD2-GT-2AD.FF.IO FF Channel List

FD_SIMU-
LATE

S, W, OOS This parameter allows the conditions to be manually supplied 
when simulation is enabled.
When simulation is disabled, both the simulated diagnostic 
value and the diagnostic value track the actual conditions.
The simulation jumper is required for simulation to be enabled. 
While simulation is enabled, the recommended action shows 
that simulation is active.

FD_RECOM-
MEN_ACT

This parameter is a device-enumerated summarization of the 
most severe condition or conditions detected.

SERIAL 
NUMBER

Pepperl+Fuchs serial number of the gateway.

SW_REV Software revision of the gateway.
IP_ADDRESS IP address of the device (when an Ethernet connection is pres-

ent).
DGW_MODE W, S DGW-FF mode. The device can operate in 2 modes:

• 0x01: FDS – Connect via FDS is allowed, ADMs are con-
trolled by FDS, the ADM_TB block is not operational

• 0x02: FF – No connect via FDS is allowed, ADMs are con-
trolled via ADM_TB blocks

ADM_X-
D_STATUS

For internal usage

FB_INFO For internal usage
TB_INFO For internal usage
SEGMENT_-
MODE_INFO

For internal usage

SNAP-
SHOT_MIN_1

For internal usage

SNAP-
SHOT_MIN_2

For internal usage

SNAP-
SHOT_MIN_3

For internal usage

SNAP-
SHOT_MIN_4

For internal usage

SNAP-
SHOT_-
MAX_1

For internal usage

SNAP-
SHOT_-
MAX_2

For internal usage

SNAP-
SHOT_-
MAX_3

For internal usage

SNAP-
SHOT_-
MAX_4

For internal usage

Parameter Char. Description

Channel 
Number Data Type

Allowed for 
FB Content

1 DS-66 DI Value: Summary status all ADMs mapped as follows:
XD_STATUS value Result
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No Error 0
Maintenance Required 1
Out of Specification 1
Excellent 0
Good 0
Fail 1
Configuration Error 1
No ADM Connected 1
Segment Disabled 0
All ADM_TB with a target mode of AUTO are taken 
into account.
Status:
• Bad (Out of Service) if all ADM_TBs are in Out-

of-Service mode
• Good (NC) in all other cases

2 8 x DS-66 MDI Value: Status of ADMs with address 1 ... 8 mapped to 
"0" and "1" like channel 1.
Status:
• Bad (Out of Service) if corresponding ADM_TBs 

is in Out-of-Service mode
• Good (NC) in all other cases

3 8 x DS-66 MDI Same as channel 2, but for ADMs 9 ... 16
11 DS-66 DI Value: Summary status all ADMs encoded as fol-

lows:
XD_STATUS value Value
No Error 0x00
Maintenance Required 0x01
Out of Specification (commissioned 
mode)

0x02

Excellent 0x10
Good 0x11
Out of Specification (non-commis-
sioned mode)

0x12

Fail 0x20
Configuration Error 0x21
No ADM Connected 0x22
Segment Disabled 0x23
All ADM_TB with a target mode of AUTO are taken 
into account.
Status:
• Bad (Out of Service) if all ADM_TBs are in Out-

of-Service mode
• Good (NC) in all other cases

Channel 
Number Data Type

Allowed for 
FB Content
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8.4 HD2-GT-2AD.FF.IO FF Field Diagnostic Conditions

12 8 x DS-66 MDI Value: Status of ADMs with Address 1 ... 8 encoded 
like channel 11
Status:
• Bad (Out of Service) if corresponding ADM_TBs 

is in Out-of-Service mode
• Good (NC) in all other cases

13 8 x DS-66 MDI Same as channel 12 but for ADMs 9 ... 16
101 8 x DS-66 MDI Input value and status of binary inputs 1 ... 8
102 8 x DS-66 MDI 1 ... 4: Value and status of on/off controller 1 ... 4

5 ... 8: Value 0, status "Bad"
103 8 x DS-65 MAI 1: Value and status of temperature input 1

2: Value and status of temperature input 2
3: Value and status of board temperature
4: Value and status of board humidity
5: Value and status of frequency input 1
6: Value and status of frequency input 2
7, 8: Value 0, status "Bad"

104 8 x DS-65 MDO 1: Relay contact output 1 (output source of relay con-
tact output 1 must be set to "FF channel")
2: Relay contact output 2 (output source of relay con-
tact output 2 must be set to "FF channel")
3: Buzzer (output source of buzzer must be set to 
"FF channel")
4: Common alarm output (output source of common 
alarm output must be set to "FF channel")
5 ... 8: Ignored

105 1x DS-66 DI, MDI Status of BINARY_INPUT_1 ... BINARY_INPUT_8 
as bits of the U8. If channel is used for MDI, only 
OUT_1 is used!

201 1x DS-66 DI Field diagnostic of resource block

Channel 
Number Data Type

Allowed for 
FB Content

Bit Name Description Default Mapping
0 Check Function Actual block mode does not match nor-

mal mode and normal mode is unequal 
to OOS.

Check function

1 ADM Maintenance 
Required

Any ADM system or segment where the 
corresponding ADM_TB with target 
mode "AUTO" has a status of "Mainte-
nance Required".

Maintenance 
Required

2 ADM Out of Specifi-
cation

Any ADM system or segment where the 
corresponding ADM_TB with target 
mode "AUTO" has a status of "Out of 
Specification".

Offspec

3 ADM Non Commis-
sioned

Any ADM where the corresponding 
ADM_TB with target mode "AUTO" has 
non-commissioned segments.

Check function

4 ADM Fail Any ADM system or segment where the 
corresponding ADM_TB with target 
mode "AUTO" has a status of "Fail".

Fail

5 ADM Not Con-
nected

Any ADM_TB with target mode "AUTO" 
where no corresponding ADM can be 
found on any diagnostic bus.

Fail
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8.5 Expert System Phenomena IDs

6 IO Out of Specifica-
tion

Any bit in IO_TB.FD_OOS_ACTIVE is 
set when IO_TB has a target mode of 
"AUTO".

Offspec

7 IO Maintenance 
Required

Any bit in IO_TB.FD_MR_ACTIVE is set 
when IO_TB has a target mode of 
"AUTO".

Maintenance 
Required

8 IO Fail Any bit in IO_TB BINARY_ERRORS or 
ANALOG_ERRORS is set when IO_TB 
has a target mode of "AUTO".

Fail

9 Block Configura-
tion error

Any transducer block with target mode 
"AUTO" of the device shows a block con-
figuration error.

Maintenance 
Required

10 ... 31 Not used

Bit Name Description Default Mapping

ID Phenomenon Cause(s) Action(s)
101 Signal level is too high, 

only host communication 
and segment power are 
detected

Trunk breakage between 
fieldbus power supply and 
first device coupler

Check trunk, fieldbus 
power supply terminals 
and first device coupler

102 Signal level of one or more 
devices is too high

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Trunk breakage between 
device couplers

Check trunk cable and 
device coupler terminals

Topology error - installed 
topology does not match 
configured topology

Check that the topology 
settings match the installa-
tion

103 Signal level of one or more 
devices is too low for the 
given topology

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Cable resistance is too 
high

Check if the correct cable 
is installed and the cable 
can be used for the topol-
ogy

Topology error - installed 
topology does not match 
configured topology

Check that the topology 
settings match the installa-
tion

104 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Bulk power supply failed Check bulk power supply
Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Cable breakage, short cir-
cuit or terminal connection 
failure

Check cabling and termi-
nals

Diagnostic device is 
wrongly or not connected 
to the segment

Check wiring connection to 
the segment
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105 The segment is powered 
and communication is 
active, but no devices are 
detected

Wrong fieldbus type 
selected

Set fieldbus type to FOUN-
DATION Fieldbus or PRO-
FIBUS PA

106 Segment powered and OK 
but no communication 
detected

Host/LAS/master commu-
nication fault

Check host/LAS/master

No host connected Check if the host is 
installed and correctly con-
nected to the segment

107 Segment voltage is out of 
range for the given topol-
ogy

Wrong fieldbus power sup-
ply installed or wrong topol-
ogy configured

Replace fieldbus power 
supply or correct topology 
settings

108 Noise is "Out of specifica-
tion" for the segment

Noise injection on the field-
bus

Check fieldbus cable for 
correct shielding and 
grounding. Check for exter-
nal noise sources.

Shield wiring / grounding 
fault

Check fieldbus cable for 
correct shielding and 
grounding.

109 Jitter is "Out of specifica-
tion" for the segment

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

Wrong cable type, cable 
impedance not correct

Check if the correct cable 
is installed and the cable 
can be used for the topol-
ogy

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

110 Jitter of one device is "Out 
of specification", jitter is not 
"Out of specification" for 
the other devices

Device malfunction: jitter of 
a device is too high

Replace device

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

111 Unbalance is "Out of speci-
fication" to fieldbus +

Short circuit/leakage cur-
rent between fieldbus pos. 
pole and shield/ground

Remove connection 
between pos. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress

112 Unbalance is "Out of speci-
fication" to fieldbus -

Short circuit/leakage cur-
rent between fieldbus neg. 
pole and shield/ground

Remove connection 
between neg. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress

113 Noise of one device is "Out 
of specification", noise is 
not "Out of specification" 
for the other devices

Device injects noise Check noise with the field-
bus oscilloscope. The 
device showing high noise 
values is not necessarily 
the one injecting the noise.

ID Phenomenon Cause(s) Action(s)
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115 Signal level of one device 
is too low for the given 
topology, signal level of 
others OK

Device malfunction: Signal 
level is too low

Replace device

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

116 Signal level of one device 
is too high for the given 
topology

Measurement executed at 
spur

Connect to proper mea-
surement point

117 Segment voltage is too low Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Topology error - non-work-
ing topology

Check if the topology is 
valid according to the field-
bus specification

Cable resistance is too 
high

Check if the correct cable 
is installed and the cable 
can be used for the topol-
ogy

Topology error - installed 
topology does not match 
configured topology

Check that the topology 
settings match the installa-
tion

120 Signal level is too high, 
only host is active and seg-
ment is powered

Trunk breakage between 
fieldbus power supply and 
first device coupler

Check trunk, fieldbus 
power supply terminals 
and first device coupler

121 Signal level of one or more 
devices is too high

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Trunk breakage between 
device couplers

Check trunk cable and 
device coupler terminals

Topology error - installed 
topology does not match 
configured topology

Check that the topology 
settings match the installa-
tion

122 Signal level of one or more 
devices is too low for the 
given topology

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Cable resistance is too 
high

Check if the correct cable 
is installed and the cable 
can be used for the topol-
ogy

Topology error - installed 
topology does not match 
configured topology

Check that the topology 
settings match the installa-
tion

123 Voltage of Bulk Power Sup-
ply (Primary or Second-
ary) is "Out of 
specification"

Bulk power supply voltage 
error

Check and correct voltage 
of bulk power supply

ID Phenomenon Cause(s) Action(s)



Advanced Diagnostics
Appendix

 2
02

0-
11

175

124 No Bulk Power Supply (Pri-
mary or Secondary) con-
nected

Bulk power supply failed 
(Bulk Power Supply (Pri-
mary or Secondary))

Check bulk power supply 
(Bulk Power Supply (Pri-
mary or Secondary))

Wiring between bulk power 
supply and Board failed

Check if bulk power supply 
is correctly wired to the 
power supply

Terminal failure: loose con-
nection

Check all terminals for cor-
rect connection

125 Type of fieldbus power 
supply A differs from B

Power supply mismatch Two different types of field-
bus power supplies are 
installed for the same seg-
ment. This is not allowed. 
Use only one type of field-
bus power supply for this 
segment.

126 Fieldbus power condi-
tioner is only supported on 
universal motherboard

Non isolated Power Sup-
ply HD2-FBCL-1.500 not 
supported on this mother-
board

Replace power supply 
module or motherboard

127 Fieldbus power supply fail-
ure detected

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

128 Segment Power Supply 
Module (A or B) failure 
detected, no redundancy 
available

Segment Power Supply 
Module (A or B) failed, 
redundant power supply 
module powers the seg-
ment

Replace Segment Power 
Supply Module (A or B)

129 Both fieldbus power sup-
plies report failure, seg-
ment is unpowered

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

130 Both fieldbus power sup-
plies report failure, seg-
ment is powered

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

131 Unbalance is "Out of speci-
fication" to the positive pole

Short circuit/leakage cur-
rent between fieldbus pos. 
pole and shield/ground

Remove connection 
between pos. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress

132 Unbalance is "Out of speci-
fication" to the negative 
pole

Short circuit/leakage cur-
rent between fieldbus neg. 
pole and shield/ground

Remove connection 
between neg. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress

133 Segment Voltage is out of 
range for the given topol-
ogy

Wrong fieldbus power sup-
ply installed or wrong topol-
ogy configured

Replace fieldbus power 
supply or correct topology 
settings

ID Phenomenon Cause(s) Action(s)
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134 Noise of one device is "Out 
of specification", noise is 
not "Out of specification" 
for other devices

Device injects noise Check noise with the field-
bus oscilloscope. The 
device showing high noise 
values is not necessarily 
the one injecting the noise.

135 Jitter of one device is "Out 
of specification", jitter is not 
"Out of specification" for 
other devices

Device malfunction: jitter of 
a device is too high

Replace device

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

136 Signal level of one device 
is too low for the given 
topology, signal level of 
others is OK

Device malfunction: Signal 
level is too low

Replace device

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

137 Segment powered and OK 
but no communication 
detected

Host/LAS/master commu-
nication fault

Check host/LAS/master

No host connected Check if the host is 
installed and correctly con-
nected to the segment

138 Segment Power Supply 
Module (A or B) not 
installed

Segment Power Supply 
Module (A or B) not 
installed

Install Segment Power 
Supply Module (A or B) on 
the motherboard

140 Noise is "Out of specifica-
tion" for the segment

Shield wiring / grounding 
fault

Check fieldbus cable for 
correct shielding and 
grounding.

Noise injection on the field-
bus

Check fieldbus cable for 
correct shielding and 
grounding. Check for exter-
nal noise sources.

141 Jitter is "Out of specifica-
tion" for the segment

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

Wrong cable type, cable 
impedance not correct

Check if the correct cable 
is installed and the cable 
can be used for the topol-
ogy

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

142 Current is too high for the 
fieldbus power supply

Fieldbus power supply 
overload

Check if there is any con-
nection between fieldbus + 
and fieldbus - or remove 
devices

144 Signal level is too high, 
only host is active and seg-
ment is powered

Trunk breakage between 
fieldbus power supply and 
first device coupler

Check trunk, fieldbus 
power supply terminals 
and first device coupler

145 Signal level of one or more 
devices is too high and 
devices are missing com-
pared to commissioning

Trunk breakage between 
device couplers

Check trunk cable and 
device coupler terminals

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk
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146 Signal level of one or more 
devices is too high

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

149 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Bulk power supply failed Check bulk power supply
Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Cable breakage, short cir-
cuit or terminal connection 
failure

Check cabling and termi-
nals

Diagnostic device is 
wrongly or not connected 
to the segment

Check wiring connection to 
the segment

150 The segment is powered 
and communication is 
active, but no devices are 
detected

Wrong fieldbus type 
selected

Set fieldbus type to FOUN-
DATION Fieldbus or PRO-
FIBUS PA

152 Noise "MR/OOS" for the 
segment

Noise injection on the field-
bus

Check fieldbus cable for 
correct shielding and 
grounding. Check for exter-
nal noise sources.

Shield wiring / grounding 
fault

Check fieldbus cable for 
correct shielding and 
grounding.

153 Jitter of one device 
"MR/OOS", jitter of other 
devices OK

Device malfunction: jitter of 
a device is too high

Replace device

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

154 Unbalance is "OOS/MR" to 
fieldbus +

Short circuit/leakage cur-
rent between fieldbus pos. 
pole and shield/ground

Remove connection 
between pos. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress

155 Unbalance is "OOS/MR" to 
fieldbus -

Short circuit/leakage cur-
rent between fieldbus neg. 
pole and shield/ground

Remove connection 
between neg. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress

156 Noise of one device is 
"MR/OOS", value of other 
devices is not "MR/OOS"

Device injects noise Check noise with the field-
bus oscilloscope. The 
device showing high noise 
values is not necessarily 
the one injecting the noise.
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157 Signal level of one device 
is too low, signal level of 
others OK

Device malfunction: Signal 
level is too low

Replace device

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

158 One device is missing 
compared to commission-
ing

Spur short circuit Check spur of the missing 
device

Spur breakage Check spur cable and ter-
minals of the missing 
device

Device failed Check and replace device
Device unintentionally 
removed from the segment

Reinstall device or execute 
commissioning wizard 
again

Device intentionally 
removed from segment

Execute commissioning 
wizard again

159 Signal level is too low Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

161 Segment powered and OK 
but no communication 
detected

Host/LAS/master commu-
nication fault

Check host/LAS/master

No host connected Check if the host is 
installed and correctly con-
nected to the segment

162 Additional devices active 
compared to commission-
ing

Extra devices installed Remove extra devices or 
execute commissioning 
wizard again

163 Devices are missing com-
pared to commissioning

Device coupler failed Check device couplers and 
device coupler terminals

Device intentionally 
removed from segment

Execute commissioning 
wizard again

164 Segment voltage is lower 
compared to commission-
ing

Fieldbus power supply 
overload

Check if there is any con-
nection between fieldbus + 
and fieldbus - or remove 
devices

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

165 Jitter is "MR/OOS" for the 
segment

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

166 Signal level of one device 
is too high, signal level of 
others is OK

Measurement executed at 
spur

Connect to proper mea-
surement point
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167 Segment voltage is lower 
compared to commission-
ing

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Fieldbus power supply 
overload

Check if there is any con-
nection between fieldbus + 
and fieldbus - or remove 
devices

169 Segment voltage is "Out of 
specification"

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

171 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Bulk power supply failed Check bulk power supply
Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Cable breakage, short cir-
cuit or terminal connection 
failure

Check cabling and termi-
nals

172 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Bulk power supply failed Check bulk power supply
Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Cable breakage, short cir-
cuit or terminal connection 
failure

Check cabling and termi-
nals

173 Segment voltage is "Out of 
specification"

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

174 Segment voltage is too low Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Topology error - non-work-
ing topology

Check if the topology is 
valid according to the field-
bus specification

175 Segment voltage is too 
low: "Out of specification"

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

Topology error - non-work-
ing topology

Check if the topology is 
valid according to the field-
bus specification

Diagnostic device is 
wrongly or not connected 
to the segment

Check wiring connection to 
the segment
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177 The segment is powered 
and communication is 
active, but no devices are 
detected

Wrong fieldbus type 
selected

Set fieldbus type to FOUN-
DATION Fieldbus or PRO-
FIBUS PA

178 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

179 Segment voltage is "Out of 
specification"

Power supply module 
defect, Voltage is OOS

Replace power supply 
module

182 Both fieldbus power sup-
plies report failure

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

183 No fieldbus power supply 
installed

No power supply module 
installed

Install power supply mod-
ule for this segment

184 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Terminal failure: loose con-
nection

Check all terminals for cor-
rect connection

Diagnostic device is 
wrongly or not connected 
to the segment

Check wiring connection to 
the segment

185 Segment voltage is "Out of 
specification"

Power supply module 
defect, Voltage is OOS

Replace power supply 
module

188 Signal level is is too high, 
only host is active and Seg-
ment is powered

Trunk breakage between 
fieldbus power supply and 
first device coupler

Check trunk, fieldbus 
power supply terminals 
and first device coupler

189 Signal level of one or more 
devices is too high and 
devices are missing com-
pared to commissioning

Trunk breakage between 
device couplers

Check trunk cable and 
device coupler terminals

190 Signal level of one or more 
devices is too high

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

191 Signal level is too low: 
OOS/MR

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

192 Signal level of one device 
is MR/OOS (too low), sig-
nal level of others is OK

Device malfunction: Signal 
level is too low

Replace device

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total
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193 No communication 
detected

Host/LAS/master commu-
nication fault

Check host/LAS/master

No host connected Check if the host is 
installed and correctly con-
nected to the segment

194 The segment is powered 
and communication is 
active, but no devices are 
detected

Wrong fieldbus type 
selected

Set fieldbus type to FOUN-
DATION Fieldbus or PRO-
FIBUS PA

195 Segment voltage is "Out of 
specification" (too low)

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

196 Segment voltage is "Out of 
specification" (too high)

Power supply module 
defect, Voltage is OOS

Replace power supply 
module

197 Segment voltage changed 
compared to commission-
ing

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

198 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

202 Both fieldbus power sup-
plies report failure, seg-
ment is unpowered

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

203 No fieldbus power supply 
installed

No power supply module 
installed

Install power supply mod-
ule for this segment

204 Segment Power Supply 
Module (A or B) is different 
compared to commission-
ing

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

205 Segment Power Supply 
Module (A or B) is missing

Segment Power Supply 
Module (A or B) not 
installed

Install Segment Power 
Supply Module (A or B) on 
the motherboard

206 Both fieldbus power sup-
plies report failure, seg-
ment is powered

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

207 Segment Power Supply 
Module (A or B) failure 
detected, no redundancy 
available

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

208 Segment Power Supply 
Module (A or B) failure 
detected

Segment Power Supply 
Module (A or B) failed, 
redundant power supply 
module powers the seg-
ment

Replace Segment Power 
Supply Module (A or B)

209 Both fieldbus power sup-
plies report failure

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies
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212 Segment voltage is mea-
sured as zero. Segment is 
unpowered

Trunk short circuit Check trunk. If no spur 
short circuit protection is 
installed, also check spurs.

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Terminal failure: loose con-
nection

Check all terminals for cor-
rect connection

Diagnostic device is 
wrongly or not connected 
to the segment

Check wiring connection to 
the segment

213 Segment voltage is "Out of 
specification"

Power supplies failed for 
the segment

Check and replace fieldbus 
power supplies

215 Noise is MR/OOS for the 
segment

Noise injection on the field-
bus

Check fieldbus cable for 
correct shielding and 
grounding. Check for exter-
nal noise sources.

Shield wiring / grounding 
fault

Check fieldbus cable for 
correct shielding and 
grounding.

216 Noise of one device is 
MR/OOS, value is not 
MR/OOS of other devices

Device injects noise Check noise with the field-
bus oscilloscope. The 
device showing high noise 
values is not necessarily 
the one injecting the noise.

217 Jitter is MR/OOS for the 
segment

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

218 Jitter of one device is 
OOS/MR, jitter of other 
devices is OK

Device malfunction: jitter of 
a device is too high

Replace device

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Fieldbus impedance fault Check if the fieldbus topol-
ogy is valid. Check noise, 
reduce high noise values.

219 Unbalance is MR/OOS to 
the positive pole

Short circuit/leakage cur-
rent between fieldbus pos. 
pole and shield/ground

Remove connection 
between pos. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress

220 Unbalance is OOS/MR to 
the negative pole

Short circuit/leakage cur-
rent between fieldbus neg. 
pole and shield/ground

Remove connection 
between neg. pole and 
shield/ground

Water ingress Check housings of devices 
and junction boxes for 
water ingress
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227 Segment current is too 
high compared to commis-
sioning and exceeds the 
specification of the power 
supply

Fieldbus power supply 
overload

Check if there is any con-
nection between fieldbus + 
and fieldbus - or remove 
devices

228 Segment current increased 
compared to commission-
ing

Current consumption of the 
segment increased com-
pared to commissioning

This indicates an upcoming 
failure of an active compo-
nent. Check devices and 
device couplers.

230 Segment current is too low 
compared to commission-
ing

Current consumption of the 
segment decreased com-
pared to commissioning

This indicates an upcoming 
failure of an active compo-
nent. Check devices and 
device couplers.

231 One device is missing 
compared to commission-
ing

Spur short circuit Check spur of the missing 
device

Spur breakage Check spur cable and ter-
minals of the missing 
device

Device failed Check and replace device
Device unintentionally 
removed from the segment

Reinstall device or execute 
commissioning wizard 
again

Device intentionally 
removed from segment

Execute commissioning 
wizard again

232 Additional devices active 
compared to commission-
ing

Extra devices installed Remove extra devices or 
execute commissioning 
wizard again

234 Devices are missing com-
pared to commissioning

Device coupler failed Check device couplers and 
device coupler terminals

Device intentionally 
removed from segment

Execute commissioning 
wizard again

235 Status of the Bulk Power 
Supply (Primary or Sec-
ondary) Voltage is 
MR/OOS

Bulk power supply voltage 
error

Check and correct voltage 
of bulk power supply

236 Voltage of the Bulk Power 
Supply (Primary or Sec-
ondary) is 0 V

Wiring between bulk power 
supply and Board failed

Check if bulk power supply 
is correctly wired to the 
power supply

Bulk power supply failed 
(Bulk Power Supply (Pri-
mary or Secondary))

Check bulk power supply 
(Bulk Power Supply (Pri-
mary or Secondary))

Terminal failure: loose con-
nection

Check all terminals for cor-
rect connection

238 Status is "Excellent" No issues are detected for 
this segment

No action required

239 Status is "Good", no diag-
nostic messages

No issues are detected for 
this segment

No action required

240 No error No issues are detected for 
this segment

No action required

241 No license available, 
Expert System not sup-
ported

The Expert System 
requires a license

Contact Pepperl+Fuchs to 
acquire the license 
required
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242 Minimum signal level of the 
segment is MR/OOS

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

Device malfunction: Signal 
level is too low

Replace device

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

243 Maximum signal level of 
the segment is MR/OOS

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Trunk breakage between 
device couplers

Check trunk cable and 
device coupler terminals

244 Current motherboard type 
different from expected 
one

Motherboard Type 
changed compared to 
commissioning

Check if the installed moth-
erboard is the desired one 
and execute the commis-
sioning wizard or replace 
the motherboard

245 Fieldbus power supply A 
different from fieldbus 
power supply B or one slot 
empty

Power supply mismatch Two different types of field-
bus power supplies are 
installed for the same seg-
ment. This is not allowed. 
Use only one type of field-
bus power supply for this 
segment.

246 One or more devices were 
detected but not con-
stantly active during 
recording

Defective device, device 
removed or added, com-
munication failure 

Check report for affected 
devices

247 One or more devices were 
detected but were not con-
stantly active during 
recording

Defective device, device 
removed or added, com-
munication failure 

Check report for affected 
devices

248 One or more devices were 
detected but were not con-
stantly active during 
recording

Defective device, device 
removed or added, com-
munication failure 

Check report for affected 
devices

249 One or more devices were 
detected but not con-
stantly active during 
recording

Defective device, device 
removed or added, com-
munication failure 

Check report for affected 
devices

250 No ADM connected No ADM with the address 
used for this Transducer 
Block is connected to the 
diagnostic bus

Check if all required ADMs 
are connected and the 
addresses are set correctly

251 ADM Firmware too old The firmware of the ADM is 
outdated for use with the 
diagnostic gateway

Update firmware to version 
1.4 or newer

252 ADM Firmware is being 
updated

Firmware update for ADM 
is executed

Wait for the firmware 
update to be completed

253 Configuration error: Volt-
age limits

Segment voltage limits are 
set to invalid values (e.g. 
low limit higher than high 
limit)

Correct segment voltage 
limits
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254 Configuration error: Cur-
rent limits

Segment current limits are 
set to invalid values (e.g. 
low limit higher than high 
limit)

Correct segment current 
limits

255 Configuration error: Signal 
level limits

Segment signal level limits 
are set to invalid values 
(e.g. low limit higher than 
high limit)

Correct segment signal 
level limits

256 Configuration error: Unbal-
ance limits

Segment unbalance limits 
are set to invalid values 
(e.g. low limit higher than 
high limit)

Correct segment unbal-
ance limits

257 Configuration error: Jitter 
limits

Segment Jitter limits are 
set to invalid values (e.g. 
value out of range)

Correct segment Jitter lim-
its

258 Configuration error: Noise 
limits

Segment noise limits are 
set to invalid values (e.g. 
value out of range)

Correct segment noise lim-
its

259 Configuration error: Dupli-
cate configured node 
addresses

Two devices with the same 
address are configured for 
this segment

Remove the duplicated 
entry from the configured 
devices

260 Configuration error: Node 
signal level limits

The signal level limits of at 
least one device is set to 
invalid values (e.g. low limit 
higher than high limit)

Check and correct signal 
level limits for the config-
ured devices

261 Segment is disabled The diagnostic function for 
this segment is disabled

Check if this segment is 
unused or whether the 
diagnostic is supposed to 
be enabled

263 Diagnostic gateway is in 
FDS mode. ADMs are not 
handled

The diagnostic gateway 
can be used in FF or in 
FDS mode. You are cur-
rently accessing the diag-
nostic gateway using FF 
but it is configured for oper-
ation with an FDS.

Check the intended inte-
gration and set the diag-
nostic gateway mode 
parameter inside the 
resource block as required

264 Address collision on diag-
nostic bus channels

ADMs with the same 
address are used on both 
diagnostic buses of the 
ADM

Change the address to 
only have unique 
addresses

265 Too many devices active 
on the fieldbus

More devices on bus than 
diagnostic gateway can 
handle

Reduce the number of 
devices including the host 
to 18 or below

266 A device coupler Out of 
specification alarm is 
detected for one device

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details
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267 A device coupler "Out of 
specification" alarm is 
detected. Check Coupler 
LEDs for the alarm cause.

Spur short circuit Check spur of the missing 
device

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

ELS sends alarm. The 
device coupler LED should 
blink three times

Check ELS of the device 
coupler with active alarms

The spurs of missing 
devices or an empty spur 
shows bad current 
changes

Check cable connections 
and devices at the affected 
spur

The maximum power rating 
of the device coupler is 
exceeded

Reduce power consump-
tion of devices connected 
to the device coupler

An empty spur is short cir-
cuited or shows bad cur-
rent changes

Check empty spurs of the 
corresponding device cou-
pler

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

268 A device coupler "Mainte-
nance required" alarm is 
detected

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
one time

Check device coupler 
manual for details

269 A device coupler "Out of 
specification" alarm is 
detected for one device

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

270 A device coupler "Out of 
specification" alarm is 
detected and devices are 
missing compared to com-
missioning

Spur short circuit Check spur of the missing 
device

The spurs of missing 
devices or an empty spur 
shows bad current 
changes

Check cable connections 
and devices at the affected 
spur

The maximum power rating 
of the device coupler is 
exceeded

Reduce power consump-
tion of devices connected 
to the device coupler
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271 A device coupler "Out of 
specification" alarm is 
detected for several 
devices

ELS sends alarm. The 
device coupler LED should 
blink three times

Check ELS of the device 
coupler with active alarms

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

An empty spur is short cir-
cuited or shows bad cur-
rent changes

Check empty spurs of the 
corresponding device cou-
pler

272 A device coupler "Mainte-
nance required" alarm is 
detected

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
one time

Check device coupler 
manual for details

273 A Surge protector con-
nected to the trunk is send-
ing an alarm

A surge protector con-
nected to the trunk 
detected its end of life

Check LEDs of the trunk 
surge protectors and 
replace the surge protec-
tors reporting end of life

274 A Surge protector con-
nected to the trunk is send-
ing an alarm

A surge protector con-
nected to the trunk 
detected its end of life

Check LEDs of the trunk 
surge protectors and 
replace the surge protec-
tors reporting end of life

276 "Maintenance required" 
alarm of a device coupler 
detected

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
one time

Check device coupler 
manual for details

277 "Out of specification" alarm 
of a device coupler 
detected for one device

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

ID Phenomenon Cause(s) Action(s)
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278 "Out of specification" alarm 
of a device coupler 
detected. Check coupler 
LEDs for the alarm cause

Spur short circuit Check spur of the missing 
device

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

ELS sends alarm. The 
device coupler LED should 
blink three times

Check ELS of the device 
coupler with active alarms

The spurs of missing 
devices or an empty spur 
shows bad current 
changes

Check cable connections 
and devices at the affected 
spur

An empty spur is short cir-
cuited or shows bad cur-
rent changes

Check empty spurs of the 
corresponding device cou-
pler

The maximum power rating 
of the device coupler is 
exceeded

Reduce power consump-
tion of devices connected 
to the device coupler

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

279 "Maintenance required" 
alarm of a device coupler 
detected

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
one time

Check device coupler 
manual for details

280 "Out of specification" alarm 
of a device coupler 
detected for one device

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

281 "Out of specification" alarm 
of a device coupler 
detected and devices are 
missing compared to com-
missioning

Spur short circuit Check spur of the missing 
device

The spurs of missing 
devices or an empty spur 
shows bad current 
changes

Check cable connections 
and devices at the affected 
spur

The maximum power rating 
of the device coupler is 
exceeded

Reduce power consump-
tion of devices connected 
to the device coupler

ID Phenomenon Cause(s) Action(s)
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282 "Out of specification" alarm 
of a device coupler 
detected for several 
devices

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

ELS sends alarm. The 
device coupler LED should 
blink three times

Check ELS of the device 
coupler with active alarms

An empty spur is short cir-
cuited or shows bad cur-
rent changes

Check empty spurs of the 
corresponding device cou-
pler

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

283 An unclassified error 
detected for the segment

Unidentifiable error is 
detected

Check detailed measure-
ments

284 An unclassified error 
detected for the segment

Unidentifiable error is 
detected

Check detailed measure-
ments

285 Devices with default 
addresses are active

One or more devices with 
default address(es) are 
active

Assign a permanent 
address to the device

286 One or more device tags or 
Device IDs are different to 
the given topology

One or more device tags or 
Device IDs documented in 
PC software differ from cur-
rently active devices

Check and correct device 
tags

287 One or more device tags or 
Device IDs are different 
compared to commission-
ing

One or more device tags or 
Device IDs recorded during 
commissioning differ from 
currently active devices

Correct device tags or exe-
cute commissioning again

288 Number of active devices 
different to Segment 
Checker design

Device count of the Seg-
ment Checker file differs 
from currently active 
devices

Check active devices and 
segment design

289 More than 32 devices are 
active

More than 32 devices are 
connected to the segment

Remove devices from the 
segment

290 More than 32 devices are 
active

More than 32 devices are 
connected to the segment

Remove devices from the 
segment

291 Signal level of one or more 
devices is too high

Trunk breakage between 
device couplers

Check trunk cable and 
device coupler terminals

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

ID Phenomenon Cause(s) Action(s)
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292 "Out of specification" alarm 
of a device coupler 
detected for several 
devices

Spur short circuit Check spur of the missing 
device

The spurs of missing 
devices or an empty spur 
shows bad current 
changes

Check cable connections 
and devices at the affected 
spur

The maximum power rating 
of the device coupler is 
exceeded

Reduce power consump-
tion of devices connected 
to the device coupler

An ELS or a surge protec-
tor sends an alarm. Device 
coupler LED should blink 
three times

Check device sending the 
alarm and check any ELS 
and surge protectors con-
nected to it

ELS sends alarm. The 
device coupler LED should 
blink three times

Check ELS of the device 
coupler with active alarms

An empty spur is short cir-
cuited or shows bad cur-
rent changes

Check empty spurs of the 
corresponding device cou-
pler

A diagnostic value exceeds 
defined value. The device 
coupler LED should blink 
two times

Check the device coupler 
manual for details

293 Signal level of one device 
is too low for the given 
topology, signal level of 
others OK

Device malfunction: Signal 
level is too low

Replace device

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

294 Signal level of one or more 
devices is too low for the 
given topology

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Cable resistance is too 
high

Check if the correct cable 
is installed and the cable 
can be used for the topol-
ogy

Topology error - installed 
topology does not match 
configured topology

Check that the topology 
settings match the installa-
tion

Device coupler failed Check device couplers and 
device coupler terminals

295 Signal level of one or more 
devices is too high

2 devices connected to a 
spur

Connect only one device to 
a spur

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

Topology error - installed 
topology does not match 
configured topology

Check that the topology 
settings match the installa-
tion

ID Phenomenon Cause(s) Action(s)
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296 Segment / spur voltage is 0 
V

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Bulk power supply failed Check bulk power supply
Device coupler failed Check device couplers and 

device coupler terminals
Cable breakage, short cir-
cuit or terminal connection 
failure

Check cabling and termi-
nals

Diagnostic device is 
wrongly or not connected 
to the segment

Check wiring connection to 
the segment

297 Segment / spur voltage is 
too low

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

Topology error - non-work-
ing topology

Check if the topology is 
valid according to the field-
bus specification

298 Segment / spur voltage is 
too low

Fieldbus power supply 
overload

Check if there is any con-
nection between fieldbus + 
and fieldbus - or remove 
devices

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Device coupler failed Check device couplers and 
device coupler terminals

299 Signal level of one device 
is too low, signal level of 
others OK

Device malfunction: Signal 
level is too low

Replace device

Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

300 Signal level is too low Too many terminators Check that one terminator 
is installed on each end of 
the trunk cable, but no 
more than these two in total

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

301 Signal level of devices is 
too high and devices are 
missing compared to com-
missioning

Trunk breakage between 
device couplers

Check trunk cable and 
device coupler terminals

ID Phenomenon Cause(s) Action(s)
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302 Signal level of one or more 
devices is too high

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

2 devices connected to a 
spur

Connect only one device to 
a spur

303 Segment / spur voltage is 0 
V

Fieldbus power supply 
failed

Replace fieldbus power 
supply module

Fieldbus power supply 
removed

Install fieldbus power sup-
ply

Bulk power supply failed Check bulk power supply
Device coupler failed Check device couplers and 

device coupler terminals
Cable breakage, short cir-
cuit or terminal connection 
failure

Check cabling and termi-
nals

Diagnostic device is 
wrongly or not connected 
to the segment

Check wiring connection to 
the segment

304 Segment / spur voltage is 
too low

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Terminal failure: corrosion Check if the resistance of 
any terminal is too high

Topology error - non-work-
ing topology

Check if the topology is 
valid according to the field-
bus specification

Device coupler failed Check device couplers and 
device coupler terminals

305 Devices are missing com-
pared to commissioning

Devices detected during 
commissioning are not 
active

Solve other reported errors 
first and check segment 
again

306 Devices are missing com-
pared to commissioning

Devices detected during 
commissioning are not 
active

Solve other reported errors 
first and check segment 
again

307 Segment voltage is too 
high for the given topology

Wrong fieldbus power sup-
ply installed or wrong topol-
ogy configured

Replace fieldbus power 
supply or correct topology 
settings

308 Segment voltage is too 
high

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

309 Segment voltage is higher 
compared to commission-
ing

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

310 Segment voltage is "Out of 
specification"

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

311 Segment voltage is too 
high compared to commis-
sioning

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

This is possibly a result of 
other errors

Solve other reported errors 
first and check segment 
again

ID Phenomenon Cause(s) Action(s)
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8.6 DGW-FF Troubleshooting
LEDs

312 Segment / spur voltage is 
too high

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

Device coupler failed Check device couplers and 
device coupler terminals

313 Segment / spur voltage is 
too high compared to com-
missioning

Fieldbus power supply 
replaced with incompatible 
model

Install correct fieldbus 
power supply

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

This is possibly a result of 
other errors

Solve other reported errors 
first and check segment 
again

Device coupler failed Check device couplers and 
device coupler terminals

314 Segment / spur voltage is 
too high

Device coupler failed Check device couplers and 
device coupler terminals

Fieldbus power supply 
failed

Check and replace fieldbus 
power supply

315 FDH-1 appears to be con-
nected to a spur

The signal level of one 
device is too high

If FDH-1 is not connected 
to a spur, re-check with a 
specific segment record

316 Jitter is "Out of specifica-
tion" and the signal level of 
devices is too high for the 
given topology

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

317 Jitter is Good and the sig-
nal level of devices is too 
high for the given topology

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

318 Jitter is "Good" and the sig-
nal level of devices is too 
high for the given topology

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

319 Jitter is "Out of specifica-
tion" and devices signal 
level is too high for the 
given topology

Not enough terminators Check if a terminator is 
installed on both ends of 
the trunk

320 Segment voltage too high 
for the given topology

Wrong fieldbus power sup-
ply installed or wrong topol-
ogy configured

Replace fieldbus power 
supply or correct topology 
settings

ID Phenomenon Cause(s) Action(s)

Behavior Cause Action
Green PWR is OFF No power supply Check power supply and wiring
Red ERR is ON Hardware failure detected Send device to manufacturer
Red ERR flashes ADM address conflict Check for ADMs that have the 

same addresses, one connected 
to CH1 other to CH2

Yellow Link/Act 
flashes

Ethernet communication is active No error

Yellow CH1 is OFF 
(FF Mode)

No ADMs detected on channel Check wiring. Are there ADMs 
supposed to be connected to the 
channel?
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ADM_TB

IO_TB

Function Blocks

8.7 Discovery and Configuration Tool (PFDCT) 
The discovery and configuration tool (PFDCT) is used to configure the basic TCP/IP network 
settings of the diagnostic gateway and to update the firmware of the device. 

Yellow CH1 flashes 
(FF Mode)

ADM outside address range 
1 ... 16 detected

Check address setting of ADMs, 
only address 1 ... 16 are sup-
ported in FF mode

Yellow CH1 is ON (FF 
Mode)

One or more ADMs detected No error

Yellow CH1 flashes 
(FDS Mode)

One or more ADMs detected No error

Yellow CH1 is ON 
(FDS Mode)

DTM communication active or one 
or more configured devices are 
active

No error

Red ALM flashes Common alarm output is active 
(open)

Depends on configuration of com-
mon alarm output in IO_TB

Phenomenon Cause Action
Block error: Configu-
ration error

One or more parameters of the 
block do not meet their constraints

Check the expert system mes-
sages of all 4 segments. They 
contain information on the error 
cause.

Block error: Other Status of any ADM segment is not 
Excellent, Good or No Error. See 
XD_STATUS parameter.

Check the affected segment diag-
nostics (expert system).

Phenomenon Cause Action
Block error: Configu-
ration error

One or more parameters of the 
block do not meet their constraints

• Check on/off controller turn 
on/off limits (turn-on value 
must be greater than turn-off 
value)

• Check Maintenance Required 
and Out of Specification limits 
of all analog inputs (tempera-
ture, humidity, frequency). 
On/off controller has input tem-
perature difference and differ-
ent units are selected for 
temperature 1 & 2

Block error: Other XD_ERROR is Maintenance 
Required or Out of Specification

Check FD_OOS_ACTIVE or 
FD_MR_ACTIVE for the input 
causing the problem.

Phenomenon Cause Action
Any block error Various See BLOCK_ERROR_DESC_1 

parameter for information on the 
error.

Behavior Cause Action
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This software can access the diagnostic gateway, provided that the computer running the soft-
ware is located in the same subnet as the diagnostic gateway. Even if the TCP/IP settings are 
not compatible to the currently used network, the software can continue to reach the gateway.
The software can be downloaded from the Pepperl+Fuchs website. For further detailed infor-
mation on the functionality of the software, refer to the PFDCT brief instructions.

8.8 Alarm Hysteresis and Reset
The hysteresis range prevents an activated alarm from being turned on and off repeatedly, if a 
measured value oscillates around the limit value. When the measured value exceeds the alarm 
value level, the corresponding maintenance or Out-of-Specification alarm is activated. This 
alarm stops only if the measured value falls below the alarm value including the hysteresis 
range or if someone resets the alarm manually.

Figure 8.4 Hysteresis and alarm status

The Maintenance-Required and Out-of-Specification limits for the I/O functionality of the KT-
MB-GT2AD.FF.IO also generate a configurable hysteresis.
If the FDS/OPC integration is used, alarms can be reset if the alarm is outside the alarm range, 
but the alarm is still active because of the hysteresis. Open the advanced parameterization and 
use the Reset buttons located in the configuration section of the alarm to clear the alarm in this 
case.

8.9 Field Device Handling for PROFIBUS
PROFIBUS devices can have 2 different status:

• In data exchange
• Not in data exchange

Type Value
Voltage 0.8 V
Current 20 mA
Unbalance 10%
Signal level 50 mV
Noise 25 mV
Jitter 0.5 us

t

Va
lu

e

Alarm
status

Hysteresis
High
Limit

OFFON
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If at least one PROFIBUS device is in data exchange, the measurement takes place only for 
PROFIBUS masters and devices that are in data exchange. All other devices are disabled for 
the measurement.
To analyze PROFIBUS devices that are not in data exchange, you can use the oscilloscope 
function. See chapter 5.12
If multiple segments are linked together via a repeater like in a PROFIBUS PA Segment Cou-
pler SK2, application monitoring takes place for all field devices connected to the same logical 
segment. To prevent the analysis of field devices not connected to the same physical segment 
as the ADM, you can add all devices of the segment to the configured field devices list and acti-
vate "Address Filter Active". If the filter is activated, only field devices in the configured list are 
monitored. All other field devices are ignored.

Figure 8.5 PROFIBUS address filter active checkbox

8.10 Online and Offline Data Sets
Each DTM provides 2 different types of user interfaces:

• Online data set
• Offline data set

An online interface shows the current values stored in the device. An offline interface shows the 
values currently stored in the dataset of the DTM inside the FDT project.
If an ADM is replaced with a new ADM, this online data will be lost. In order to prevent such 
data loss, the data from the online data set can be uploaded to the offline data set and down-
loaded to the device again later.

Figure 8.6 Online and Offline Data Set

8.11 HD2-GT-2AD.FF.IO Web Server
The diagnostic gateway features a built-in web server. You can access this web server by enter-
ing the IP address or DNS name of the diagnostic gateway into a web browser. The web server 
provides the following features:

Diagnostic Device

Diagnostic Manager

Offline
Data Set

Online
Data Set

Online
Data Set

D
irect Connection

U
pl

oa
d

D
ow

nl
oa

d
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Status
Overview of all connected ADMs and their diagnostic states.

Configuration
• Modify network settings of the DGW.

Warning: If you change the IP settings to an invalid value, you cannot access the web 
server again. In this case, use the diagnostic gateway configuration tool to correct the val-
ues.

• Change the diagnostic gateway mode to FDS or FF.
• Unlock the diagnostic gateway if it is locked from an FDS.
• Locate the device. The device flashes all LEDs of the diagnostic gateway. 
• Check the firmware revision and the MAC ID.
• Update the firmware of the diagnostic gateway. 

Subnet Scan
The subnet scan window shows a list of all diagnostic gateways in the same TCP/IP subnet and 
the status of their connected ADMs. The IP address of the listed diagnostic gateway is a link. 
Click the link to open the corresponding website.

Cabinet Management
The cabinet management window shows the current measured data for the cabinet manage-
ment I/Os and the associated configuration.
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8.12 OPC Server Details

8.12.1 OPC-DA Server Name Space
OPC servers provide a method that enables different software packages to access data from 
process control devices. OPC-DA and OPC-AE server are installed together with the diagnos-
tic manager by default. This OPC server communicates with the FDS and provides data for 
access from several OPC clients.
The name space of the OPC-DA server is structured as follows:
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Figure 8.7 OPC-DA name space structure

OPC-DA Server Names and Meanings

Note
Failures that occurred on system level are also shown on the segment level.

Name Meaning
FDSOPCService.DA Name of the OPC service (PROG_ID)
FDS Tag of the FDS server
Port TAG of the FDS port
DMA 001 (1-4) Tag of the diagnostic module and the appro-

priate segment
Action Instructions for troubleshooting
Cause Cause of fault
MessageID Unique ID of failure message (see chapter 

8.12.2)
State Describes the current status of the node by 

the following values: 
0: No Error
1: Maintenance Required 
2: Out of Specification 
3: Hardware Error 
4: Communication Error

StateString String of the corresponding state
SummarizedState Provides the highest prior state-data-value 

and the prior state-data-quality for the actual 
and all subordinate nodes (priorities see 
below)
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Value Definitions and Priorities

8.12.2 OPC-AE Message Data
OPC-AE Message Names and Meaning

Overview of the Message Content

State Value Meaning
0 No Error
1 Maintenance Required
2 Out of Specification
3 Hardware Error
4 Communication Error

State Data Quality Meaning
BAD, Comm_FAILURE A communication error between the OPC 

server and the FDS server has occurred.
BAD, NON_SPECIFIC FDS server has not polled the diagnostic 

module yet (temporary state).
BAD, OUT_OF_SERVICE A segment is disabled.
UNCERTAIN, NON_SPECIFIC Occurs if the diagnostic module is connected 

via the FDS to a Pepperl+Fuchs fieldbus gate-
way that also processes alarms. This is an 
invalid operating state.

GOOD None of the above applies.

SummarizedState Priority Meaning
HIGH BAD, Comm_FAILURE

BAD, NON_SPECIFIC
UNCERTAIN, NON_SPECIFIC

LOW GOOD
IGNORED BAD, OUT_OF_SERVICE

Name Meaning
Source of the message Chain of tags separated by dots: 

FDS.PORT.HD2-DM-A.SEGMENT
Type CONDITION_BASED_EVENT
EventCategory Pepperl+Fuchs ADM diagnostic condition
Severity Weight of the alarm occurred
Message Short description of the message occurred

Alarm Status Message ID Severity Message Value
GOOD 0 101 Status returned to nor-

mal
Maintenance required 1005 701 Bulk power supply 

exceeds limits set 
during commissioning

1004 701 Physical layer 
exceeds limits set 
during commissioning
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OPC-AE Message Format
<Alarm Status>
<Message ID>
<Message Value>
Example:
Maintenance Required
1004
Bulk power supply exceeds limits set during commissioning.

Out of specification 2006 901 Bulk power supply 
exceeds specified lim-
its or wrong mother-
board used

2007 901 Physical layer 
exceeds limits of the 
fieldbus specification

Hardware error 3000 301 ADM internal HW 
error

Communication error 4001 351 ADM did not answer 
4002 351 Port could not be 

opened
4003 351 SK3 existing

Pending - - Pending
Segment disabled 9000 251 -

Alarm Status Message ID Severity Message Value
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